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FOREWORD 

 
Since its establishment in 1976, Acharya Nagarjuna University has been forging 

ahead in the path of progress and dynamism, offering a variety of courses and research 

contributions. I am extremely happy that by gaining ‘A’ grade from the NAAC in the year 

2016, Acharya Nagarjuna University is offering educational opportunities at the UG, PG 

levels apart from research  degrees  to  students  from  over 443 affiliated colleges spread 

over the two districts of Guntur and Prakasam. 

 
The University has also started the Centre  for Distance  Education in 2003-04  with 

the aim of taking higher education to the door step of all the sectors of the society. The 

centre  will  be  a  great  help  to  those  who  cannot  join  in  colleges,  those  who  cannot 

afford the  exorbitant  fees  as  regular  students,  and  even  to   housewives   desirous   of 

pursuing higher studies. Acharya Nagarjuna University has started offering B.A.,  and 

B.Com courses at the Degree level and M.A., M.Com., M.Sc., M.B.A., and L.L.M., courses 

at the PG level from the academic year 2003-2004 onwards. 

 
To facilitate easier understanding by students studying through the distance mode, 

these self-instruction materials have been prepared by eminent and experienced teachers. 

The lessons have been drafted with great care and expertise in the stipulated time by these 

teachers. Constructive ideas and scholarly suggestions are welcome from students and 

teachers involved respectively. Such ideas will be incorporated for the greater efficacy 

ofthis distance mode of education. For clarification of doubts and feedback, weekly classes 

and contact classes will be arranged at the UG and PG levels respectively. 

 
It is my aim that students getting higher education through the Centre for Distance 

Education  should  improve  their  qualification,  have  better  employment  opportunities 

andin turn be part of country’s progress. It is my fond desire that in the years to come, the 

Centre for Distance Education will go from strength to strength in  the  form  of  new 

courses  and  by  catering  to  larger  number  of  people.  My  congratulations   to   all  the 

Directors, Academic Coordinators, Editors and Lesson- writers of the Centre who have 

helped in these endeavors. 
 

 
 

                                                                                                Prof.  Raja Sekhar Patteti 

Vice-Chancellor 

Acharya Nagarjuna University







(502BCE21) 
MODEL QUESTION PAPER  

B.Com. (General) DEGREE EXAMINATION, 
Third Year - Fifth Semester 

Part II - Commerce 
Paper VI - SOFTWARE SOLUTIONS TO ACCOUNTING 

Time : Three hours        Max. Marks: 70 
SECTION A-(5 x 4 = 20 marks) 

Write a short answer for any FIVE of the following. 
Each question carries 4 marks. 

 
 
1.  How to Insert/Delete rows in Excel? 

Excel ǖ అуȺ వёసలъ Insert/Delete ŷయడం ఎþ? 
 
2.  Explain features of ZOHO Books. 

ZOHO Books ƯకȮ లɕðలъ ĤవĠంచంĒ. 
 
3.  How to Create a Company in Tally? 

Tally ǖ కంŢĽę ఎþ సృĦȸంçĢ? 
 
4.  How to create unit of measurement in Tally? 

Tally ǖ Ɩలత ҘęȌ ę ఎþ సృĦȸంçĢ? 
 
5.  Explain Receipt Voucher in Tally. 

Tally ǖ రŋш ǘచȜ ę ĤవĠంచంĒ. 
 
6.  How to create a Ledger in Tally? 

Tally ǖ ŪడȵȜ ъ ఎþ సృĦȸంçĢ? 
 

7.  Explain Gateway of Tally. 
ŴȌ-Ɛ ఆȗ ìɇņę ĤవĠంచంĒ. 
 

8.  Explain Security features in Tally.  
ìɇņǖ భʘñ ĿచరɊъ ĤవĠంచంĒ. 

 
 



SECTION B – (5 x 10 = 50 marks) 
Answer the following questions. 
Each question carries 10 marks. 

 
9.  (a)     Explain any ten functions in MS Excel. 

            MS Excel ǖ ఏЍõ పė ఫంɕనɊъ ĤవĠంచంĒ. 
   Or 

  (b) Briefly explain statements and budgeting using MS Excel. 
MS Excel ę ఉపǓĈంŷ ƓȸŘɆంсɊ మĠѐ బŚȵȌ ъ зɊపȽంä ĤవĠంచంĒ. 

 
10.  (a)  Explain the features and advantages of Tally in Accounting. 

అǞంĐంȄ ǖ ìɇņ ƯకȮ లɕðѓ మĠѐ ʛǓజõలъ ĤవĠంచంĒ. 
 Or 

(b)  Briefly explain about Quick books and Zoho books. 
 Quick books మĠѐ Zoho books ҁĠȳ зɊపȽంä ĤవĠంచంĒ. 
 

11.  (a)  How to Create/Alter/Delete a company in Tally. 
ìɇņǖ ఒక కంŢĽę ఏ Ĥధంä Create/Alter/Delete ŷăȽѕ? 

 Or 
(b)  Explain the functions and objectives of Tally ERP9. 

Tally ERP 9 ƯకȮ Ĥщѓ మĠѐ లąɇలъ ĤవĠంచంĒ. 
 
12. (a)  How to Creating Stock Group and Stock items in Tally? 

ìɇņǖ ăȸȂ ҥȖ మĠѐ ăȸȂ వјȽѕలъ ఎþ సృĦȸంçĢ? 
 Or 

(b)  What is a ledger? Explain Multi-Ledger creation in Tally. 
ŪడȵȜ అంż ఏĞĐ? ìņǖ బљళ ŪడȵȜ సృĦȸę ĤవĠంచంĒ. 
 

13.  (a)  What is a voucher? Explain different types of vouchers in Tally. 
ǘచȜ అంż ఏĞĐ? ìņǖ ĤĤధ రâల ǘచరɊъ ĤవĠంచంĒ. 

 Or 
(b) Discuss the trading and profit loss accounting reports. 

 వరȽక þభ నĂȸల ãñ ęƐėకѓ ҁĠȳ చĠȳంచంĒ. 
 
 

-------- 
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Lesson – 1 

INTRODUCTION TO COMPUTERIZED ACCOUNTING 
 

Objective: 

1. Understanding Computerized Accounting: Explain the concept of computerized accounting 

and its advantages over manual accounting. 

2. History and Evolution: Provide an overview of the history and evolution of computerized 

accounting systems. 

3. Components: Identify the key components of a computerized accounting system. 

4. Implementation Process: Describe the steps involved in implementing a computerized 

accounting system in an organization. 

5. Benefits and Challenges: Discuss the benefits and potential challenges associated with 

computerized accounting. 

 

Structure: 

1.1 Introduction: 

1.2 Key Features of Computerized Accounting 

1.3 Popular Computerized Accounting Software: 

1.4 Implementation Considerations: 

1.5 Accounting Information system: 

1.6 Various Users having Interest in accounting information: 

1.7 Qualitative Characteristics of Accounting Information 

1.8 Keywords: 

1.9 Reference: 

 

1.1 Introduction: 

Computerized accounting refers to the use of computers and accounting software to manage 

financial transactions, maintain records, and generate reports. This method has revolutionized 

traditional accounting by enhancing accuracy, efficiency, and accessibility. Here’s an 

overview of what computerized accounting entails: 

Meaning of Computerized Accounting: 

 Computerized Accounting system means an accounting information system that 

processes all financial transactions of the business following the widely accepted 

accounting principles to generate reports as required. 

 It is a database based on application where the transaction are stored in an organized 

form. 

 

Characteristics of Computerized Accounting Software: 

 This System helps in data inputting online. 

 In this, all the financial transaction related to the business are recorded and stored in a 

fully deviced database. 

 In this, the financial statements are processed directly from the collected data. 

 In this, the opening and closing balances of each account are stored in the database. 

 In this, Method purchase and sales invoices are prepared very easily. 

 The business owner can access various report whenever he wants. 

 

Manuals Accounting System: 
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 Such as Accounting System in which all the functional transactions related to the 

business are written by the manual in the primary books of accounting, after that the 

balances of the accounts are drawn in various accounts according to the rules, after 

that with their help the trail balance is made and with the help of the trail balance, the 

final balance is made. 

 Accounts ( trading and profit and loss account, Balance sheet) are prepared, it is 

called Human/ Manual Accounting. 

Difference Between Manual Accounting And Computerized Accounting 

Basis for 

Comparison 

Manual Accounting Computerized Accounting 

Meaning Manual Accounting is a system of 

accounting that uses physical registers 

and account books for keeping financial 

records. 

Computerized accounting is 

an accounting system that 

users an accounting software 

,for recording financial 

transactions electronically. 

Recording Recording is possible through book of 

original entry 

Data content is recorded in 

customized database. 

Calculation All the calculation is performed 

manually 

Only data input is required, 

the calculation are performed 

by computer system 

Speed Slow Comparatively Faster 

Back Up  Not possible Entries of transactions can be 

saved and backed up 

 

1.2 Key Features of Computerized Accounting 

1. Automation of Processes: 

   - Reduces manual data entry by automating repetitive tasks like billing, invoicing, and 

ledger maintenance. 

   - Minimizes errors associated with manual calculations and data entry. 

2. Real-Time Data Processing: 

   - Allows for instant updates and real-time access to financial information. 

   - Facilitates timely decision-making based on current data. 

3. Enhanced Accuracy: 

   - Decreases human error by using precise software calculations. 

   - Ensures consistent data entry and record-keeping standards. 

4. Efficient Data Management: 

   - Enables easy storage, retrieval, and modification of financial data. 

   - Provides robust data management features such as sorting, filtering, and searching. 

5. Comprehensive Reporting: 

   - Generates detailed financial reports like balance sheets, income statements, and cash flow 

statements. 

   - Customizable reporting options to meet specific business needs. 

6. Integration Capabilities: 

   - Integrates with other business systems such as inventory management, payroll, and 

customer relationship management (CRM). 

   - Streamlines operations across different departments. 

 

Advantages of Computerized Accounting: 

1. Time-Saving: 

   - Speeds up accounting processes, allowing accountants to focus on more strategic tasks. 
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   - Quick generation of financial statements and reports. 

2. Cost-Effective: 

   - Reduces costs related to manual bookkeeping and paper records. 

   - Decreases the need for physical storage space. 

3. Improved Accuracy: 

   - Enhances data precision and reduces the likelihood of errors. 

   - Ensures compliance with accounting standards and regulations. 

4. Better Data Security: 

   - Protects sensitive financial information through data encryption and access controls. 

   - Regular backups safeguard against data loss. 

5. Scalability: 

   - Easily scalable to accommodate growing business needs. 

   - Suitable for businesses of all sizes, from small enterprises to large corporations. 

 

Disadvantages of Computerized Accounting: 

1. Training Cost: 

Computerized accounting system can be operated only by a person with special 

knowledge of accounting system and proficient in computer. The cost of training of 

such a person is also high. 

 

2. High Installation Cost: 

Not only computers and printers are requiredto perform accounting operations with 

this method, but new hardware and software also have to be purchased which costs 

more. 

 

3. Security Problem: 

 In this accounting method, the stored data gets deleted when a virus enters the 

system. Along with this, data can be easily changed in it, which is also very difficult 

to retrieve. 

 

4. Possibility of Failure: 

 In this accounting system there is always a possibility of the system to fail. In this, in 

case of hardware failure; the whole system pays off, which also effect the accounting 

works. 

 

5. Protest by the Employees: 

When computerized accounting system Is adopted in the institutes, it is opposed by 

the employees working in the institute because they fear that they will have to lay off 

and lose their job. 

 

6. Bad effects on Health: 

Continuous use of computer has adverse effect on manual health, especially on eyes, 

back pain and joint pain. 

 

1.3 Popular Computerized Accounting Software: 

1. QuickBooks: 

   - Widely used by small and medium-sized businesses. 

   - Offers features like invoicing, expense tracking, and payroll management. 

2. Sage 50 (formerly Peachtree): 

   - Known for robust accounting and financial management capabilities. 
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   - Suitable for small to medium-sized enterprises. 

3. Xero: 

   - Cloud-based accounting software popular among small businesses. 

   - Provides real-time financial data and collaboration features. 

4. Microsoft Dynamics GP: 

   - Comprehensive enterprise resource planning (ERP) solution. 

   - Ideal for larger organizations with complex accounting needs. 

5. Zoho Books: 

   - Online accounting software with a user-friendly interface. 

   - Integrated with other Zoho applications for a seamless business experience. 

6. Tally Prime: 

- Online accounting software with a user-friendly interface. 

-  It has Comprehensive Financial Management and Inventory & Management   

 

1.4 Implementation Considerations: 

1. Choosing the Right Software: 

   - Assess business needs, budget, and scalability requirements before selecting software. 

   - Consider user reviews and industry-specific features. 

2.Training and Support: 

   - Provide adequate training for employees to ensure effective use of the software. 

   - Ensure access to reliable customer support and resources. 

3. Data Migration: 

   - Plan for a smooth transition from manual or old systems to the new software. 

   - Ensure accurate data migration and reconciliation. 

4. Regular Updates: 

   - Keep the software updated to benefit from the latest features and security enhancements. 

   - Regular updates ensure compliance with changing regulations and standards. 

 

In conclusion, computerized accounting streamlines financial management by automating 

processes, enhancing accuracy, and providing real-time data access. With the right software 

and implementation strategy, businesses can achieve significant improvements in their 

accounting operations. 

 

1.5 Accounting Information system: 

 Accounting information system is a system by which accounting report related to the 

business are made available to the parties related to the business. 

 Accounting Information system refers to the process in which the data day-to-day 

financial transactions of the organization are collected and their lawful accounting is 

done and by converting the information of this data, it is necessary to provide 

necessary information to the internal and external parties. 

 

Types of Accounting Information: 

1. Income Related Information: 

The Income earned by the organization in a given period is called income related 

information. This information is obtained from the profit and loss account or income 

statement of the organization. 

 

2. Information of Financial Position: 
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 Information about the position of the institution on a given date is called information 

of balance sheet of that institution about the financial condition, payment capacity 

etc., of the institution can be obtained. 

 

3. Production Related Information: 

Information about the cost, quantity, operating expenses etc., of the goods produced is 

included in this. This information is obtained form the construction account of the 

organization, in large institutions its information is obtained from the cost accounts. 

 

4. Information Related to Human Resources: 
 The Number of employees working in the organization, salary payable to them, 

expenditure on their welfare, allowance, bonus, helath, security related information 

are included in this. 

 

1.6 Various Users having Interest in accounting information: 

 In the current changing business scenario, today many types of people are interested 

in the information related to financial accounting of the institutions, 

 These various parties interested in accounting information can be divided into the 

following two categories for the convenience of study: 

 1. Internal Parties              2. External Parties 

 

1. Internal Parties: 

Such parties who make their direct contribution for the smooth functioning of the 

institutions are called internal parties. These parties run the organization effenciency by 

taking decisions regarding the conduct of the business by estimating the profit of the 

organization for a certain period. 

 

Owner: 

The person who starts the institution is called the owner of that institution. The owner 

is most interested in accounting information because on the basis of this information, 

he takes decisions regarding the conduct of business by estimating the profit of the 

organization for a certain period. 

 

 Management: 
Accounting information is a feedback to the management to conduct its work 

smoothly in the interest of business. Management determines the credit policy, sales 

and production policy of the business only after analyzing the information and keeps 

control over the employees working in the enterprise. 

 

 Employees: 
The officers and employees working in the enterprise use the relevant information 

only to achieve the set objectives of the enterprise. The determination of their salary, 

promotion, bonus and working conditions depend on the basis of accounting 

information only. 

 

B. External Parties: 
Those persons and organizations which do not have direct relation with the business but still 

have interest in that business are called external parties. The following are the outside parties 

interested in accounting information- 

Investors:  
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An investor is said to be a person or institution who invests his extra money in the form of 

capital or loan in any institution. The investor makes sure that not only will he get adequate 

dividend and interest on his money, but his money will also be safe by analyzing the 

accounting and interest information of that business before investing money. 

Suppliers and Creditors: Supplier is the person and organization that supplies the goods, it 

is also interested in accounting information because it analyzes the information received and 

finds out when and how to supply the goods to the organization. Similarly, creditors also 

provide goods and services on credit after studying the information and observing the 

profitability and repayment capacity of the institution. 

Banks and Financial Institutions: Banks and financial institutions also study its accounting 

information before giving loan to the business and know what is its creditworthiness and 

liquidity position, only then it provides loan. Consumer: A consumer is a person who uses the 

product of the organization. He always wants to get the product at the lowest price, so he can 

see the accounting report of the organization to know at what price the product will be 

available to him. Consumers have a continuing interest over the results and economic 

condition of the organization. 

Tax Department: 
The tax department is also interested in the accounting information of the business entity 

because it calculates the tax by determining the income on the basis of the income statement 

and status statement of the business entity. 

Government: 
Central and State Governments are also interested in the accounting information of a business 

institution. It not only determines taxes on the basis of accounting reports but also controls 

business activities. 

Researcher: 

 Researchers do their research on the economic activities of the business (profit-loss, 

purchase-sale, dividend rate, transfer in various reserves etc.) Accounting information is a 

mirror of the financial condition of any business organization. Therefore, it is especially 

useful for the researcher.. 

Stock Exchange: 
If the shares of the company are listed, then the purchase and sale of such shares is done 

through stock exchange. In such a situation, the stock exchange is also interested in the 

accounting information of the organization. Because the value of the shares of such a 

company is affected by the accounting information. 

 

1.7 Qualitative CharateristicsOf Accounting Information 

Comprehensive: 
The user of accounting information ranges from an ordinary person to a subject matter expert, 

so accounting information should be simple, clear, concise, definite and easily 

understandable. 

Reliability: 

 Accounting information should be reliable, for this it is necessary that the information should 

be based on original documents (such as purchase invoice, sales invoice) etc. and they are 

certified. Accounting information will not be reliable if it is intentionally used to know 

profit/loss to any person. 

Significance or Suitability: 
The accounting information should be relevant to the needs of different parties so as to 

facilitate proper decision making. Accounting information should be available in time so that 

on its basis it is convenient to take information about events related to past, future and 

present, to make future forecasts and to respond in this regard. 
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Complete: 

 Accounting information should be accurate and complete in itself. Incomplete accounting 

information is uncertain and redundant. 

 

Fairness: 

 The accounting information must be objectively based on factual accounting. There should 

be no bias or contradiction in this information. 

Management Information System and Accounting Information System "Management 

information system is an information system that provides accurate, timely and systematic 

information to management for decision making, establishing control, solving problems and 

monitoring activities." 

Accounting information system refers to the process in which the data of day-to-day 

financial transactions of the organization are collected and their lawful accounting is done 

and by converting the information of this data, it is necessary to provide necessary 

information to the internal and external parties. 

 

Difference between Management Information and Accounting Information: 

Aspects Management Information Accounting Information 

Purpose Aids in decision-making, planning, and 

control within an organization. 

Provides financial data and reports 

for internal and external 

stakeholders. 

Focus Primarily forward-looking and focuses 

on future planning. 

Historical and compliance-focused, 

emphasizing past financial 

performance. 

Users Internal managers and executives. Internal management and external 

stakeholders (investors, creditors, 

regulators). 

Scope Broader, includes financial and non-

financial information. 

Narrower, primarily financial data. 

Reporting 

Frequency 

Can be frequent (daily, weekly, monthly) 

as needed by management. 

Typically periodic (monthly, 

quarterly, annually). 

Regulation Not regulated, tailored to internal needs 

and goals. 

Highly regulated, must comply 

with accounting standards (GAAP, 

IFRS). 

Level of 

Detail 

Can be detailed and specific to certain 

segments or activities. 

Summarized and standardized for 

consistency and comparison. 

Type of 

Data 

Includes both quantitative and 

qualitative data. 

Primarily quantitative financial 

data. 

Flexibility Highly flexible, can be adjusted as per 

management requirements. 

Less flexible, follows strict 

guidelines and frameworks. 

Examples Sales reports, budget forecasts, 

performance metrics, market analysis. 

Income statements, balance sheets, 

cash flow statements, tax returns. 

Time 

Horizon 

Future-oriented, with a focus on strategic 

planning. 

Past-oriented, with a focus on 

recording and reporting historical 

data. 

Accuracy May use estimates and projections; less 

emphasis on absolute accuracy. 

Requires high accuracy and 

reliability in reported figures. 
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1.8 Keywords: 

1. Efficiency: Computerized accounting streamlines financial processes, reducing manual 

errors and saving time. 

2. Accuracy: Automated calculations ensure precise financial data, minimizing discrepancies 

and ensuring reliability. 

3. Accessibility: Real-time access to financial information from anywhere, enhancing 

decision-making and collaboration. 

4. Security: Enhanced data protection through encryption and access controls, safeguarding 

sensitive financial information. 

 

1.9 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K Nadhani 

2. "Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 

 

 

        Radha Krishna.V 

 

 

 



 

 

Lesson - 2 

INTRODUCTION TO EXCEL 
 

Objective: 

1. Overview of Excel: Introduce Microsoft Excel and its role in accounting and data analysis. 

2. Basic Functions: Explain the basic functions and operations that can be performed in 

Excel. 

3. Spreadsheet Basics: Describe the structure of an Excel spreadsheet, including cells, rows, 

columns, and sheets. 

4. Data Entry and Formatting: Provide guidelines on entering data and formatting cells for 

better readability. 

5. Use Cases in Accounting: Highlight common use cases of Excel in accounting tasks such 

as budgeting, forecasting, and financial reporting. 

 

Structure: 

2.1 Introduction 

2.2 Why use Excel 

2.3 Spreadsheet 

2.4 Workbook 

2.5 Excel’s Structure 

2.6 What are Excel Presentation Standards 

2.7 Gridlines and Borders 

2.8 Page Size, Date & Number Format 

2.9 Charts for Data Visualization 

2.10 Pie Chart 

2.11 Keywords 

2.12 Reference 

 

2.1 Introduction: 

Microsoft Excel is a spreadsheet developed by Microsoft for Windows, macOS, Android and 

iOS. 

Excel is an incredibly powerful tool for making huge data meaningful. But it also works 

really well for simple calculations and tracking almost any kind of information. Excel 

organizes data in columns and rows and allows to do mathematical functions. 

It features include calculations, graphing tools, pivot tables, and a macro programming 

language called Visual Basic for Applications. 

Excel is typically used for: 

Data entry, Data management, Analysis, Accounting. Budgeting. Data analysis. Visuals and 

graphs, Programming. Financial modelling. 

 

2.2 Why use Excel? 

Excel is a versatile and powerful tool, it's important to note that for very large datasets or 

highly complex analyses, more specialized software like databases, statistical packages, or 

data visualization tools may be more appropriate. However, for almost all the everyday tasks 

and smaller-scale data management and analysis needs. Excel remains a valuable and 

accessible choice. 

Microsoft Excel is a widely used spreadsheet software application that offers numerous 

benefits across various industries and professions. The following are some of the reasons 

everyone uses Excel 
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1. Data Organization: 

Excel is excellent for organizing and structuring data. It allows users to input data into cells 

and arrange it in rows and columns, making it easy to view, manipulate, and analyze. 

2. Calculations and Formulas: 

Excel is equipped with powerful mathematical functions and formulas. Users can perform 

complex calculations, such as mathematical, financial, statistical, and logical operations. with 

ease. 

3. Data Analysis: 

Excel provides tools for data analysis, including pivot tables, charts, and data filtering. These 

features enable users to visualize data trends and patterns, making it easier to draw insights 

and make informed decisions. 

4. Graphs and Charts: 

Users can create a wide variety of charts and graphs to represent data visually. Excel's 

charting capabilities help in presenting information in a more understandable and persuasive 

way. 

5. Budgeting and Financial Planning: 

Excel is commonly used for budgeting, financial forecasting, and expense tracking. It allows 

individuals and businesses to manage their finances effectively. 

6. Project Management: 

Excel can be used for project planning and tracking tasks, timelines, and dependencies. It's a 

versatile tool for project managers and teams. 

7. Inventory Management: 

Businesses often use Excel to keep track of inventory levels, manage stock, and reorder 

products when needed. 

8. Reporting and Dashboards: 

Excel enables the creation of customized reports and dashboards, providing a snapshot of key 

metrics and performance indicators. 

9. Data Validation: 

Excel allows you to set rules and validations to ensure data accuracy and consistency, 

reducing errors in data entry. 

10. Data Import and Export: 

You can import data from various sources into Excel and export it to different formats, 

making it a valuable tool for data integration and exchange. 

11. Time Tracking and Scheduling: 

Excel can be used for time tracking, creating schedules, and managing appointments and 

deadlines. 

12. Educational and Academic Use: 

Students and educators often use Excel for various academic purposes, such as analyzing 

scientific data conducting experiments, and solving mathematical problems. 

13. Human Resources: 

HR departments use Excel for tasks like employee data management, payroll calculations, 

and tracking employee performance. 

14. Sales and Marketing: 

Sales professionals and marketers use Excel for lead tracking, sales forecasts, and marketing 

campaign analysis. 

15. Personal Finance: 

Many individuals use Excel to manage personal budgets, track expenses, and plan for savings 

and investments. 

 

16. Data Storage: 
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Excel can be used as a simple database for storing information, especially when the data 

volume is relatively small. 

17. Customization: 

Excel is highly customizable. Users can create templates, macros, and add

their specific needs. 

18. Compatibility: 

Excel is widely supported and can work seamlessly with other Microsoft Office applicati

and third-party software. 

 

2.3 Spreadsheet: 

A spreadsheet is a software application or program used for organizing, storing, 

manipulating, and analyzing data in a tabular form

• The data in a spreadsheet is typically arranged in rows and columns, formi

• The key for unlocking all that potential is the grid of cells.

• Each cell can contain text, numbers, formulas, or functions, allowing users to perform 

various calculations, data analysis, and data visualization tasks.

• That allows us to add up our data, sort and filter it, put it in tables, and build good

and useful charts. 

Spreadsheet is a concept or a process / software and MS Excel is one of the most popular 

Spreadsheet, which is widely used.

 

2.4 Workbook: 

A workbook is a spreadsheet program file to be created in Excel by the user. A workbook 

contains one or more worksheets. In simple terms, an Excel File is also referred to as a 

workbook. 

A worksheet consists of cells which is used to enter and calculate data. The cells 

organized into columns and rows. A worksheet is a part of a workbook. We may also refer it 

as just 'Sheets'. 

A workbook can contain many work sheets. Think of it as a book. The book (workbook/file) 

usually have many pages (worksheet). The Sheets are al

See the image below to know how an excel spreadsheet looks like. It is made up of Columns 

(A,B,C..) and Rows (1,2,3...) and the intersection every row and column make a Cell, like Al 

is the active cell. 

Just below the quick access toolb

buttons as well. 
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Just below the quick access toolbar, you can see File, Home, Insert and many more menu 
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Create a workbook: 

1. Open Ms Excel. 

2. Select Blank Workbook (or) Press Ctrl+N.

Ctrl Stands for Control and N Stands for New. Most of the key board shortcuts in Excel 

works with Ctrl or Alt. 

 

 

Save a workbook 

Every time one works in an excel file, it must be saved to ensure that your work is saved and 

protected. 

Press Ctrl + S to save an existing workbook in its current location.

We can use Save As to save the workbook in a different loca

workbook in the same or another location.

1. Click File > Save As. 
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Select Blank Workbook (or) Press Ctrl+N. 

Ctrl Stands for Control and N Stands for New. Most of the key board shortcuts in Excel 

Every time one works in an excel file, it must be saved to ensure that your work is saved and 

Press Ctrl + S to save an existing workbook in its current location. 

We can use Save As to save the workbook in a different location, or to create a copy of the 

workbook in the same or another location. 
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Ctrl Stands for Control and N Stands for New. Most of the key board shortcuts in Excel 

Every time one works in an excel file, it must be saved to ensure that your work is saved and 

tion, or to create a copy of the 
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2. Under Save as, pick the place 

where to save workbook. 

For Example, to desktop or 

in a folder on computer, 

click computer. 

 

 

 

3. Click Browse to find the location in Documents 

folder. 

To pick another location on computer, click 

Desktop, and then pick the exact place where to 

save workbook. 

4. In the File name box, enter a name for a new 

workbook. Enter a different name if creating a copy 

 

1. To Save workbook in a different file format (like .xlsx or .txt), in the save as type list 

(under the file name box),pick the format as required. Usually .xlsx is used.

2. Click Save. 

 

2.5 Excel’s Structure: 

The Excel is made up of two portions, the ribbon and the sheet and has many parts.

In the below picture we can seen clearly
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Under Save as, pick the place    

where to save workbook.  

For Example, to desktop or  

in a folder on computer,  

Browse to find the location in Documents 

To pick another location on computer, click 

Desktop, and then pick the exact place where to 

4. In the File name box, enter a name for a new 

workbook. Enter a different name if creating a copy of an existing workbook.

To Save workbook in a different file format (like .xlsx or .txt), in the save as type list 

(under the file name box),pick the format as required. Usually .xlsx is used.

two portions, the ribbon and the sheet and has many parts.

In the below picture we can seen clearly 
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of an existing workbook. 

 

To Save workbook in a different file format (like .xlsx or .txt), in the save as type list 

(under the file name box),pick the format as required. Usually .xlsx is used. 

two portions, the ribbon and the sheet and has many parts. 
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Ribbon: 

The Ribbon Contains all of the commands that needs to perform common tasks in Excel. It 

has multiple tabs, each with several groups of commands

access commands. 

Sheet: 

The Sheet is made up of columns (vertical) and rows (horizontal), which make cells.

Cell: Each rectangle in a workbook is called a cell. A cell is the intersection of a row and a 

column. Simply click to select a cell.

Row: A row is a group of cells that runs from the left of the page to the right. In Excel, rows 

are identified by numbers.  

Column: A column is a group of cells that runs from the top of the page to the bottom. In 

Excel, columns are identified by letters.
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The Ribbon Contains all of the commands that needs to perform common tasks in Excel. It 

has multiple tabs, each with several groups of commands. The ribbon is used to navigate and 

The Sheet is made up of columns (vertical) and rows (horizontal), which make cells.

Each rectangle in a workbook is called a cell. A cell is the intersection of a row and a 

lick to select a cell. 

A row is a group of cells that runs from the left of the page to the right. In Excel, rows 

A column is a group of cells that runs from the top of the page to the bottom. In 

identified by letters. 
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The Ribbon Contains all of the commands that needs to perform common tasks in Excel. It 

. The ribbon is used to navigate and 

The Sheet is made up of columns (vertical) and rows (horizontal), which make cells. 

Each rectangle in a workbook is called a cell. A cell is the intersection of a row and a 

A row is a group of cells that runs from the left of the page to the right. In Excel, rows 

A column is a group of cells that runs from the top of the page to the bottom. In 
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The Sheet is a set of rows and columns. It forms the same pattern as in math exercise books, 

the rectangle boxes formed by the pattern are called cells. In the above image, the Cell has 

been selected. 

Values can be typed to cells. 

Values can be both numbers and letters: 

Each cell has its unique reference, which is its coordinates, this is where the columns and 

rows intersect. 

 

Mapping data in a cell: 

Hello FinC Minds was typed in cell . The reference can be found by clicking on the relevant 

cell and seeing the reference in the Name Box to the left, which tells that the cell's reference . 

Another way to find the reference is to first find the column, in this case C, then map that 

towards the row, in this case 3, which gives us the reference of C3. The letter is always the 

column and the number is always the row. 

 

Multiple Sheets: 

It starts with one Sheet by default when a new workbook is created. Many sheets in a 

workbook can be created. New sheets can be added and removed. Sheets can be named to 

making it easier to work with data sets. 

Let's create two new sheets and give them useful names. 

First, click the plus icon, shown in the picture below, and create new sheets: 
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2.6 What are Excel Presentation Standards?

Excel Presentation Standards are practices followed by an organization for the better 

presentation. Microsoft Office Excel has a number of features that make it easy to manage 

and analyze data. To take full advantage of these features, it is important to organize and 

format data in a worksheet. These practices vary from organization to organization and they 

follow a set of guidelines for better presentation

Large organizations may have a standard formatting style, which means that every employee 

or the member should use the s

the company documents, presentations reports etc.

This makes the document and reports looks neat and standard. However, every company may 

not use a standard format. 

 

A sample formatting style is given below for a Company:

Font means the style of the text and characters like Times New Roman, Calibri, Cambri etc.

Font Size means the size of the text like 8. 10. 12. Generally, companies prefer 10 or 11 as 

text size. Further, the size may be higher

 

The text can also  be written in normal or bold or Italic formats
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2.6 What are Excel Presentation Standards? 

Standards are practices followed by an organization for the better 

presentation. Microsoft Office Excel has a number of features that make it easy to manage 

and analyze data. To take full advantage of these features, it is important to organize and 

data in a worksheet. These practices vary from organization to organization and they 

follow a set of guidelines for better presentation 

Large organizations may have a standard formatting style, which means that every employee 

or the member should use the same formats like Font name, text size, color and others in all 

the company documents, presentations reports etc. 

This makes the document and reports looks neat and standard. However, every company may 

is given below for a Company: 

Font means the style of the text and characters like Times New Roman, Calibri, Cambri etc.

Font Size means the size of the text like 8. 10. 12. Generally, companies prefer 10 or 11 as 

text size. Further, the size may be higher for headings (Titles) or sub headings (sub

be written in normal or bold or Italic formats 
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Standards are practices followed by an organization for the better 

presentation. Microsoft Office Excel has a number of features that make it easy to manage 

and analyze data. To take full advantage of these features, it is important to organize and 

data in a worksheet. These practices vary from organization to organization and they 

Large organizations may have a standard formatting style, which means that every employee 

ame formats like Font name, text size, color and others in all 

This makes the document and reports looks neat and standard. However, every company may 

Font means the style of the text and characters like Times New Roman, Calibri, Cambri etc. 

Font Size means the size of the text like 8. 10. 12. Generally, companies prefer 10 or 11 as 

for headings (Titles) or sub headings (sub-titles). 
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Typing: 

 

Colour Format: 

There are different types of colours in MS Excel like the Font colour and the Background 

colour. By default, the background is white and the text is black in colour, but one can always 

choose and change the same. 

 

2.7 Gridlines and Borders: 

As we know that every excel is made up of Cells, we can see that the boxes are made up of 

very light colours, they are a

document, the cell boxes will not be printed. If you need the cell boxes to be printed, you 

need to use Borders. 

Border can be applied using the following path:

Home >> Font >> Borders 
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Gridlines just helps us to identify the cells easily, if you don't want the gridline to appear, the 

same can be removed with the following path: 

View >> Uncheck the Gridline box, as shown below:

 

2.8 Page Size, Date & Number Format:

The Excel sheet can be zoomed in or out from the bottom right of the screen as convenient.

Format Cells are very important function in Excel and you can format one single cell or a 

Selected Few cells or the whole sheet. Though there are various formatting options, the two 

important ones are the date and number formats.

Pathway for Format Cells: 

Home >> Cells >> Format drop down >> Format Cells

Shortcut >> Ctrl + 1 

 

2.9 Charts for Data Visualization:

Types of Charts - Overview: 

The most popular types of charts are column charts, 

line charts, area charts, scatter charts, spider (radar) charts, gauges, and comparison charts. 

Here is a quick view of these charts. The biggest challenge is to how to select the most 
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ines just helps us to identify the cells easily, if you don't want the gridline to appear, the 

same can be removed with the following path:  

View >> Uncheck the Gridline box, as shown below: 

 

2.8 Page Size, Date & Number Format: 

zoomed in or out from the bottom right of the screen as convenient.

Format Cells are very important function in Excel and you can format one single cell or a 

Selected Few cells or the whole sheet. Though there are various formatting options, the two 

ant ones are the date and number formats. 
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effective type of chart for our task.

If we want to choose most suitable chart type, generally, we should consider the total number 

of variables, data prints and the period 

advantages. 

Column Chart: 

A column chart is a method of displaying 

sometimes called vertical bar charts. They allow easy comparisons among a number of items 

and trends analysis. In general, statistics and figures are difficult to understand when 

presented in tables or written format. Column charts make things easy, immediate, and 

understandable. 

 

 

 

 

 

 

Column charts are effective for the comparison of at least one set of data points. The vertical 

axis, also known as the Y-axis, is often shown in numeric values. The X

horizontal line indicates a period.

Typically, data points in column charts can be used in Clustered or stacked forms. we can find 

trends over time by using these types in different colors. A clustered column chart is 

especially useful in showing and 

can quickly check a specific percentage of the overall data

 

 

2.10 Pie Chart: 

The Pie Chart is also known as a “

sectors or sections to illustrate the numerical problems. Each sector denotes a proportionate 

part of the whole. To find out the composition of something, Pie

cases, Pie-chart replace other graph, Line Plots, Histograms etc.,
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r task. 

If we want to choose most suitable chart type, generally, we should consider the total number 

of variables, data prints and the period  of our data. Each type of chart has specific 

A column chart is a method of displaying data with categories represented by a rectangle

sometimes called vertical bar charts. They allow easy comparisons among a number of items 

and trends analysis. In general, statistics and figures are difficult to understand when 

en format. Column charts make things easy, immediate, and 

Column charts are effective for the comparison of at least one set of data points. The vertical 

axis, is often shown in numeric values. The X

horizontal line indicates a period. 

Typically, data points in column charts can be used in Clustered or stacked forms. we can find 

trends over time by using these types in different colors. A clustered column chart is 

especially useful in showing and analyzing multiple data sets. For stacked column charts, we 

can quickly check a specific percentage of the overall data 

The Pie Chart is also known as a “circle chart”, Dividing the circular statistical graphic into 

o illustrate the numerical problems. Each sector denotes a proportionate 

part of the whole. To find out the composition of something, Pie-chart works the best. In most 

chart replace other graph, Line Plots, Histograms etc., 
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of our data. Each type of chart has specific 

data with categories represented by a rectangle- 

sometimes called vertical bar charts. They allow easy comparisons among a number of items 

and trends analysis. In general, statistics and figures are difficult to understand when 

en format. Column charts make things easy, immediate, and 

Column charts are effective for the comparison of at least one set of data points. The vertical 

axis, is often shown in numeric values. The X-axis on the 

Typically, data points in column charts can be used in Clustered or stacked forms. we can find 

trends over time by using these types in different colors. A clustered column chart is 

analyzing multiple data sets. For stacked column charts, we 
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o illustrate the numerical problems. Each sector denotes a proportionate 

chart works the best. In most 
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In reality we can break down any sample data groups into different categories for example by 

gender or in various age groups. For Business Projects, we can use pie charts to respect the 

importance of one specific factor on the others.

However, 

analyzing 

different 

we should 

column 

 

 

 

 

 

 

 

 

 

 

Line 

This type 

is 

used for explaining trends over periods. The vertical axis always displays a numeric amount, 

while the X-Axis indicates some other related factors, line ch

in the shape of circles, Square or other formats

 

Page setup of spreadsheets: 

Margins -Built-In: 
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data sets, 
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charts. 

charts: 

of chart 
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used for explaining trends over periods. The vertical axis always displays a numeric amount, 

arts can be shown with makers 
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There is a choice of three built-in margin settings: Normal, narrow and wide. 

To get to Normal: 

1) Choose page layout 

2) Hit the Margins drop down menu 

3) Click the Normal Margins 

 
 

'Custom Margins' choice (4): 

4) The Custom Margins button will produce the Page Setup Dialog Box, with the Margins tab 

highlighted. 

Adjust the margins to exact requirements as required. We can also be able to centre image on 

the page here, either horizontally, vertically or both. 

 

 
Center  On a Page, Paper Orientation & Setting Paper Size: 

By default Excel will print in the top left hand corner of the page. If we want it to print 

elsewhere we need to tell it to do so. 

The image part with relationship ID rId27 was not found in the file.
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To centre it on the page we need to go to the Page Setup dialog box again as before.

This will open the box we see in the picture below. we will see on the loour left

options to centre horizontally and / or vertically.

 

Print Titles: 

At times, when the data is large, and may run into multiple pages, the table headers or titles 

may need to be printed in every page for better reading of the data. This is where Print tiles 

option is valuable. Page Layout >> Print Titles

 

Once you click on page title, the page setup box will open as below.

 

In the page setup box, select the print area and the rows to be repeated in every page.
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To centre it on the page we need to go to the Page Setup dialog box again as before.

This will open the box we see in the picture below. we will see on the loour left

options to centre horizontally and / or vertically. 

At times, when the data is large, and may run into multiple pages, the table headers or titles 

may need to be printed in every page for better reading of the data. This is where Print tiles 

option is valuable. Page Layout >> Print Titles 

nce you click on page title, the page setup box will open as below. 

In the page setup box, select the print area and the rows to be repeated in every page.

Software Solutions to Accounting 

To centre it on the page we need to go to the Page Setup dialog box again as before. 

This will open the box we see in the picture below. we will see on the loour left-hand side the 

At times, when the data is large, and may run into multiple pages, the table headers or titles 

may need to be printed in every page for better reading of the data. This is where Print tiles 

 

 

In the page setup box, select the print area and the rows to be repeated in every page. 
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Setting The Print Area: 

• The default print area for Excel is ALL which means the entire sheet, 

it will print all the cells in which there is any data. If we want to print a specific cells, or rows 

or columns or a table, we can use the Print Area option. • To do this, highlight the data we 

want to print, click on the page layout 

• The area will then have a thinner line around it. Once this is set, the print command will 

print only the print area for that sheet.

 

 

2.11 Keywords: 

1. Formulas, Functions, Pivot Tables, Charts

2. Conditional Formatting, Data Validation, VLOOKUP, INDEX

3. Macros, VBA, Data Analysis, Power Query

4. Filtering, Sorting, Conditional Formatting, What

 

2.12 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K. 

2. "Tally Prime with GST: Hands
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• The default print area for Excel is ALL which means the entire sheet, hence when we print, 

it will print all the cells in which there is any data. If we want to print a specific cells, or rows 

or columns or a table, we can use the Print Area option. • To do this, highlight the data we 

want to print, click on the page layout >> print area >> set print area. 

• The area will then have a thinner line around it. Once this is set, the print command will 

print only the print area for that sheet. 

1. Formulas, Functions, Pivot Tables, Charts 

g, Data Validation, VLOOKUP, INDEX-MATCH 

3. Macros, VBA, Data Analysis, Power Query 

4. Filtering, Sorting, Conditional Formatting, What-If Analysis 

"Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K. 

Prime with GST: Hands-on Practice" by Asok K. Nadhani 
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hence when we print, 

it will print all the cells in which there is any data. If we want to print a specific cells, or rows 

or columns or a table, we can use the Print Area option. • To do this, highlight the data we 

• The area will then have a thinner line around it. Once this is set, the print command will 

 

 

"Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K.  Nadhani 

Radha Krishna.V 



Lesson - 3 

EXCEL  SHORTCUTS & FEATURES 
 

Objective: 

1. Time-Saving Shortcuts: List and explain essential Excel keyboard shortcuts to enhance 

productivity. 

2. Advanced Features: Introduce advanced Excel features such as PivotTables, VLOOKUP, 

and Conditional Formatting. 

3. Data Analysis Tools: Discuss various data analysis tools available in Excel, including 

charts, graphs, and data validation. 

4. Customization Options: Describe how to customize the Excel interface and settings to suit 

user preferences. 

5. Best Practices: Provide best practices for using Excel efficiently in accounting and data 

management. 

 

Structure: 

3.1 Introduction 

3.2 List of Short cut keys in Excel 

3.3 Conditional Formatting can be used for various benefits like 

3.4 Quickly Identify Duplicates 

3.5 Keywords 

3.6 Reference 

 

3.1 Introduction: 

Excel Shortcuts 

Excel is a powerful tool used by millions of people every day. One of the most common 

reasons people use Excel is to complete tedious and time-consuming tasks faster. 

For example, it would take many clicks and time to find the total cost of purchases from a 

huge production dataset. 

 

Keyboard shortcuts are extremely useful for the purposes of improving speed and 

productivity when working with Excel. 

An often-overlooked method of increasing productivity when working in an Excel model is 

to use Excel shortcuts, or shortcut keys. These shortcut keys perform major functions that, 

when used instead of clicking in the toolbar, dramatically increase efficiency and speed. 

Imagine simply pressing two or three keys on the keyboard as opposed to moving your hand 

to the mouse, moving the mouse, and clicking several times. 

here are thousands of keyboard Excel shortcuts that can be used within Excel to increase 

productivity. These shortcuts can perform many functions. from ones as simple as navigation 

within the spreadsheet to using formulas or grouping data. 

 

Every time you need to do something in excel and your hand moves towards the mouse, just 

pause and think, is there a keyboard shortcut for this and try using one. This will increase 

your confidence and significantly improve your speed in excel. 

Please find below, the list of most common and popular used shortcuts to start with. Just try 

your hands with these and then we will move to the next phase. 

 

3.2 List of Short cut keys in Excel: 

1. Ctrl + N: Create a new workbook. 
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2. Ctrl + O: Open an existing workbook. 

3. Ctrl + S: Save the current workbook. 

4. Ctrl + P: Print the current workbook. 

5. Ctrl + F: Open the Find and Replace dialog box. 

6. Ctrl + H: Open the Find and Replace dialog box (with the Replace tab selected). 

7. Ctrl + C: Copy the selected cells. 

8. Ctrl + X: Cut the selected cells. 

9. Ctrl + V: Paste the copied/cut cells. 

10. Ctrl + Z: Undo the last action. 

11. Ctrl + Y: Redo the last action. 

12. Ctrl + A: Select the entire worksheet. 

13. Ctrl + B: Apply or remove bold formatting. 

14. Ctrl + I: Apply or remove italic formatting. 

15. Ctrl + U: Apply or remove underline formatting. 

16. Ctrl + K: Insert a hyperlink. 

17. Ctrl + 1: Open the Format Cells dialog box. 

18. Ctrl + 5: Apply or remove strikethrough formatting. 

19. Ctrl + 9: Hide the selected rows. 

20. Ctrl + 0: Hide the selected columns. 

21. Ctrl + Shift + L: Apply or remove filters. 

22. Ctrl + Shift + "+"": Insert a new cell, row, or column. 

23. Ctrl + "-": Delete the selected cell, row, or column. 

24. Ctrl + Arrow Key: Move to the edge of the current data region. 

25. Ctrl + Shift + Arrow Key: Extend the selection to the edge of the current data 

region. 

26. Ctrl + Home: Move to the beginning of the worksheet. 

27. Ctrl + End: Move to the last cell with data in the worksheet. 

28. Ctrl + Page Up: Move to the previous sheet in the workbook. 

29. Ctrl + Page Down: Move to the next sheet in the workbook. 

30. Ctrl + Space: Select the entire column. 

31. Shift + Space: Select the entire row. 

32. Alt + Enter: Insert a line break within a cell. 

33. Ctrl + Shift + ";": Enter the current time. 

34. Ctrl + ";": Enter the current date. 

35. Ctrl + Shift + "$": Apply currency format. 

36. Ctrl + Shift + "%": Apply percentage format. 

37. Ctrl + Shift + "#": Apply date format. 

38. Ctrl + T: Create a table from the selected data. 

39. F2: Edit the active cell. 

40. F4: Repeat the last action. 

41. F7: Open the Spelling dialog box. 

42. F11: Create a chart from the selected data. 

43. Alt + F1: Create an embedded chart from the selected data. 

44. Ctrl + Shift + A: Insert argument names into a formula. 

45. Ctrl + D: Fill down in the selected cell. 

46. Ctrl + R: Fill right in the selected cell. 

47. Ctrl + Shift + U: Expand or collapse the formula bar. 

48. Ctrl + `: Toggle showing formulas in cells. 
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49. Alt + H + H: Open the Fill Color menu.

50. Alt + H + B: Open the Borders menu.

 

If you press Alt in Excel you would observe all the tabs in the ribbon will start displaying 

their respective shortcut key letters.

 

Conditional Formatting: 

Conditional Formatting is a feature in many spreadsheet applications that allows you to apply 

specific formatting to cells that meet certain criteria

It is most often used as color-based formatting to highlight, emphasize, or differentiate among 

data and information stored in a spreadsheet.

The Conditional Formatting button is available in Home Tab in the Styles box.

 

3.3 Conditional Formatting can be used for various benefits like:

• Highlight cells with value Greater / Lesser than a number in a dataset. Quickly Identify 

Duplicate using Conditional Formatting in Excel. Highlighting Top / Bottom 10 (or 10%) 

value in a dataset. 

• Highlighting Errors/Blanks using conditional Formatting in Excel. Search and Highlight 

using conditional Formatting in Excel.

 

Highlight Cells with Value Greater/Less than a Number:

1. Select the Cells. 

2. Conditional Formatting >> Highlight Cells 

3. Enter the number (e.g. 5) in the dialog box and choose any relevant colour (Light Red).

4. All the cells with values greater than 5, will be highlighted with Light Red colour.

 

3.4 Quickly Identify Duplicates:

Conditional Formatting in excel can be used to identify duplicate in a dataset. Select the 

dataset in which you want to highlight duplicates.
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1. Select the Cells. 

2. Conditional Formatting >> Highlight Cells Rules >> Duplicate values..

3. Select Duplicate in the dialog box

cells with duplicate values, will be highlighted with Light Red colour.

 

Highlighting Top/Bottom 10 (or 10%):

1. Select the Cells. 

2. Conditional Formatting >> Top/Bottom Rules >> Top 10 items..

3. Select 10 in the dialog box and choose any relevant colour (Light Red).

4. The top 10 items in the selected cells, will be highlighted with Light Red colour.

3.5 Keywords: 

1. Navigation: Arrow keys, Ctrl + arrow keys, Ctrl + Home/End

2. Selection: Shift + arrow keys, Ctrl + Shift + arrow keys

3. Editing: F2 (Edit cell), Ctrl + X/C/V (Cut/Copy/Paste), Ctrl + Z (Undo)

4. Formatting: Ctrl + B/I/U (Bold/Italic/Underline), Alt + H, H (Font options)

 

3.6 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P

2. "Tally Prime with GST: Hands
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2. Conditional Formatting >> Highlight Cells Rules >> Duplicate values.. 

3. Select Duplicate in the dialog box and choose any relevant colour (Light Red). 4. All the 

cells with duplicate values, will be highlighted with Light Red colour. 

Highlighting Top/Bottom 10 (or 10%): 

2. Conditional Formatting >> Top/Bottom Rules >> Top 10 items.. 

Select 10 in the dialog box and choose any relevant colour (Light Red). 

4. The top 10 items in the selected cells, will be highlighted with Light Red colour.

1. Navigation: Arrow keys, Ctrl + arrow keys, Ctrl + Home/End 

+ arrow keys, Ctrl + Shift + arrow keys 

3. Editing: F2 (Edit cell), Ctrl + X/C/V (Cut/Copy/Paste), Ctrl + Z (Undo) 

4. Formatting: Ctrl + B/I/U (Bold/Italic/Underline), Alt + H, H (Font options)

"Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K. Nadhani

"Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 
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4. The top 10 items in the selected cells, will be highlighted with Light Red colour. 

 

 

4. Formatting: Ctrl + B/I/U (Bold/Italic/Underline), Alt + H, H (Font options) 

. Rustagi and Ashok K. Nadhani 

Radha Krishna.V 



Lesson - 4 

PREPARATION OF ACCOUNTS 
 

Objective: 

1. Accounting Principles: Explain the fundamental accounting principles and concepts. 

2. Chart of Accounts: Describe the process of setting up a chart of accounts in an accounting 

system. 

3. Journal Entries: Detail the steps for recording journal entries and their significance in the 

accounting cycle. 

4. Ledger Maintenance: Discuss the importance of maintaining accurate ledgers and how to 

update them. 

5. Trial Balance: Explain how to prepare a trial balance and its role in the preparation of 

financial statements. 

 

Structure: 

4.1 Introduction to Preparation of Accounts 

4.2 Importance of Preparing Accounts 

4.3 Key Components of Account Preparation 

4.4 Basic Steps in Preparing Accounts 

4.5 CONCEPT OF PREPARATION OF ACCOUNTS 

4.6 Keywords 

4.7 Reference 

 

4.1 Introduction to Preparation of Accounts: 

The preparation of accounts is a fundamental aspect of accounting that involves recording, 

classifying, and summarizing financial transactions to provide useful information for 

decision-making. It is essential for businesses, organizations, and individuals to track their 

financial activities, ensure legal compliance, and assess their financial health. This 

introduction covers the basics of account preparation, its importance, and the key components 

involved. 

 

4.2 Importance of Preparing Accounts 

1. Financial Control: Properly prepared accounts help businesses keep track of income and 

expenses, allowing for better financial control. 

2. Decision Making: Accurate financial information is crucial for making informed business 

decisions, such as budgeting, investing, and planning. 

3. Legal Compliance: Maintaining proper accounts is often required by law, ensuring that 

businesses comply with regulatory requirements. 

4. Performance Evaluation: Financial statements derived from prepared accounts help in 

evaluating the performance and financial health of the business. 

5. Stakeholder Communication: Prepared accounts provide transparency and trust, essential 

for communicating with stakeholders, such as investors, creditors, and tax authorities. 

 

4.3 Key Components of Account Preparation 

1. Source Documents: These are the original records that document financial transactions, 

such as invoices, receipts, and bank statements. 

2. Journal Entries: Transactions are initially recorded in the journal as debit and credit entries, 

forming the first step in the accounting process. 

3. Ledger Accounts: Journal entries are posted to ledger accounts, which are individual 

records for each account, such as cash, sales, and expenses. 
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4. Trial Balance: A trial balance is prepared to ensure that total debits equal total credits, 

serving as a check for recording accuracy. 

5. Financial Statements: The final step involves preparing financial statements, including the 

Income Statement, Balance Sheet, and Cash Flow Statement. 

 

4.4 Basic Steps in Preparing Accounts 

1.Recording Transactions: 

- Identify Transactions: Recognize financial transactions and gather source documents. 

   - Journalize: Record the transactions in the journal using the double-entry system, which 

ensures that every debit has a corresponding credit. 

2. Posting to Ledgers: 

- Post Journal Entries**: Transfer the journal entries to the respective ledger accounts. 

   - Maintain Ledgers: Each account's debit and credit entries are maintained in its ledger. 

3. Preparing Trial Balance: 

   - List All Ledgers: Create a list of all ledger accounts and their balances. 

   - Ensure Balance: Verify that the total debits equal total credits. 

4. Adjusting Entries: 

   - Record Adjustments: Make necessary adjusting entries for accrued expenses, prepaid 

expenses, depreciation, and other adjustments. 

   - Update Ledgers: Post these adjusting entries to the ledger accounts. 

5. Preparing Financial Statements: 

   - Income Statement: Summarizes revenues and expenses to determine the net profit or loss. 

   - Balance Sheet: Provides a snapshot of the business's financial position, listing assets, 

liabilities, and equity. 

   - Cash Flow Statement: Shows the inflow and outflow of cash, highlighting operating, 

investing, and financing activities. 

 

4.5 CONCEPT OF PREPARATION OF ACCOUNTS: 

Preparing accounts in Excel can be an efficient way to maintain financial records, perform 

calculations, and generate reports. Here is a detailed guide on how to prepare accounts in 

Excel, complete with an example. 

Step-by-Step Guide to Preparing Accounts in Excel 

 

Step 1: Setting Up the Excel Workbook 

1. Open Excel and create a new workbook. 

2. Create multiple sheets for different sections of accounts, such as: 

   - Chart of Accounts 

   - Journal Entries 

   - Ledger Accounts 

   - Trial Balance 

   - Financial Statements (Income Statement, Balance Sheet) 

 

Step 2: Creating the Chart of Accounts 

1. Navigate to the first sheet and rename it as `Chart of Accounts`. 

2. Create columns for Account Number, Account Name, Account Type, and Description. 

 

Example: Chart of Accounts 

Account Number Account Name Account Type Description 

1000 Cash Asset Cash in hand 

2000 Account Receivables Asset Amount Owned by 
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Customer 

3000 Inventory Asset Goods Available for sale 

4000 Account Payable Liability Amount owned to 

suppliers 

5000 Sale Revenue Revenue Income from sale 

6000 Cost of Goods Sold Expense Cost of Goods Sold 

7000 Salaries Expenses Expenses Salaries paid to employee  

 

Step 3: Recording Journal Entries 

1. Create a new sheet and rename it as `Journal Entries`. 

2. Create columns for Date, Account Number, Account Name, Debit, and Credit. 

 

Example: Journal Entries 

Date        Account Number Account Name     Debit   Credit 

01/01/2024 1000 Cash 10,000  

01/01/2024 5000 Sale Revenue  10,000 

02/01/2024 6000 Cost of Goods Sold 6,000  

02/01/2024 3000 Inventory  6,000 

03/01/2024 7000 Salaries Expense 2,000  

03/01/2024 1000 Cash  2,000 

 

Step 4: Posting to Ledger Accounts 

1. Create a new sheet and rename it as `Ledger Accounts`. 

2. Create columns for Date, Account Number, Account Name, Debit, Credit, and Balance for 

each ledger. 

 

Example: Ledger Account for Cash  

Date        Account Number Account Name     Debit   Credit Balance 

01/01/2024 1000 Cash 10,000  10,000 

03/01/2024 7000 Cash  2,000 8,000 

 

Step 5: Preparing the Trial Balance 

1. Create a new sheet and rename it as `Trial Balance`. 

2. List all account names with their respective debit and credit balances. 

 

Example: Trial Balance 

Account Name Debit Credit 

Cash 8,000  

Accounts Receivables   

Inventory  6,000 

Accounts Payable   

Sale Revenue  10,000 

Cost of Goods Sold 6,000  

Salaries Expense 2,000  

Total 16,000 16,000 

 

Step 6: Preparing Financial Statements 

Income Statement: 

1. Create a new sheet and rename it as `Income Statement`. 
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2. List all revenue and expense accounts to calculate the net profit or loss. 

Example: Income Statement 

Description Amount 

Sale Revenue 10,000 

Cost of Goods Sold (6,000) 

Gross Profit 4,000 

Salaries Expenses (2,000) 

Net Profit 2,000 

 

Balance Sheet: 

1. Create a new sheet and rename it as `Balance Sheet`. 

2. List all asset, liability, and equity accounts to ensure the accounting equation is balanced. 

Example: Balance Sheet 

Description Amount 

Assets  

Cash 8,000 

Inventory 6,000 

Total Assets 14,000 

Liabilities  

Account Payable 0 

Total Liability  0 

Equity  

Retained Earnings 14,000 

Total Equity 14,000 

Total Liablities 14,000 

By following these steps, you can efficiently prepare accounts in Excel, maintaining accurate 

financial records and generating essential financial statements. 

 

4.6 Keywords: 

1. Recording: Entering financial transactions into accounting records. 

2. Classification: Sorting transactions into appropriate categories (e.g., assets, liabilities, 

revenue, expenses). 

3. Summarization: Aggregating data into financial statements like balance sheets and income 

statements. 

 

4.7 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K.Nadhani 

2. "Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 

          

Radha Krishna.V 

 

 



 

 

Lesson - 5 

ANALYSIS & INTERPRETATION 
 

Objective: 

1. Financial Statement Analysis: Introduce techniques for analyzing financial statements to 

assess an organization's performance. 

2. Ratio Analysis: Explain key financial ratios and how to calculate and interpret them. 

3. Trend Analysis: Describe the process of conducting trend analysis to identify patterns over 

time. 

4. Variance Analysis: Discuss variance analysis and its importance in comparing actual 

performance with budgeted figures. 

5. Decision-Making: Highlight how analysis and interpretation of financial data aid in 

informed decision-making. 

 

Structure: 

5.1 Introduction 

5.2 Financial Statements 

5.3 Budgeting in Excel 

5.4 Conclusion 

5.5 Keywords 

5.6 Reference 

 

5.1 Introduction: 

Detailed Explanation on Financial Statements and Budgeting using MS Excel: Analysis and 

Interpretation 

Financial Statements and Budgeting are crucial components of financial management. 

Microsoft Excel is a powerful tool for creating, analyzing, and interpreting these elements. 

Here’s a detailed guide on preparing, analyzing, and interpreting financial statements and 

budgets using Excel. 

 

5.2 Financial Statements 

Financial Statements are formal records of the financial activities and position of a business, 

person, or entity. The primary financial statements include the Income Statement, Balance 

Sheet, and Cash Flow Statement. 

A. Income Statement 

The Income Statement shows the company's revenues and expenses during a particular 

period, highlighting how the revenues are transformed into net income or net profit. 

Steps to Create an Income Statement in Excel: 

1. Open Excel and create a new workbook. 

2. Create Columns for the following headers: 

   - Date 

   - Revenue 

   - Expenses (various categories such as Cost of Goods Sold, Salaries, Rent, etc.) 

   - Net Profit/Loss 

Example: Income Statement 

DATE REVENUE COGS SALARIES RENT OTHEREXP TOTAL 

EXP 

NET 

PROFIT

/LOSS 

1/1/24 10,000 6,000 2,000 1,000 500 9,500 500 
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Analysis and Interpretation: 

- Revenue Growth: Compare revenues over different periods to analyze growth. 

- Expense Management: Evaluate if expenses are within expected limits. 

- Profitability: Determine net profit margins and assess overall profitability. 

 

B. Balance Sheet 

The Balance Sheet provides a snapshot of a company's financial position at a specific point in 

time, listing assets, liabilities, and equity. 

 

Steps to Create a Balance Sheet in Excel: 

1. Open Excel and create a new workbook. 

2. Create Sections for Assets, Liabilities, and Equity. 

3. List All Accounts and their balances under the respective sections. 

 

Example: Balance Sheet 

ASSETS AMOUNT LIABILITES AMOUNT EQUITY AMOUNT 

CASH 8,000 ACCOUNTS 

PAYABLE 

6,000 COMMON 

STOCK 

10,000 

INVENTORY 6,000   RETAINED 

EARNINGS 

2,000 

TOTAL 

ASSETS 

14,000 TOTAL 

LIABLITIES 

6,000   

 

Analysis and Interpretation: 

- Liquidity: Assess the company’s ability to cover short-term obligations with current assets. 

- Solvency: Evaluate long-term stability by comparing total liabilities with total equity. 

- Asset Management: Examine the composition and utilization of assets. 

 

C. Cash Flow Statement 

The Cash Flow Statement shows the cash inflows and outflows from operating, investing, 

and financing activities over a period. 

 

Steps to Create a Cash Flow Statement in Excel: 

1. Open Excel and create a new workbook. 

2. Create Sections for Operating Activities, Investing Activities, and Financing Activities. 

3. List All Cash Flows under respective sections. 

Example: Cash Flow Statement  

Operating Activities Amount 

Cash from customers 10,000 

Cash paid to supplier (6,000) 

Cash paid for salaries (2,000) 

Net Cash from Operating Activities 2,000 

Investing Activities Amount 

Purchase of Equipment (1,000) 

Net Cash from Investing Activities (1,000) 

Financing Activities Amount 

Issuance of Stock 5,000 

Net Cash from Financing stock 5,000 
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Net Increase in Cash -6,000 ; Cash at Beginning – 2,000 ; Cash at end – 8,000 

Analysis and Interpretation: 

- Cash Flow Adequacy: Determine if operating activities generate sufficient cash. 

- Investment Assessment: Evaluate cash used in or generated from investing activities. 

- Financing Strategy: Assess how financing activities affect cash flow. 

 

5.3 Budgeting in Excel 

Budgeting involves forecasting future revenues and expenses to plan for financial activities. 

Excel is highly useful for creating and managing budgets. 

 

Steps to Create a Budget in Excel: 

1. Open Excel and create a new workbook. 

2. Create Headers for the budget period (e.g., months, quarters). 

3. List All Revenue and Expense Categories. 

Example: Monthly Budget 

Category January Feburary March April Total 

Revenue 10,000 12,000 11,000 13,000 46,000 

COGS 6,000 7,000 6,500 7,500 27,000 

SALARIES 2,000 2,000 2,000 2,000 2,000 

RENT 1,000 1,000 1,000 1,000 4,000 

OTHER EXP 500 600 550 700 2,350 

NET  PROFIT 500 1,400 950 1,800 4,650 

Analysis and Interpretation: 

- Variance Analysis: Compare actuals against the budget to identify variances. 

- Trend Analysis: Analyze trends in revenues and expenses over the budget period. 

- Resource Allocation: Ensure resources are allocated efficiently to maximize profits. 

 

5.4 Conclusion: 

Using Excel for preparing financial statements and budgeting involves: 

- Setting up structured worksheets. 

- Inputting accurate financial data. 

- Utilizing Excel functions for calculations and analysis. 

 

With Excel's powerful tools, you can perform detailed analysis and interpretation, enabling 

better financial decision-making and strategic planning. 

 

5.5 Keywords: 

Analysis, Interpretation, Excel, Data Visualization. 

Explanation: These keywords refer to the process of examining data using Excel tools to 

draw meaningful conclusions and insights, often involving visual representations for clarity 

and understanding. 

 

5.6 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K. Nadhani 

2. "Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 

 

         Radha Krishna.V 

 



Lesson - 6 

SELECTION OF AN ACCOUNTING SOFTWARE 

 

Objective: 

1. Criteria for Selection: Identify the key criteria to consider when selecting accounting 

software. 

2. Software Options: Provide an overview of popular accounting software options available 

in the market. 

3. Feature Comparison: Compare the features and functionalities of different accounting 

software. 

4. Customization and Scalability: Discuss the importance of customization and scalability in 

accounting software. 

5. Cost-Benefit Analysis: Explain how to conduct a cost-benefit analysis to choose the most 

suitable accounting software. 

 

Structure: 

6.1 Introduction 

6.2 Popular Accounting Software Options 

6.3 Selection of Accounting Software was done with Tally Prime 4.1 

6.4 Key Factors in Selecting Accounting Software 

6.5 Why Tally Prime 4.1? 

6.6 Steps in Selecting Tally Prime 4.1 

6.7 Selection Of an Accounting Software 

6.8 Types Of Accounting Software 

6.9 Systematic Software 

6.10 Software Manufactured as per Requirement 

6.11 Keywords 

6.12 Reference 

 

6.1 Introduction: 

Selecting the right accounting software for your business is crucial as it can greatly impact 

your financial management and overall business efficiency. Here’s a clear guide to help you 

make an informed decision: 

 

1.Identify Your Business Needs 

- Size of the Business: Small businesses may need basic features, while larger businesses 

might require advanced functionalities. 

- Type of Business: Different industries have different accounting requirements. For instance, 

a retail business might need robust inventory management. 

- Number of Users: Determine how many people will need access and their roles. 

-Budget: Set a budget for your accounting software, considering both initial costs and 

ongoing fees. 

 

2. Key Features to Consider 

-Core Accounting Features: Ensure the software includes essential features such as general 

ledger, accounts payable, accounts receivable, and bank reconciliation. 

- Financial Reporting: Look for customizable financial reports, including balance sheets, 

income statements, and cash flow statements. 

- Automation: Features like automated billing, invoicing, and payment reminders can save 

time and reduce errors. 
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- Tax Preparation: Integration with tax software and tools for tax calculations can simplify 

tax filing. 

- Inventory Management: Useful for businesses that need to track inventory levels, orders, 

and sales. 

-Payroll Processing: If you have employees, integrated payroll features can help manage 

salaries, deductions, and compliance with tax laws. 

- Scalability: Choose software that can grow with your business, allowing for additional 

features or users as needed. 

 

3. Ease of Use 

- User-Friendly Interface: The software should be intuitive and easy to navigate, even for 

users without an accounting background. 

- Training and Support: Availability of training resources, customer support, and user 

community forums can be very helpful. 

 

4. Integration Capabilities 

- Compatibility: Ensure the software integrates seamlessly with other tools you use, such as 

CRM systems, e-commerce platforms, and banking apps. 

- API Availability: Having an open API can be beneficial for custom integrations or 

advanced data management needs. 

 

5. Security 

- Data Protection: Look for software with robust security measures, including data 

encryption and secure backup. 

- Access Controls: The ability to set user permissions and access levels to protect sensitive 

financial information. 

 

6. Vendor Reputation and Reviews 

-Research Vendors: Look into the history and reputation of the software provider. 

- User Reviews: Read reviews and testimonials from other users to gauge their experiences 

with the software. 

- Case Studies: Check for case studies or success stories from businesses similar to yours. 

 

7. Cost Considerations: 

-Pricing Structure: Understand the pricing model – is it a one-time purchase, subscription-

based, or pay-per-user? 

-Hidden Costs: Be aware of any additional costs for add-ons, extra users, or customer 

support. 

 

8. Trial and Demonstration 

- Free Trial: Take advantage of free trials to test the software and see if it meets your needs. 

- Product Demo: Request a demonstration from the vendor to better understand the 

software’s capabilities and features. 

 

9. Compliance 

-Regulatory Compliance: Ensure the software helps you comply with local and international 

accounting standards and regulations (e.g., GAAP, IFRS). 

- Tax Compliance: It should support local tax laws and help in accurate tax reporting and 

filing. 
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10.Customer Support 

-Support Availability: Check the availability and responsiveness of customer support, 

including options for phone, email, or live chat. 

- Help Resources: Access to comprehensive help resources, such as manuals, FAQs, and 

video tutorials. 

 

6.2 Popular Accounting Software Options 
-QuickBooks: Suitable for small to medium-sized businesses; offers a wide range of features 

and integrations. 

- Xero: Known for its user-friendly interface and robust feature set, ideal for small 

businesses. 

-FreshBooks: Best for freelancers and small businesses that need simple, easy-to-use 

invoicing and expense tracking. 

-Sage: Provides solutions for small businesses to large enterprises, with strong accounting 

and ERP capabilities. 

-Zoho Books: Affordable option with strong features, especially good for small businesses. 

-Tally Prime: Widely used in countries like India, offering comprehensive accounting and 

inventory management features. 

 

By carefully evaluating these aspects, you can select an accounting software that best fits 

your business requirements, enhancing efficiency and ensuring accurate financial 

management. 

 

6.3  Selection of Accounting Software was done with Tally Prime 4.1: 

Selecting accounting software is a crucial decision for any business as it impacts financial 

management, compliance, and operational efficiency. When choosing accounting software 

and deciding on Tally Prime 4.1, several factors need to be considered. Here's a detailed 

overview of the selection process and why Tally Prime 4.1 might be the preferred choice: 

 

6.4 Key Factors in Selecting Accounting Software 

1. Business Requirements: 

   - Size of Business: Small, medium, or large. 

   - Industry: Specific needs based on industry. 

   -Number of Users: Single user or multi-user environment. 

   - Scalability: Ability to grow with your business. 

 

2. Features and Functionalities: 

   - Core Accounting: General ledger, accounts payable/receivable, bank reconciliation. 

   -Advanced Features: Inventory management, payroll processing, GST compliance. 

   - Customization: Ability to customize reports and dashboards. 

   - Integration: Compatibility with other software (CRM, ERP). 

 

3. Ease of Use: 

   -User Interface: Intuitive and easy to navigate. 

   - Training and Support: Availability of tutorials, customer support, and documentation. 

 - Implementation: Ease of setting up and migrating data. 

 

4. Cost: 

   - Upfront Costs: Purchase or subscription fees. 

   - Ongoing Costs: Maintenance, updates, and support. 
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   - Value for Money: ROI based on features and business benefits. 

 

5. Security: 

   - Data Protection: Security measures to protect financial data. 

   - Access Controls: User permissions and role-based access. 

 

6. Compliance: 

   - Regulatory Compliance: Adherence to local and international accounting standards. 

   - Audit Trails: Tracking changes and maintaining records for audits. 

 

6.5 Why Tally Prime 4.1? 

Tally Prime 4.1 is a popular choice for many businesses due to its robust features, ease of use, 

and cost-effectiveness. Here’s a detailed breakdown of why Tally Prime 4.1 might be the right 

choice: 

 

1.Comprehensive Features: 

   - Accounting and Finance: Complete solution for managing accounts, general ledger, 

invoicing, and financial reporting. 

   - Inventory Management: Efficient tracking of stock, inventory valuation, and stock 

movement. 

   - GST Compliance: Seamless GST return filing, invoicing, and compliance with Indian tax 

laws. 

   - Multi-User Environment: Supports multiple users with role-based access controls. 

 

2. Ease of Use: 

   - User-Friendly Interface: Simple and intuitive interface that reduces the learning curve. 

   - Quick Implementation: Easy to set up with minimal training required for users. 

 

3. Cost-Effective: 

   - Affordable Pricing: Competitive pricing with a good balance of features and costs. 

   - No Hidden Costs: Transparent pricing model without hidden fees. 

 

4. Customization and Flexibility: 

   - Customizable Reports: Ability to generate customized reports based on specific business 

needs. 

   - Scalable Solution: Can be scaled to meet the growing needs of a business. 

 

5. Integration and Compatibility: 

   - Integration with Other Systems: Ability to integrate with other business systems and 

software. 

   - Data Migration: Tools and support for migrating data from other accounting systems. 

 

6. Security and Compliance: 

   - Data Security: Strong security measures to protect sensitive financial data. 

   - Audit and Compliance: Built-in features for maintaining audit trails and ensuring 

compliance with accounting standards. 

 

6.6 Steps in Selecting Tally Prime 4.1 

1. Needs Assessment: 
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   - Conduct a thorough needs assessment to understand the specific requirements of your 

business. 

   - Identify the must-have features and functionalities. 

2. Market Research: 

   - Research various accounting software options available in the market. 

   - Compare features, pricing, and reviews. 

3. Evaluation: 

   - Evaluate Tally Prime 4.1 against the identified requirements. 

   - Consider ease of use, customization, integration, and support. 

4. Demo and Trial: 

   - Request a demo or trial version of Tally Prime 4.1. 

   - Test the software with real data and scenarios to ensure it meets your needs. 

5. Decision and Purchase: 

   - Based on the evaluation, make an informed decision. 

   - Purchase the software and plan for implementation and training. 

6. Implementation: 

   - Install and set up Tally Prime 4.1. 

   - Migrate existing data and configure the software according to business requirements. 

7. Training and Support: 

   - Provide training to users. 

   - Ensure access to customer support and resources. 

By following these steps and considering the factors outlined, businesses can make an 

informed decision to select Tally Prime 4.1, ensuring it aligns with their financial 

management needs and business objectives. 

 

6.7 Selection Of an Accounting Software: 

Information and technology has established new dimensions in every sphere of life and after 

scientific activities, most of the work has been done in the business world. 

• Various types of software have been created for the smallest needs of business, so that 

business tasks which used to take hours are now completed in minutes. • There are many 

accounting software such as Tally, Busy, Marg are available in India to perform business 

functions, but among them the most popular software in India is Tally because it keeps up 

with the changing business activities. 

 

6.8 Types Of Accounting Software: 

Ready-to-Use Software: Such software can be used by ordinary users as soon as they are 

received and their maintenance cost and training cost are both very low. This is the reason 

why they are used more by a small and traditional business concerns. Tally Prime and Busy 

are the most popular software in India.  

Advantages: 

• The results of this software' are more accurate and faster. 

• This software is used by most of the small businessmen, so the employees working on this 

software are easily available. 

Disadvantages: 

• The level of confidentiality in this software is low. 

• This software has limited connectivity with other information systems. 

 

6.9 Systematic Software: Software that can be modified according to the instructions of the 

user. They are called organized or customized software. Such software is expensive. Often 
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this type of software is used in organizations where financial dealings are of some special 

nature. 

Advantages: 

Such software is designed according to the needs of the consumer. 

Such software maintains a high level of confidentiality. 

Disadvantages: 

The cost of this type of software is high. Hence it is unsuitable for small entrepreneurs. 

>The user of this software needs more training. 

 

6.10 Software Manufactured as per Requirement: 
 Such software which is prepared and provided by the software company according to the 

requirement and instructions of the user, is called asRequired manufactured software. Such 

software has a high degree of confidentiality and such software is used in large commercial 

organizations. 

Advantages: 

>This software has a high level of privacy. 

>It is more useful for large business organizations. 

Disadvantages: 

This is specialized software, so it can be used only by trained personnel. 

The cost of this software is high as compared to others. 

 

6.11 Keywords: 

When selecting accounting software, consider keywords like scalability, user-friendliness, 

integration, and security. Scalability ensures the software can grow with your business, while 

user-friendliness enhances adoption and efficiency. Integration capability with other tools 

streamlines operations, and robust security features protect sensitive financial data. Choose 

software that aligns with your business needs and future growth plans. 

 

6.12 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K.Nadhani 

2. "Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 
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Lesson – 7 

INTRODUCTION TO TALLY PRIME 
 

Objective: 

1. Overview of Tally Prime: Introduce Tally Prime and its role in computerized accounting. 

2. Key Features: Outline the key features and capabilities of Tally Prime. 

3. User Interface: Describe the user interface and navigation of Tally Prime. 

4. Installation Process: Provide instructions on how to install Tally Prime. 

5. Benefits of Using Tally Prime: Discuss the benefits of using Tally Prime for accounting 

and financial management. 

 

Structure: 

7.1 What is Tally Prime? 

7.2 History of Tally Prime 

7.3 Key Features or Core Modules of Tally Prime 

7.4 Uses of Tally Prime 

7.5 Introduction to Tally Prime 

7.6 Salient Features of Tally Prime 

7.7 Requirements to be statisfied to Install Tally Prime 

7.8 Keywords 

7.9 Reference 

 

7.1 What is Tally Prime? 

Tally Prime is an accounting software that makes recording and organizing accounting 

information so simple that in no time, you will be in greater control of your business, 

business (whether small. medium or large enterprises), right from invoicing to insights that 

matter to business growth. 

 

7.2 History of Tally Prime: 

Tally Solutions Pvt. Ltd. is an Indian multinational technology company, that provides 

enterprise resource planning software. It is headquartered in Bangalore, Karnataka. 

Tally Solutions was co-founded in 1986 by Shyam Sunder Goenka and his son Bharat 

Goenka after the family's cotton business was destroyed by fire. It began as Peutronics 

Financial Accountant, an accounting software application. The company was incorporated in 

1991 and was renamed Tally Solutions in 1999. 

The first version of the accounting software was launched as an MS-DOS application. It had 

only basic accounting functions, and was named Peutronics Financial Accountant. 

• In 2006, Tally launched Tally 8.1, a concurrent multi-lingual version, and also Tally 9 

In 2009, the company released Tally Prime, a business management solution 

• In 2015, the company launched a program called Vriddhi to certify and classify its business 

partners. Also in 2015. Tally Solutions announced the launch of Tally ERP 9 Release 5.0 with 

taxation and compliance features. 

• In 2016, Tally Solutions was shortlisted as a GST Suvidha Provider to provide interface 

between the new Goods and Services Tax (GST) server and taxpayers, and in 2017, the 

company launched its updated GST compliance software. 

• In 2020, the company released Tally Prime. 

•In 2022. they introduced Tally Prime Edit Log. 

 

7.3 Key Features or Core Modules of Tally Prime: 
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Tally Prime, a complete accounting software, helps you manage several functions of the 

business, starting from recording business transaction to generating complex reports in an 

integrated manner.  

 Accounts receivable, for all money the business receives. 

 Accounts payable, for all Money the business owes. 

 Pre-defined chart of accounts. 

 Invoicing and billing  

 Flexible inventory management 

 Insightful business reports 

 Sales and purchase management 

 Record and Book keeping 

 Transact in multiple currencies 

 Online business reports 

 Employee Payroll Management 

 Multi-company Support 

 Cost tracking and analysis 

 Complete solutions for GST, TDS  and TCS 

 

7.4 Uses of Tally Prime: 

Simple and as per modern software standards: 

Tally Prime is the latest version of Tally and the main and most evident difference in the 

latest version when compared with the older version is the look of the software. The new 

version i.e Tally Prime looks very classy and is also soothing to the eyes of the user. 

It is also simpler to use. Understanding the user, the software is made in such a way that 

every screen of Tally can be accessed with a simple search bar called the 'Go To search' 

switch. Type out the screen name for example if I wish to check my Balance sheet. I can 

simply type 'Balance sheet and it will display suggestions and I can click the one I want to 

see. It has the same functionality as the Google search engine you type and get whatever you 

want. 

More Flexibility: 

Tally Prime provides you with the flexibility to access your Tally data in the form of reports 

from any device and at any time. You can log in to your account from the Tally Solutions 

website and view your Tally data reports. 

Future Ready: 

When a business grows over some time, it's expected that new features and functions will be 

added to its existing ERP software. Tally prime is constantly being updated to accommodate 

new features to suit business needs. This software has the potential to grow with your 

business. 

More Secure: 

Tally prime understands the importance of a company's data and information. Tally Prime has 

come up with built-in security at many levels so that, with tally prime, your data will always 

be secure. User-level security controls, as well as user activity overview, are some of the 

features Tally provides to keep its company data safe. 

Remote Access: 

With tally prime, you can access your important business reports from anywhere outside your 

business premises. Tally Prime brings the ability to access your data from a web browser, or 

any device at anytime from anywhere. Accessing Bills Receivable & Payable. Stock 

Summary, Sales/Purchase Register. Profit & Loss A/C. Balance Sheet, and many such reports 

securely is now possible with the aid of Tally Prime. 
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Data Synchronization: 

Tally Solutions understand that gathering and organizing data from multiple branches is a 

tedious task. To consolidate all your data in one place and provide you with more ease in 

analysing your data, tally has a synchronization feature in tally prime. This feature 

consolidates all your data from different locations and provides it to you in one place. 

Always Stay Compliant: 

Stay compliant with new rules and regulations as introduced by the government. Every new 

compliance rule is made available for Tally users in the latest update. Thus you need to keep 

your software up-to-date. 

Takeaway: 

Tally Prime is one of that software that is a complete business management software package. 

It is a one-time investment that provides you with return throughout your business life-cycle. 

Keeping in mind the requirement of small and medium businesses. 

Tally Prime is being improved every once in a while. One of the biggest advantages of Tally 

is its ability to adapt to every type of business. It has hundreds of features that can be enabled 

or disabled as per the requirement. Due to this reason, more and more businesses in the 

African countries and worldwide are using Tally to maintain their books of accounts. 

 

7.5 Introduction to Tally Prime 

Tally Prime is one of the most widely used financial software. Tally Prime reports can help a 

business owner make informed decisions to increase efficiency, reduce costs, and organize 

business operations. 

With Tally Prime, accurate, up-to-date business information is available at the click of a 

button anytime. It provides a comprehensive solution for the accounting and inventory needs 

of a business. 

It provides the capability to generate fully accurate tax returns in a matter of minutes, 

extracting, interpreting and presenting financial data. 

 

7.6 Salient Features of Tally Prime: 

A leading accounting package:  
The first version of Tally was released in 1988. Today it is recognised as one of the leading 

accounting packages across the world, with over a million customers. 

No accounting codes: 
Unlike other computerised accounting packages which require numeric codes, Tally Prime 

pioneered the 'no accounting codes' concept. Tally Prime users have the freedom to allocate 

meaningful names in plain English to their data items in the system. 

Complete business solution: 
Tally Prime provides a comprehensive solution to the accounting and inventory needs of a 

business. The package comprises financial accounting, book-keeping and inventory 

accounting. It also has various tools to extract, interpret and present data. 

Flexible and easy to use: 
Tally Prime is very flexible. It mimics the human thought process, which means that Tally. 

ERP 9 can adapt itself to any business need. Tally Prime users need not change the way their 

business is run to adapt themselves to the package. 

Speed: 
Tally Prime provides the capability to generate instant and accurate reports, which assist the 

management to take timely and correct decisions for the overall productivity and growth of 

the company. 

Power: 
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Tally Prime allows the user to maintain multiple companies, with unlimited levels of 

classification and grouping capabilities. It also allows drill down facility from report level to 

transaction level. 

Flexibility: 
Tally Prime provides the flexibility to generate instant reports for any given period 

(month/year) or at any point of time besides providing the facility to toggle between 

Accounting & Inventory reports of the same company or between companies. 

Real time processing: 

Tally Prime updates books of accounts, as soon as the transactions are entered, thereby 

facilitating instant report generation. It also facilitates a real-time multi-user environment. 

Versatility: 

Tally Prime is suitable for a range of organisations, from small grocery stores to large 

corporations with international locations and operations. 

Tally Help: 

The Tally Prime Online Help (Alt+H) provides instant assistance on basic and advanced 

features or any other relevant topic of Tally Prime. 

Remote Access: 

Tally Prime provides remote capabilities to access data from anywhere and anytime. 

Control Centre: 
The Control Centre works as an interface between the user and Tally Prime installed at 

different sites and enables the user to centrally configure and administer Site/User belonging 

to an account. 

Support Centre: 

The Support Centre allows a user to directly post his/her support queries on the functional 

and technical aspects of the Product. 

Auditor's Edition: Tally Prime provides auditing and compliance capabilities for Chartered 

Accountants. Statutory Compliance: Tally Prime helps generating 100% accurate tax returns 

within a few minutes. Moreover, it provides the experience of a hand-prepared return to 

ensure that taxation becomes a hassle-free task. It is compatible across Indian tax regimes 

such as VAT, Excise, TDS and Service tax. 

Intelligent Set up Manager: 

• Setup tool can interact with all the components of the operating system  

• It guide’s you in troubleshooting the licensing run-time issues 

Concurrent Multi-Lingual: 

• Viewing them in another language and printing them in yet another Indian language. 

• Capability of maintaining many languages and few international languages. 

Multi- Tasking: 

Viewed and printed from anywhere of the Tally screen without disturbing the current work. 

 

7.7 Requirements to be statisfied to Install Tally Prime: 

Particulars System Recommended Configuration 

Operating system (OS) Microsoft Windows 7 or above. 

System type 64-bit operating system (for the OS and other applications 

such as MS Excel, Adobe Acrobat, and so on). 

Memory (RAM) A minimum of 4 GB or more. 

Hard disk 45 MB of free space to install the application. 
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Processor Intel Core2Duo and above or equivalent. 

Connectivity Continuous connection to the internet. 

Monitor resolution 1024 x 768 or higher. 

 

7.8 Keywords: 

1. Business Management: Tally Prime streamlines accounting, inventory, and compliance for 

businesses. 

2. User-Friendly Interface: Offers an intuitive interface for easy navigation and efficient data 

entry. 

3. Real-time Reporting: Provides accurate and instant financial reports and analysis. 

4. GST Compliance: Ensures seamless GST filing and compliance with Indian tax 

regulations. 

 

7.9 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K. Nadhani 

2. "Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 
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Lesson - 8 

FEATURES OF TALLY PRIME 
 

Objective: 

1. Comprehensive Accounting: Explain the comprehensive accounting features available in Tally 

Prime. 

2. Inventory Management: Describe the inventory management capabilities of Tally Prime. 

3. Tax Compliance: Discuss how Tally Prime helps in ensuring tax compliance and managing 

GST. 

4. Reporting and Analysis: Highlight the reporting and data analysis features in Tally Prime. 

5. Customization and Integration: Explain the customization options and integration capabilities 

of Tally Prime. 

 

Structure: 

8.1 Functional Features of Tally Prime 

8.2 Statement of Accounts 

8.3 Accounts Receivable and Accounts Payable 

8.4 Basic Inventory 

8.5 Advanced Accounting in Tally Prime 

8.6 Advanced Inventory 

8.7 Reorder Levels 

8.8 Stock Ageing Analysis 

8.9 Batch Related Reports 

8.10 Point of Sale (POS) 

8.11 Goods and Services Tax (GST) 

8.12 Tax Deducted at Source (TDS) 

8.13 Tax Collected at Source (TCS) 

8.14 Payroll 

8.15 Technology Advantages in Tally Prime 

8.16 Multi-directory for company management 

8.17 Keywords 

8.18 Reference 

 

8.1 Functional Features of Tally Prime: 

Sure! Here’s a detailed explanation of each of these concepts in the context of accounting and 

using software like Tally Prime: 

Complete Bookkeeping 

Bookkeeping is the systematic recording, storing, and retrieving of financial transactions for a 

business. It includes: 

- Recording: All financial transactions are recorded in journals and ledgers. 

- Storing: Records are securely stored and organized for easy access. 

-Retrieving: Financial information is easily retrievable for analysis, reporting, and auditing. 

Books, Registers, and Statement of Accounts 

-Books: Refers to the various journals and ledgers where financial transactions are recorded. 

Common types include: 

  - General Journal: Records all types of transactions. 
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  - Special Journals: Used for specific types of transactions like sales, purchases, cash receipts, 

and disbursements. 

- Registers: Detailed records within the accounting system that keep track of specific types of 

transactions or data. 

  -Purchase Register: Records all purchase transactions. 

  - Sales Register: Records all sales transactions. 

  - Cash Register: Tracks cash transactions. 

 

8.2Statement of Accounts: Summarizes the financial transactions and status of a specific 

account, providing a clear picture of the account's balance and activities over a period. 

General Ledger 

The general ledger is a complete record of all financial transactions made by a business. It 

includes: 

- Accounts: Each account (assets, liabilities, equity, revenue, expenses) is maintained within the 

general ledger. 

- Debits and Credits: Each transaction is recorded with a debit and a credit entry in respective 

accounts. 

- Trial Balance: A statement listing all the closing balances of the general ledger accounts to 

ensure that debits equal credits. 

 

8.3 Accounts Receivable and Accounts Payable 

- Accounts Receivable (AR): Represents money owed to the business by customers for goods or 

services delivered. AR management includes: 

  - Invoicing: Sending invoices to customers. 

  - Collection: Tracking and collecting payments. 

  - Aging Report: Monitoring overdue invoices. 

- Accounts Payable (AP): Represents money the business owes to suppliers for goods or 

services received. AP management includes: 

  - Bill Entry: Recording bills from suppliers. 

  - Payments: Tracking and making payments. 

  - Aging Report: Monitoring due and overdue bills. 

Flexible Voucher Numbering 
Flexible voucher numbering allows businesses to customize the numbering sequence of vouchers 

(documents recording transactions) for better organization and identification. This can include: 

-Automatic Numbering: Sequential numbering of vouchers. 

- Manual Numbering: Users can assign specific numbers. 

- Prefix/Suffix: Adding prefixes or suffixes to voucher numbers for categorization (e.g., INV-001 

for invoices). 

Flexible Classification of Heads 

Flexible classification of heads refers to the ability to categorize and organize accounts under 

different heads or groups. This includes: 

- Creating Groups: Categorizing accounts into groups (e.g., assets, liabilities, income, expenses). 

- Sub-Groups: Creating sub-categories for detailed tracking (e.g., under assets: current assets, 

fixed assets). 

- Custom Classification: Customizing account groups based on business needs. 

Panoramic View 
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A panoramic view provides a comprehensive overview of financial data on a single screen. This 

can include: 

-Dashboard: A visual representation of key financial metrics and performance indicators. 

-Summary Reports: Consolidated reports showing the overall financial position. 

Drill-Down Display 
Drill-down display allows users to click on summarized data to view detailed information. This 

feature helps in: 

- Analyzing: Viewing transaction details behind summary figures. 

- Tracing: Identifying the source and specifics of entries. 

Database Reporting 
Database reporting involves generating reports from the accounting database to analyze financial 

data. This includes: 

-Custom Reports: Creating specific reports based on business needs. 

-Standard Reports: Predefined reports like balance sheet, profit and loss statement, etc. 

Voucher and Cheque Printing 

Voucher and cheque printing enables businesses to print transaction vouchers and cheques 

directly from the software. This feature includes: 

-Custom Templates: Designing templates for vouchers and cheques. 

-Batch Printing: Printing multiple documents at once. 

Columnar Reports: 

Columnar reports present data in columns for easy comparison and analysis. This format is used 

for: 

- Financial Statements: Presenting multiple periods side by side. 

- Comparative Analysis: Comparing different departments, products, or time periods. 

Bank Reconciliation 

Bank reconciliation is the process of matching the accounting records with the bank statement. 

This ensures: 

- Accuracy: Identifying discrepancies between the books and the bank. 

- Completeness: Ensuring all transactions are recorded. 

Cash Flow Statements 

Cash flow statements track the flow of cash in and out of the business, providing insights into: 

- Operating Activities: Cash generated from core business operations. 

- Investing Activities: Cash used for investments in assets. 

- Financing Activities: Cash flows from borrowing and repaying debt, and equity financing. 

Each of these features is critical for maintaining accurate and efficient financial management 

within a business, and tools like Tally Prime are designed to provide comprehensive solutions for 

these accounting needs. 

 

8.4 Basic Inventory: 

Here's an explanation of the various inventory management features in Tally Prime: 

Stock Items 

Stock items are individual products or goods that a business trades. Each stock item in Tally 

Prime includes: 

-Item Details: Name, description, and part number. 

-Unit of Measure: The unit in which the item is measured (e.g., pieces, kilograms). 

- Stock Group: Categorization for better management (e.g., electronics, apparel). 
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Stock Categories: 

Stock categories provide a way to classify stock items based on common features or 

characteristics, helping in detailed reporting and analysis. For example: 

- Categories: Such as 'Raw Materials', 'Finished Goods'. 

- Analysis: Facilitates comparison and performance tracking within a category. 

Stock Query by Stock Group or Stock Category 

Tally Prime allows users to query stock based on groups or categories, providing insights into: 

- Stock Levels: Current quantity on hand. 

- Valuation: Value of stock based on different methods (e.g., FIFO, LIFO). 

- Movements: Transactions affecting stock levels. 

Multiple Godowns/Locations 

Managing multiple godowns or locations allows businesses to track inventory stored at different 

places. Features include: 

-Godown Creation: Set up multiple storage locations. 

- Tracking: Monitor stock levels at each godown. 

- Reporting: View reports based on location-wise stock. 

Stock Transfers to Godowns 

Stock transfers involve moving inventory between godowns. Tally Prime supports: 

- Transfer Entries: Recording internal stock transfers. 

- Tracking: Keeping track of stock movements between locations. 

- Cost Allocation: Allocating transfer costs to the relevant godown. 

Multiple Stock Valuation: 

Tally Prime supports various stock valuation methods to meet different business needs: 

- FIFO (First In, First Out): Assumes oldest inventory is sold first. 

- LIFO (Last In, First Out): Assumes newest inventory is sold first. 

- Weighted Average: Values inventory based on the average cost of items. 

- Specific Identification: Tracks specific items for unique valuation. 

Batch Wise 

Batch-wise inventory management helps in tracking inventory by batches, which is crucial for 

perishable goods or items requiring lot control: 

- Batch Numbers: Assign unique batch numbers to items. 

- Expiry Dates: Track and manage expiry dates for each batch. 

- Batch Reports: Generate reports based on batch information. 

Alternative Units 

Alternative units allow the same stock item to be managed in different units of measure: 

- Multiple Units: Define primary and alternative units (e.g., pieces and cartons). 

- Conversion: Set up conversion rates between units (e.g., 1 carton = 12 pieces). 

Additional Cost 

Additional costs refer to extra expenses associated with procuring stock items, such as: 

- Freight: Transportation charges. 

- Insurance: Costs of insuring the goods. 

- Handling Charges: Loading/unloading fees. 

- Allocation: Distribute additional costs to items to get accurate landed cost. 

Sales and Purchase Order Processing 
Order processing involves managing customer orders (sales) and supplier orders (purchases): 

- Sales Orders: 
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  - Creation: Record customer orders. 

  - Tracking: Monitor order status (pending, fulfilled). 

  - Invoicing: Convert orders into sales invoices. 

- Purchase Orders: 

  - Creation: Record orders placed with suppliers. 

  - Tracking: Monitor order status (pending, received). 

  - Goods Receipt: Convert orders into purchase invoices or goods receipts. 

- Order Management: Ensures efficient handling and fulfillment of orders. 

Putting It All Together 
Combining these features, Tally Prime offers a robust inventory management system. Businesses 

can efficiently manage their inventory across multiple locations, track items batch-wise, and 

handle complex valuation and unit conversion requirements. Order processing ensures smooth 

transactions with customers and suppliers, while additional cost allocation provides accurate cost 

management. This comprehensive suite of tools supports the end-to-end inventory lifecycle, from 

procurement to sales, ensuring optimal stock levels and accurate financial records. 

 

8.5 Advanced Accounting in Tally Prime: 

Here's a detailed explanation of the various advanced accounting features in Tally Prime: 

Multiple Companies: 

Tally Prime allows businesses to manage multiple companies within a single software 

installation. This feature is beneficial for businesses with multiple legal entities or branches. Key 

aspects include: 

- Company Creation: Set up multiple companies with their own unique financial records. 

- Inter-Company Transactions: Record and manage transactions between companies. 

- Consolidated Reporting: Generate consolidated financial statements for multiple companies. 

Multi-Currency: 

The multi-currency feature in Tally Prime enables businesses to handle transactions in different 

currencies. This is essential for businesses dealing with international clients or suppliers. Key 

features include: 

-Currency Setup: Define multiple currencies with exchange rates. 

- Transaction Recording: Record sales, purchases, and other transactions in foreign currencies. 

- Exchange Rate Management: Update and manage exchange rates for accurate currency 

conversion. 

- Reporting: Generate reports in base currency with conversion details. 

Multiple Financial Years 

Tally Prime supports the management of multiple financial years, allowing businesses to 

seamlessly transition from one financial year to the next. This feature includes: 

- Year-End Process: Carry forward balances to the next financial year. 

- Historical Data Access: Access and compare financial data across multiple years. 

- Reporting: Generate reports for any financial year without closing the previous one. 

Post-Dated Vouchers: 

Post-dated vouchers in Tally Prime are used to record transactions that will take effect in the 

future. This is useful for planning and managing future cash flows. Key aspects include: 

-Voucher Entry: Record vouchers with a future date. 

- Tracking: View post-dated vouchers separately to distinguish them from current transactions. 

- Automatic Posting: Vouchers become effective automatically on the specified date. 
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Percentage-Based Reporting 
Percentage-based reporting allows businesses to generate reports that show financial data as a 

percentage of a specific base value. This is useful for analysis and comparison. Key features 

include: 

- Sales Analysis: View sales figures as a percentage of total sales. 

- Expense Analysis: View expenses as a percentage of total income. 

- Profitability Analysis: Analyze profit margins as a percentage of sales. 

Ratio Analysis: 

Ratio analysis in Tally Prime provides insights into the financial health and performance of a 

business by calculating various financial ratios. These ratios help in making informed decisions. 

Key ratios include: 

- Liquidity Ratios: Measure the ability to meet short-term obligations (e.g., Current Ratio, Quick 

Ratio). 

- Profitability Ratios: Assess the ability to generate profit (e.g., Gross Profit Margin, Net Profit 

Margin). 

- Solvency Ratios: Evaluate long-term financial stability (e.g., Debt to Equity Ratio). 

- Efficiency Ratios: Analyze how effectively resources are used (e.g., Inventory Turnover Ratio). 

 

8.6 Advanced Inventory: 

Here’s an in-depth explanation of additional inventory management and sales features in Tally 

Prime: 

Bill of Material (BOM): 

The Bill of Material (BOM) is a comprehensive list of components, materials, and instructions 

required to manufacture a product. In Tally Prime, BOM is used for managing production and 

inventory. Key aspects include: 

- Components List: Detailed list of raw materials, parts, and sub-assemblies required to produce 

a finished product. 

- Quantity: Specifies the quantity of each component needed. 

- Production Process: Includes steps and instructions for assembling the components. 

- Cost Tracking: Helps in calculating the total cost of production, including materials and labour. 

 

8.7 Reorder Levels 

Reorder levels help businesses maintain optimal inventory levels by specifying the minimum 

quantity of stock that must be available before placing a new order. In Tally Prime, this feature 

includes: 

- Minimum Stock Level: The threshold below which new stock needs to be ordered. 

- Maximum Stock Level: The upper limit to avoid overstocking. 

- Reorder Quantity: The suggested quantity to order when the stock reaches the reorder level. 

- Alerts and Notifications: Automatic alerts when stock levels fall below the reorder point. 

 

8.8 Stock Ageing Analysis: 

Stock ageing analysis helps businesses evaluate how long inventory has been in stock. This is 

crucial for managing inventory efficiently, particularly for perishable goods. Key features 

include: - Ageing Buckets: Categorize stock based on the duration it has been held (e.g., 0-30 

days, 31-60 days, 61-90 days). 

- Detailed Reports: Generate reports showing the age of each stock item. 
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- Actionable Insights: Identify slow-moving or obsolete stock and take necessary actions such as 

discounts or promotions. 

 

8.9 Batch Related Reports 

Batch-related reports provide detailed information about inventory batches, which is important 

for managing perishable goods, pharmaceuticals, and other batch-specific items. Tally Prime 

offers:- Batch Tracking: Monitor inventory batches throughout the supply chain. 

- Expiry Management: Track expiry dates to ensure timely sales or disposal of products. 

- Batch-wise Reports: Generate reports that provide insights into batch-specific details like 

production date, expiry date, and quantity. 

- Quality Control: Ensure that products meet quality standards by tracking batch information. 

 

8.10 Point of Sale (POS): 

Point of Sale (POS) systems facilitate retail transactions by managing sales at the point where the 

customer makes a purchase. Tally Prime’s POS features include: 

- Sales Invoicing: Quick and efficient generation of sales invoices at the point of sale. 

- Barcode Scanning: Support for barcode scanning to speed up the billing process. 

- Multiple Payment Modes: Accept various payment methods, including cash, credit/debit cards, 

and digital payments. 

- Inventory Updates: Real-time update of inventory levels with each sale. 

- Customer Management: Maintain customer details and transaction history for better service and 

marketing efforts. 

- Discounts and Promotions: Apply discounts and promotional offers at the time of sale. 

Statutory Features in Tally Prime: 

Here is an explanation of the GST, TDS, TCS, and payroll features in Tally Prime: 

 

8.11 Goods and Services Tax (GST) 

GST is a comprehensive indirect tax levied on the manufacture, sale, and consumption of goods 

and services in India. Tally Prime supports comprehensive GST compliance with features like: 

1.GST Setup and Configuration 

   - GST Registration: Enter and manage GSTIN for your business. 

   - Tax Rates: Configure GST rates for different items and services. 

   - HSN/SAC Codes: Maintain HSN (Harmonized System of Nomenclature) codes for goods 

and SAC (Service Accounting Code) for services. 

2.GST Invoicing: 

   - GST Compliant Invoices: Generate invoices that include all mandatory GST details. 

   - Bill of Supply: Create bills of supply for exempted goods and services. 

3. GST Returns: 

   - GSTR-1: Prepare and file outward supply details. 

   - GSTR-2A: Match and reconcile inward supplies. 

   - GSTR-3B: Prepare and file monthly summary returns. 

   - GSTR-9: Annual return filing. 

4. Input Tax Credit (ITC): 

   - ITC Management: Track and claim input tax credit on purchases. 

   - Reconciliation: Reconcile ITC with GSTR-2A. 

5. GST Reports: 
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   - Summary Reports: Generate summary reports for all GST transactions. 

   - Detailed Reports: Access detailed reports for GSTR-1, GSTR-2A, and GSTR3B. 

 

8.12 Tax Deducted at Source (TDS): 
TDS is a means of collecting tax at the source from where an individual's income is generated. 

Tally Prime’s TDS features include: 

1. TDS Configuration: 

   - TDS Nature of Payment: Set up different nature of payments for TDS deduction (e.g., salary, 

contract payments). 

   - TDS Rates: Define and manage TDS rates. 

2. TDS Deduction: 

   - Automatic Deduction: Automatically deduct TDS on applicable transactions. 

   - Expense Booking: Book expenses net of TDS. 

3.TDS Returns: 

   - Form 26Q: Quarterly returns for payments other than salary. 

   -Form 24Q: Quarterly returns for salary payments. 

   - Form 27Q: Returns for payments to non-residents. 

4. TDS Reports: 

   -TDS Computation: Detailed computation of TDS for different periods. 

   - Challan Reconciliation: Reconcile TDS payments with challans. 

 

8.13 Tax Collected at Source (TCS): 

TCS is the tax collected by the seller at the time of sale, which the buyer has to pay over and 

above the sale price. Tally Prime’s TCS features include: 

1. TCS Configuration: 

   - TCS Nature of Goods: Define categories for which TCS is applicable. 

   - TCS Rates: Set up applicable TCS rates. 

2. TCS Collection: 

   - Automatic Collection: Automatically collect TCS on applicable sales. 

   - Invoice Generation: Include TCS details in invoices. 

3. TCS Returns: 

   - Form 27EQ: Quarterly return for TCS collected. 

4. TCS Reports: 

   - TCS Computation: Detailed computation and summary of TCS collected. 

   - Challan Reconciliation: Reconcile TCS payments with challans. 

 

8.14 Payroll: 

Payroll management in Tally Prime covers all aspects of employee salary processing and 

statutory compliance. Key features include: 

1. Payroll Setup: 

   - Employee Details: Maintain detailed employee records. 

   - Salary Structures: Define salary structures with earnings, deductions, and benefits. 

2. Salary Processing: 

   - Attendance & Overtime: Record attendance and overtime. 

   -Payroll Vouchers: Generate payroll vouchers for salary disbursement. 

   - Payslips: Generate and distribute payslips to employees. 
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3. Statutory Compliance: 

   - Provident Fund (PF): Manage PF contributions and generate related reports. 

   - Employee State Insurance (ESI): Manage ESI contributions and compliance. 

   - Professional Tax (PT): Deduct and manage professional tax. 

4. Payroll Reports: 

   - Salary Register: Detailed report of salary payments. 

   - PF/ESI/PT Reports: Compliance reports for statutory deductions. 

   - Tax Reports: TDS on salaries, Form 24Q, and other payroll-related tax reports. 

 

8.15 Technology Advantages in Tally Prime: 

Simple and rapid installation: 
Tally Prime has a simple, menu-driven installation procedure. The user can install the program 

files on any drive if the hard disk has partitions. 

The user can also specify the name and directory location of the program files. Tally Prime uses 

minimum hard disk Unlimited multi-user support: A multi-user version of Tally Prime can be 

installed on a network, having any number space in the local drive. Its installation on the local 

disk takes just a few seconds. of computers with different operating systems such as Win 98, NT, 

2000, XP etc. 

Internal backup/restore: 
Tally Prime has an in-built, user-friendly 'backup and restore' option. It helps the user to take a 

backup of one or more companies or all companies, in a single directory, in the local hard disk, 

or in any external media. 

Data reliability: 
Tally Prime offers reliable data. It uses a flexi-field, flexi-length, self-indexed, weighted file 

structure for an extremely compact and fast database. Tally Prime is robust. Tally Prime uses 

signalling quality data integrity checks, at regular levels, to ensure the complete reliability of 

data. 

User-defined security levels: 
Tally Prime offers high levels of security. Users can define multiple levels of security according 

to their requirements. Every authorised user in the company can have an individual password, 

with rights to use specific features only. The user with the administrator level password will have 

full access and can set controls for other users. 

Data security: 

 Tally Prime's data integrity checks ensure that there are no external changes to the data. Tally 

Prime also uses a binary encoding format of storage to prevent devious grouping of information. 

Tally Audit: 
 The Tally Prime Audit feature provides the user with administrator rights and the capability to 

check the entries made by the authorised users and alter these entries, if necessary. Once the 

entries are audited, Tally Prime displays the altered entries, if any, along with the name of the 

user, who has altered the entry, and the date and time of the alteration. 

Tally Vault: 

 Tally Prime offers a data encryption option called Tally Vault. Without the valid Tally Vault 

password, the data cannot be accessed. Tally Prime follows the DES (Data Encryption Standard) 

encryption method to safeguard data. Transferring of data into a separate company: Tally Prime 

allows users to maintain a company for any number of financial years. Once the books of 

accounts have been completed for the earlier financial years, the user can split the company data 
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into multiple companies as per financial periods required. The user can specify the date from 

which the company has to be split and Tally Prime will split the company to form two companies 

as per periods specified. Once the data has been split, the closing balance of the first period (first 

company) becomes the opening balance for the next period (second company). 

 

8.16 Multi-directory for company management: 
 The user can create multiple directories to store data. The data stored in these directories can be 

accessed directly in Tally Prime, by specifying the path. 

Import/Export of data: 

 Any transaction can be exported and imported to other software after suitably altering the 

current structures to accept the Tally Prime data structure. Data can also be imported to Tally 

Prime by writing a TDL program. The data which is to be exported from Tally Prime can be in 

XML, HTML or ASCII format. 

Data Synchronization: 
Synchronization is the process of exchanging Tally Prime data between two or more locations. 

This process enables a branch office to send its data to the head office, over the Internet or a 

private network. Graphical analysis of data: Tally Prime provides graphical analysis of data 

which helps the user to perform deeper analysis. The user can generate graphical analysis reports 

such as Sales register, Purchase register, Ledgers, Funds flow, Cash flow, Stock Item registers 

and so on. This helps the management to quickly judge performance and be better prepared for 

difficult times. 

Technology Disadvantages in Tally Prime: 

Tally Prime is a robust and widely used accounting software, but like any technology, it has its 

own set of disadvantages. Here are some of the potential drawbacks associated with Tally Prime: 

1. Limited Customization: 

- Preset Functionality: Tally Prime offers a range of pre-configured functionalities that may not 

cater to all specific business needs. Customizing reports or processes to suit unique requirements 

can be limited. 

- Customization Complexity: Customizing Tally Prime often requires deep technical knowledge 

or the assistance of a Tally expert, which can be costly and time-consuming. 

2. Steep Learning Curve: 

- Complex Interface: The user interface, though improved in Tally Prime, can still be complex 

for new users, especially those not familiar with accounting principles. 

- Training Requirement: Businesses may need to invest in training for their employees to fully 

utilize all the features of Tally Prime. 

3. Integration Challenges: 

- Limited Integration: Tally Prime does not easily integrate with many third-party applications 

and services out of the box. This can be a drawback for businesses that use multiple software 

systems and require seamless integration. 

- Manual Data Entry: Due to limited integration capabilities, there may be a need for manual data 

entry, which can be prone to errors and time-consuming. 

4. Cost: 
- Initial Investment: The initial cost of purchasing Tally Prime can be high for small businesses. 

- Ongoing Costs: There are additional costs for annual maintenance, upgrades, and potential 

customization. 

5. Scalability Issues: 
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- Limited Scalability: Tally Prime is well-suited for small to medium-sized enterprises. However, 

as a business grows into a larger enterprise with more complex needs, Tally Prime may not scale 

effectively to handle high volumes of transactions and more complex operations. 

6. Data Security Concerns: 
- Local Data Storage: Traditionally, Tally Prime stores data locally on the user's computer or a 

local server. This can pose a risk if proper backup and security measures are not in place. 

- Backup Management: Users need to manually manage data backups, and failure to do so can 

result in data loss. 

7. Dependency on Tally Experts 

- Technical Support: Businesses often rely on Tally-certified experts for troubleshooting and 

optimizing the software, which can incur additional costs and dependencies. 

8. User Restrictions 

- Limited Multi-User Functionality: While Tally Prime does support multiple users, its 

performance can be affected when multiple users are accessing the system simultaneously, 

particularly in larger organizations. 

- User Access Control: Setting up and managing user permissions can be cumbersome and might 

not be as granular as some businesses require. 

9. Limited Advanced Features: 

- Advanced Analytics: Tally Prime offers basic reporting and analytics. However, it lacks 

advanced business intelligence and data visualization features that more modern ERP systems 

might provide. 

- Mobile Access: Although there are ways to access Tally Prime remotely, its mobile access 

features are not as robust as those found in cloud-based accounting solutions. 

10. Updates and Patches: 

- Manual Updates: Updates and patches need to be manually installed, which can be 

inconvenient and can disrupt business operations if not managed properly. 

- Compatibility Issues: New updates may sometimes cause compatibility issues with existing 

data or customizations. 

 

8.17 Keywords: 

1. Simplified Navigation: Tally Prime offers an intuitive and user-friendly interface, making it 

easier for users to navigate through various features and perform tasks efficiently. 

2.Comprehensive Accounting: It provides robust accounting capabilities, including financial 

management, receivables, payables, and cash flow management, ensuring accurate and timely 

financial reporting. 

3. GST Compliance: Tally Prime is equipped with comprehensive GST features, allowing 

businesses to manage GST returns, invoice generation, and compliance with ease. 

4. Real-time Reporting: The software offers real-time reporting and analytics, providing users 

with instant insights into their business performance and helping in informed decision-making. 

 

8.18 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K. Nadhani 

2. "Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 

 

     Srihari Nizampatnam 

 



 

 

Lesson - 9 

COMPANY CREATION 

 
Objective: 

1. Steps to Create a Company: Detail the step-by-step process for creating a new company in 

Tally Prime. 

2. Essential Information: Identify the essential information required during the company creation 

process. 

3. Configuration Options: Explain the various configuration options available when setting up a 

new company. 

4. Data Security: Discuss the importance of data security and how to secure company 

information in Tally Prime. 

5. Customization: Explore the customization options available for tailoring the company setup to 

specific business needs. 

 

Structure: 

9.1 Introduction 

9.2 Business Scenario 

9.3 Procedure to Create a Company in Tally Prime 

9.4 Company Features Screen 

9.5 Alteration of Company 

9.6 Shut Company in Tally Prime 

9.7 Select Company 

9.8 Keywords 

9.9 Reference 

 
9.1 Introduction: 

Maintaining accounts under the manual system of accounting is a tedious and time-consuming 

activity. Under this system, transactions are first recorded in journals, then the entries are posted 

into the respective ledger accounts and then a trial balance is prepared, to verify whether, the 

ledger summaries of all account transactions are accurate. If the totals of the debit and credit side 

of the trial balance are not equal, then to rectify the same, adjusting entries are passed and ledger 

entries are corrected. Finally, the transactions data is used to prepare the accounting reports for 

each accounting period. With the increase in scale of business and volume of business 

transactions, the difficulties and complexities of maintaining accounts also increases. 

Computerized accounting puts an end to the above tedious and time-consuming process. It 

involves the simple cycle of one-time creation of the ledgers, followed by the recording of day-

to-day transactions. The rest of the accounting process including generation of financial reports 

is automated. 

Among accounting software, Tally Prime stands out for its simplicity and efficiency. It is one of 

the fastest and most powerful concurrent multi-lingual Business Accounting and Inventory 

Management software  available in the market. It is a fully integrated, affordable and highly 

reliable software. Tally Prime is easy to buy, quick to install, and easy to learn and use. Tally 

Prime is designed to automate and integrate all business operations, such as sales, finance, 

purchasing, inventory, 



Company Creation        9.2  Software Solutions to Accounting 

 

 

and manufacturing. 

Let us understand how to get started with Tally Prime, before moving on to recording 

transactions. 

Mouse and Keyboard Conventions: 

Mouse and keyboard Convention 

Action Particulars 

Fn Press the Function key 

Fn Press Alt+ Function key 

Fn Press Ctrl+ Function key 

 

Switching between Screen Areas: 

When Tally Prime first loads, the Gateway of Tally screen is displayed. To switch between the 

main screen area and calculator at the bottom of the screen, press Ctrl+N or Ctrl+M. Press 

Ctrl+Alt+T to navigate to Product and Features screen, press Ctrl+Alt+L to navigate to the 

License and Services detail screen, press Ctrl+Alt+F to navigate to Configuration Information 

screen. 

Quitting Tally 

You can exit the program from any Tally screen, but Tally requires all screens to be closed before 

it shuts down. 

To quit working on Tally: 

Press Esc until you see the message Quit? Yes or No. Press Y or Enter, or click on Yes to quit 

Tally 

Alternatively, to Exit without confirmation, press Ctrl+Q from Gateway of Tally 

You can also press Enter or Quit in the Gateway of Tally 

Now that you are familiar with Gateway of Tally and keyboard conventions, let us use a business 

scenario to illustrate the creation of a company in Tally Prime before recording business 

transactions in its books of account. 

9.2 Business Scenario: 

Nidhi Sales Pvt Ltd., is a dealer in computer hardware. The company maintained its accounts 

manually till March 2024. In April 2024, the company installed Tally Prime 

After installation of Tally Prime the company's accountant is required to create the company, 

'Nidhi Sales Pvt Ltd.' in Tally Prime. After company creation, ledgers and groups have to be 

created as per the previous year's balance sheet with their balances to record further transactions. 

Working in Tally Prime: 

 From the License screen, T: Continue in Educational Mode option can be selected in case 

you want to use Tally Prime without a license.  

 This is very well used for learning purpose and also there are very few restrictions in 

educational mode. 

 One of the major restrictions in education mode is Date Restriction. You can use only 

1st, 2nd and 31st date of any of the month for recording a voucher or viewing a report. 

 To work on TallyPrime without License, 
 From the License screen, Click on T: Continue in Educational Mode in the license 
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The first step in working with TallyPrime is to create a Company. A Company in TallyPrime is a 

central repository where we can maintain all the financial records of our business, and we can 

extract the required financial reports and statements. 

To create the company in TallyPrime, Open TallyPrime> Select Company screen appears. The 

same screen appears after reactivating the license in TallyPrime the Select Company screen. 

 
 

Explanation about Select Company Options: 

 

 

 You can create the company in the same drive where Tally Prime is installed. If required 

you may 

also press 

backspace 

and change 
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the Data directory drive. 

 If you have configured the company for remote access feature in the remote end this 

option to be selected to access the data remotely.

 The Drive path can be mentioned where the data to be stored/saved. By using copy & 

paste 

 (Ctrl+ C or Ctrl +Alt+ C

location path manually. 

 If already the transactions a

path if you want to maintain the data this option to be selected. We can also browse the 

required location from this option.

9.3 Procedure to Create a Company in Tally Prime:

From the Select Company Screen > Click on Company Creation Then Company screen shall be 

disappear like this. 

 

The fields in the Company Creation screen and the information to be filled in each of them are 

explained below. To navigate between the fields, use Enter/Tab, or Mou

Company Data path: 

 The path to the location of Tally Prime data is displayed here. By default, the path provided 

while installing Tally Prime will be displayed. However, you can press Backspace and specify 

the location in which you want the dat

Name: Provide a name for the company that is being created. In this example, we are creating a 

company named Nidhi Sales Pvt. Ltd.

Primary Mailing Details: The mailing name and address details are picked from here for any 

report such as balance sheet and statements of accounts.

Mailing name: 
The name provided for the company in the Name field is automatically displayed here. However, 

you can change it as per requirements. The name specified here will be used for mailing 

purposes.  

In this example, Nidhi Sales Pvt. Ltd. is retained.
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If you have configured the company for remote access feature in the remote end this 

cted to access the data remotely. 

The Drive path can be mentioned where the data to be stored/saved. By using copy & 

Ctrl +Alt+ C for copy to paste Ctrl +V or Ctrl +Alt+ V) or type the 

If already the transactions are recorded and maintained in D Drive, in the same location 

path if you want to maintain the data this option to be selected. We can also browse the 

required location from this option. 

Procedure to Create a Company in Tally Prime: 

ny Screen > Click on Company Creation Then Company screen shall be 

The fields in the Company Creation screen and the information to be filled in each of them are 

explained below. To navigate between the fields, use Enter/Tab, or Mouse clicks.

The path to the location of Tally Prime data is displayed here. By default, the path provided 

while installing Tally Prime will be displayed. However, you can press Backspace and specify 

the location in which you want the data to be stored. 

Provide a name for the company that is being created. In this example, we are creating a 

Nidhi Sales Pvt. Ltd. 

The mailing name and address details are picked from here for any 

balance sheet and statements of accounts. 

The name provided for the company in the Name field is automatically displayed here. However, 

you can change it as per requirements. The name specified here will be used for mailing 

example, Nidhi Sales Pvt. Ltd. is retained. 

Software Solutions to Accounting 

If you have configured the company for remote access feature in the remote end this 

The Drive path can be mentioned where the data to be stored/saved. By using copy & 

) or type the 

re recorded and maintained in D Drive, in the same location 

path if you want to maintain the data this option to be selected. We can also browse the 

ny Screen > Click on Company Creation Then Company screen shall be 

 

The fields in the Company Creation screen and the information to be filled in each of them are 

se clicks. 

The path to the location of Tally Prime data is displayed here. By default, the path provided 

while installing Tally Prime will be displayed. However, you can press Backspace and specify 

Provide a name for the company that is being created. In this example, we are creating a 

The mailing name and address details are picked from here for any 

The name provided for the company in the Name field is automatically displayed here. However, 

you can change it as per requirements. The name specified here will be used for mailing 
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Address: Fill in the company's address.  

Country: Select the country in which the company is located. This will allow users to choose the 

statutory capabilities available for that country. In this example, the country selected is India. 

State: This field appears once India is selected as the country. Select the State in which the 

company is located. In this example, Nidhi Sales Pvt Ltd is located in Karnataka. 

1. Fill in the relevant PIN Code. 

2. Fill in the relevant numbers in the Phone No., Mobile No. and Fax No fields. 

3. E-mail: Fill in the company's official E-mail ID here. This will be used while E-mailing 

reports and statements from Tally Prime. 

4. Website: Fill in the company's official website address. 

 

Books and Financial Year Details: 

Financial year begins from: This refers to the twelve-month accounting period of the company. 

For Nidhi Sales Pvt Ltd, the financial year begins on 1-4-2024. 

Books beginning from: The date provided in the aforesaid field will be automatically displayed 

here. In the example, the date is retained. However, if you have started with maintaining your 

books of accounts with Tally Prime mid-year, the required date can be set accordingly. 

 

Security Control: 

Tally Vault password (if any): Once you enter a password here, you will need it to open your 

company each time. The name of a company that is locked using Tally Vault will be hidden with 

the asterisk * symbol. You need to provide the Tally Vault password to open and access the 

company. 

Use security control?  : Setting this option to 'Yes' will allow you to define the access rights for 

each user who will access your company. This feature is explained in forthcoming volumes. For 

Nidhi Sales Pvt Ltd., we shall set this option to No. 

Base Currency Information: 

Base currency symbol: The base currency symbol will be filled as per the country selected. For 

India, it is  ₹ .  

Formal name: The currency's formal name will be filled here. In this example, it is INR (Indian 

Rupees). 

Suffix symbol to amount? : For some countries, the currency symbol is specified after the 

amount. This option can be enabled for such countries, so that the currency symbol may be 

printed after the amount. However, Nidhi Sales Pvt Ltd., is an Indian company and hence this 

option is set to No. 

Add space between amount and symbol: Tally Prime will provide a single space between the 

amount and the currency symbol, if this option is set to Yes. For e.g.: 5,000. Notice the space 

between symbol and theamount. 

Show amounts in millions: If the company's financial statements need to have their values 

expressed in terms of millions, set this option to Yes. 

Number of decimal places: By default, the number of decimal places for the base currency is set 

to 2. However, you can have up to 4 decimal places. The Indian currency has 2 decimal places 

whereas certain other countries require 3 decimal places and so on. 

Word representing amount after decimal: The symbol for amounts expressed in decimals will 

be set by default. For India, it is paise. 
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No. of decimal places for amounts in words

printing the amount in words. This number should be equal to or lesser than the number specified 

in Number of Decimal Places field. For example, if the cur

value to be printed in words can be restricted to 2 decimal places.

 

The Company creation screen for Nidhi Pvt Ltd., 

 

The message Accept Yes or No will be displayed. Press Enter or Y to Save the details.

After Saving the Company Creation Screen then Company Features Screen shall be Appears.

9.4 Company Feature Screen: 

The settings are related to various features and functionalities that can be enabled or disabled for 

the company "Nidhi Sales Pvt. Ltd." Here's a det

9.6  Software Solutions to Accounting

No. of decimal places for amounts in words: You can specify the number of decimal places for 

printing the amount in words. This number should be equal to or lesser than the number specified 

in Number of Decimal Places field. For example, if the currency has up to 3 decimal places, the 

value to be printed in words can be restricted to 2 decimal places. 

The Company creation screen for Nidhi Pvt Ltd.,  

The message Accept Yes or No will be displayed. Press Enter or Y to Save the details.

g the Company Creation Screen then Company Features Screen shall be Appears.

 

The settings are related to various features and functionalities that can be enabled or disabled for 

the company "Nidhi Sales Pvt. Ltd." Here's a detailed explanation of each section and its options:

Software Solutions to Accounting 

: You can specify the number of decimal places for 

printing the amount in words. This number should be equal to or lesser than the number specified 

rency has up to 3 decimal places, the 

 

The message Accept Yes or No will be displayed. Press Enter or Y to Save the details. 

g the Company Creation Screen then Company Features Screen shall be Appears. 

 
The settings are related to various features and functionalities that can be enabled or disabled for 

ailed explanation of each section and its options: 
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Accounting 

1. Maintain Accounts: Yes 

   - This option allows the software to maintain the accounting records of the company. 

2. Enable Bill-wise entry: Yes 

   - This feature enables tracking of receivables and payables bill by bill. 

3. Enable Cost Centres: No 

   - Cost centres help in tracking income and expenses by department or project. 

4. Enable Interest Calculation: No 

   - This option enables the calculation of interest on outstanding amounts. 

 

Inventory: 
1. Maintain Inventory: Yes 

   - This option allows the software to maintain inventory records. 

2. Integrate Accounts with Inventory: Yes 

   - This feature links inventory management with accounting. 

3. Enable multiple Price Levels: No 

   - This option allows the setting of different price levels for different customers. 

4. Enable Batches: No 

   - Batches are used for managing inventory based on batch numbers. 

   - Maintain Expiry Date for Batches: No 

     - This option tracks expiry dates for inventory batches. 

5. Enable Job Order Processing: No 

   - This feature manages job orders for manufacturing processes. 

 

6. Enable Cost Tracking: No 

   - This enables tracking of costs associated with various activities. 

7. Enable Job Costing: No 

   - This option allows costing for specific jobs or projects. 

8. Use Discount column in invoices: No 

   - This feature adds a discount column in the invoices. 

9. Use separate Actual and Billed Quantity columns in invoices: No 

   - This feature separates actual and billed quantities in invoices. 

 

Taxation: 

1. Enable Goods and Services Tax (GST): Yes 

   - This enables GST features in the software. 

   - Set/Alter Company GST Rate and Other Details: No 

     - This allows setting or altering the GST rates and related details. 

2. Enable Tax Deducted at Source (TDS): No 

   - This feature manages TDS, which is a tax deduction mechanism in India. 

3. Enable Tax Collected at Source (TCS): No 

   - This option manages TCS, which is collected at the source of income. 

4. Enable Value Added Tax (VAT): No 

   - This feature enables VAT, which is another form of indirect tax. 

5. Enable Excise: No 

   - This option manages excise duty, a type of tax levied on the manufacture of goods. 
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6. Enable Service Tax: No 

   - This enables the management of service tax, which is a tax on services.

 

 

Online Access: 
1. Enable Browser Access for Reports: Yes

   - This feature allows accessing reports via a web browser.

2. Enable Tally.NET Services for Remote Access &Synchronisation: No

   - This option enables remote access and synchronization using Tally.NET services.

 

Payroll: 

1. Maintain Payroll: No 

   - This option manages payroll functions within the software.

   - Enable Payroll Statutory: No 

     - This feature handles statutory requirements related to payroll, such as provident fund and 

employee state insurance. 

 

Others: 

1. Enable Payment Request to share payment link/QR code: No

   - This option allows sharing payment requests through links or QR codes.

2. Enable multiple addresses: No

   - This feature manages multiple addresses for the company, useful for multi

businesses. 

3. Mark modified vouchers: No 

   - This option marks vouchers that have been modified.

 

These settings can be customized based on the specific needs and business processes of "Nidhi 

Sales Pvt. Ltd." Each option represents a feature that can enhance the software's functionality to 

better align with the company's operational requirements.
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This enables the management of service tax, which is a tax on services. 

1. Enable Browser Access for Reports: Yes 

This feature allows accessing reports via a web browser. 

T Services for Remote Access &Synchronisation: No 

This option enables remote access and synchronization using Tally.NET services.

This option manages payroll functions within the software. 

 

This feature handles statutory requirements related to payroll, such as provident fund and 

1. Enable Payment Request to share payment link/QR code: No 

This option allows sharing payment requests through links or QR codes. 

2. Enable multiple addresses: No 

This feature manages multiple addresses for the company, useful for multi-location 

 

marks vouchers that have been modified. 

These settings can be customized based on the specific needs and business processes of "Nidhi 

Sales Pvt. Ltd." Each option represents a feature that can enhance the software's functionality to 

company's operational requirements. 

Software Solutions to Accounting 

This option enables remote access and synchronization using Tally.NET services. 

This feature handles statutory requirements related to payroll, such as provident fund and 

location 

These settings can be customized based on the specific needs and business processes of "Nidhi 

Sales Pvt. Ltd." Each option represents a feature that can enhance the software's functionality to 
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The message Accept Yes or No will be displayed. Press Enter or Y to Save the details.

After Saving the Company Features Screen, The gateway of Tally Screen will appear with the 

company’s Name Displayed on the Left pa

 

 

 

9.5 Alteration of Company: 

Altering a company in software like Tally Prime  involves making changes to the company's 

existing settings and configurations after it has been created. This process allows you to update 

company information, enable or d

evolving needs of the business. 

 

Navigation Path to Alter a Company Details:

To alter the company details such as (Company name, Address etc) in Tally Prime,

From Gateway of Tally>click on 

screen, make the necessary changes.
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The message Accept Yes or No will be displayed. Press Enter or Y to Save the details.

After Saving the Company Features Screen, The gateway of Tally Screen will appear with the 

company’s Name Displayed on the Left pane  

Altering a company in software like Tally Prime  involves making changes to the company's 

existing settings and configurations after it has been created. This process allows you to update 

company information, enable or disable features, and adjust various settings to better suit the 

Navigation Path to Alter a Company Details: 

To alter the company details such as (Company name, Address etc) in Tally Prime,

>click on K: Company > select Alter >Inthe Company Alteration 

screen, make the necessary changes. 
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The message Accept Yes or No will be displayed. Press Enter or Y to Save the details. 

After Saving the Company Features Screen, The gateway of Tally Screen will appear with the 

 

Altering a company in software like Tally Prime  involves making changes to the company's 

existing settings and configurations after it has been created. This process allows you to update 

isable features, and adjust various settings to better suit the 

To alter the company details such as (Company name, Address etc) in Tally Prime, 

Company Alteration 
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9.6 Shut Company in Tally Prime:

InTally Prime, shutting a company means temporarily closing the company session without 

deleting the company data. This is often done

session securely. 

Navigation path Towards Shut Company:

From Gateway of Tally>click on 

screen appears. 

 

 
 

9.7 Select Company: 

9.10  Software Solutions to Accounting

Shut Company in Tally Prime: 

InTally Prime, shutting a company means temporarily closing the company session without 

deleting the company data. This is often done to switch between companies or to end the work 

Navigation path Towards Shut Company: 

>click on K: Company > select Shut (Ctrl+F3) > Shut Company 

Software Solutions to Accounting 

 

InTally Prime, shutting a company means temporarily closing the company session without 

to switch between companies or to end the work 

Shut (Ctrl+F3) > Shut Company 
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In Tally Prime, the "Select Company" option allows you to open an existing company that you 

have already created. This is essential for working with the specific data and configurations of 

that company. 

Navigation path Towards Shut Company: 

From Gateway of Tally>click on K: Company > select Select Company (Alt+F3) > Select 

Company screen appears. 

 
 

9.8 Keywords: 

1. Business Plan: Develop a comprehensive strategy outlining goals, target market, and financial 

projections. 

2. Legal Structure: Choose an appropriate legal entity (LLC, Corporation, etc.) and register the 

business. 

3. Funding: Secure necessary capital through loans, investors, or personal savings. 

4. Operations: Establish efficient operational processes, hire staff, and launch marketing 

campaigns. 

 

9.9 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K.Nadhani 

2. "Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 
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Lesson -  10 

 TALLY GATEWAY SCREEN 

 
Objective: 

1. Introduction to Gateway of Tally: Explain the purpose and components of the Gateway of 

Tally screen. 

2. Navigation: Describe how to navigate through the different sections of the Gateway of Tally. 

3. Accessing Features: Discuss how to access various features and modules from the Gateway of 

Tally. 

4. User Management: Explain the process of managing user roles and permissions from the 

Gateway of Tally. 

5. Best Practices: Provide best practices for effectively using the Gateway of Tally screen for 

efficient workflow. 

 

Structure: 

10.1 Using the Dashboard 

10.2 Navigating from Anywhere to Anywhere in Tally Prime 

10.3 Top Menu 

10.4 Benefits of Using the Top Menu 

10.5 Go To Scenario 

10.6 F12: Configuration in Tally Prime 

10.7 Keywords 

10.8 Reference 

 
10.1 Using the Dashboard: 

The dashboard provides quick access to important features and reports, ensuring you can 

efficiently manage your company’s data and perform necessary transactions. The navigation 

menu on the right allows you to easily create, alter, and view essential data and reports. 

By understanding these features and shortcuts, you can effectively manage your company in 

Tally Prime, ensuring accurate accounting, inventory management, and compliance with 

statutory requirements. 

 

Getting Started with Tally Prime: 

Tally Prime helps to run your business the way you want to. Tally Prime gives you a simple and 

consistent experience, along with ease of discoverability of features across. 

 

10.2 Navigating from Anywhere to Anywhere in Tally Prime 
In Tally Prime, you can navigate or configure company and external operations from anywhere 

in the application.  

Top Menus are consistent and always available throughout the application to perform any 

operations from anywhere without getting distracted from the current task that is being 

performed. 
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10.3 Top Menu: 

In Tally Prime, we can perform various tasks using the 

follow a rigid set of steps for each task.

Using the Top Menu in Tally Prime, now you can navigate from 

within Tally Prime without the need to know any navigation path or learn the short cuts keys to 

reach to any reports or create any transactions.

 

By Clicking on this option, the following actions can be performed using a single menu

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

The top menu in Tally Prime visible in your 

essential for managing your company's financial and operational data. Here's a detailed 

explanation of each item in the top menu:

 Top Menu in Tally Prime 

K: Company  
Y

 

O:Import  E: Export 

10.2  Software Solutions to Accounting

In Tally Prime, we can perform various tasks using the Top Menu options, without having to 

follow a rigid set of steps for each task. 

Using the Top Menu in Tally Prime, now you can navigate from 'Anywhere to Anywhere'

within Tally Prime without the need to know any navigation path or learn the short cuts keys to 

reach to any reports or create any transactions. 

Clicking on this option, the following actions can be performed using a single menu

 

The top menu in Tally Prime visible in your screenshot, provides access to various functionalities 

essential for managing your company's financial and operational data. Here's a detailed 

explanation of each item in the top menu: 

Y: Data Z:Exchange

: Export  

P: Print F1:Help

Software Solutions to Accounting 

options, without having to 

'Anywhere to Anywhere' 

within Tally Prime without the need to know any navigation path or learn the short cuts keys to 

Clicking on this option, the following actions can be performed using a single menu 

screenshot, provides access to various functionalities 

essential for managing your company's financial and operational data. Here's a detailed 

:Exchange 

:Help 
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1. K: Company 

   - Company: This option allows you to perform various company-related tasks such as 

selecting, creating, altering, and shutting companies. It is fundamental for managing multiple 

companies within Tally Prime. 

     - Select Company (F3): Open an existing company. 

     - Create Company: Set up a new company in Tally Prime. 

     - Alter Company: Modify the details and settings of an existing company. 

     - Shut Company (Alt + F1): Close the current company session. 

 

2. Y: Data 

   - Data: This section deals with data-related operations such as backup, restore, splitting 

company data, and importing/exporting data. 

     - Backup: Create a backup of your company data. 

     - Restore: Restore company data from a backup file. 

     - Split Company Data: Split your company data into different financial years. 

     - Import Data: Import data from other sources or previous versions. 

     - Export Data: Export data for reports, analysis, or to share with other systems. 

 

3. Z: Exchange: 

   - Exchange: Manage data exchange between Tally Prime and other systems or users. This is 

useful for synchronization and sharing data. 

     - Send for Remote Access: Allow access to your company data remotely. 

     - Receive from Remote Access: Receive data from remote access. 

     - Configure Synchronization: Set up synchronization settings for data exchange. 

 

4.G: Go To 

   - Go To: A quick access feature that allows you to navigate directly to any report, transaction, 

or feature within Tally Prime. This enhances efficiency by reducing the time spent navigating 

through menus. 

 

5. O: Import 

   - Import: Import data into Tally Prime from external sources, such as spreadsheets, other 

software, or previous versions of Tally. 

     - Masters: Import master data such as ledgers and stock items. 

     - Transactions: Import transaction data like sales, purchases, receipts, and payments. 

 

6. E: Export 

   - Export: Export data from Tally Prime to external formats for sharing, reporting, or analysis. 

     - Masters: Export master data. 

     - Transactions: Export transaction data. 

     - Reports: Export reports in various formats (Excel, PDF, XML, etc.). 

 

7. M: Share 

   - Share: Share data and reports directly from Tally Prime with others via email or other 

communication methods. 
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8. P: Print 

   - Print: Print reports, vouchers, and other documents directly from Tally Prime. 

     - Reports: Print financial statements, inventory reports, and other analysis documents. 

     - Vouchers: Print sales invoices, purchase orders, and other transaction documents. 

 

9. F1: Help 

   - Help: Access help resources and support for Tally Prime. 

     - Contents: View the help documentation. 

     - Support Centre: Get support from Tally Solutions. 

     - About Tally Prime: View information about the Tally Prime software version and licensing. 

 

Additional Contextual Menus: 

- F2: Date: Change the working date within Tally Prime. This is useful for entering transactions 

for different dates without changing the system date. 

- F3: Company: Quickly access the company selection menu. 

 

10.4 Benefits of Using the Top Menu: 

- Efficiency: Quick access to essential features and operations enhances productivity. 

- Data Management: Simplifies complex data management tasks such as backup, restore, and 

synchronization. 

- Flexibility: Allows for easy navigation and operations across multiple companies and datasets. 

- Support: Provides immediate access to help and support resources. 

Understanding and utilizing the top menu in Tally Prime enables you to manage your company's 

accounting, inventory, and compliance tasks more effectively, ensuring smooth and efficient 

business operations. 

Main Feature in Tally Prime: 

Go To option from the Top Menu is one of the main features in Tally Prime 

To access the feature of Go To,  

From Gateway of Tally > Press Alt+ G Or Click G: Go To  Open/Navigate to any report or create 

any masters without disturbing the current work data. 
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10.5 Go To Scenario: 

Mr. Sachin the accountant of Nidhi Pvt. Ltd., Recording Payment Voucher 

Mr. Ravi ask Sachin  immediately wants a print of Profit and Loss A/c  

Mr. Sachin, without disturbing the current voucher  work which of the feature does he use to take 

the Print of Profit & Loss A/c asked by Mr. Ravi. 

Switch To Scenario: 

Using Switch To option, you can Open/ Navigate any report by closing the current work 

Mr. Abi , an accountant of Nidhi Pvt. Ltd., has created the necessary ledger like Purchase, 

Sales, Customers and Suppliers account. Now, he wanted to record the purchase transaction. 

Instead of going to Gateway of Tally and navigating to the voucher creation screen, he can press 

CTRL+G for SwitchTo> Create Voucher > F9: Purchase. 

 

10.6 F12: Configuration in Tally Prime: 

In Tally Prime the company features have been moved to the top menu. 

Under K: Company option, the features have been revamped and arranged in Company Features 

based on the usability.  

Most of the features which are related to masters can be enabled during master creation 

The Configurations across the product are organised to meet your invoicing and reporting 

preferences, with: 

 Proper placement and grouping for ease of find-ability 

 Sequencing based on use 

 Layered presentation 

F12 configurations have been made changes to ensure the key settings for the values in reports 

are readily available under Basis of Values. 

The F12 Configuration is moved to Top Menu such as M: Email, P: Print and F1: Help. 

 

10.7 Keywords: 

In Tally, the gateway screen is the central navigation hub where users can access various features 

and functions of the software. The gateway screen typically includes keywords or options that 

help users quickly navigate through the different modules. Here are the four lines of keywords 

commonly found on the Tally gateway screen: 

1. Masters: This line includes options related to creating and managing master records such as 

ledgers, stock items, groups, and other master data. 

2.Transactions: This line provides access to various transaction entries like vouchers, invoices, 

receipts, payments, and journal entries. 

3. Utilities: This line includes tools and utilities such as banking, data synchronization, 

import/export, and other utility functions. 

4.Reports: This line offers access to a wide range of reports, including financial statements, 

inventory reports, statutory reports, and other analytical reports. 

These keywords help users efficiently navigate through Tally's comprehensive features and 

functionalities, making the accounting and business management process more streamlined. 

 

10.8 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K. Nadhani 

2. "Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 
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Lesson - 11 

 Company Data Management 

 
Objective: 

1. Data Backup and Restore: Explain the importance of regular data backup and how to restore 

data in Tally Prime. 

2. Company Data Security: Discuss measures to ensure the security and integrity of company 

data. 

3. Data Synchronization: Describe the process of synchronizing company data across multiple 

locations. 

4. Importing and Exporting Data: Explain how to import and export data in Tally Prime. And  

Data Archiving: Discuss the process and benefits of archiving old company data for future 

reference. 

 

Structure: 

11.1 Introduction 

11.2 Why should one take the company Data Backup 

11.3 Restoring of Company Data 

11.4 Open Restored Company 

11.5 Business Scenario 

11.6 Security Features in Tally Prime 

11.7 Overview on Security Control 

11.8 Configuring Security Controls in Tally Prime 

11.9 Key Security Controls in Tally Prime 

11.10 Configuring Security Controls in Tally Prime 

11.11 Enabling Data Encryption 

11.12 Problems on Company Creation 

11.13 Keywords 

11.14 Reference 
 

11.1 Introduction: 

• It is recommended that you take a regular backup of your company data to safeguard against 

any form of data loss. This way you can be prepared for any adverse event, such as a virus attack 

a hard drive crash, and so on. Using Tally Prime, you can easily take a backup of your company 

data and restore it whenever needed. 

• You can also use the backup feature to move your data to another computer, or share it with 

your accountant or auditor for verification. Sharing the backup of the data is a much more 

reliable method than directly copying the company data folders. 

• It is recommended that you back up your data in a location that is separate from the original, 

for example, a different drive on the computer, a pen drive, a hard disk, and so on. You can even 

store this data on a cloud location and access it easily. 

Using Tally Prime, we can easily take a backup of a company data and restore the company data 

when required.  

 

11.2 Why should one take the company Data Backup 
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 To Safeguard the company data against hard drive crash and virus attack 

 Any Data lost will be disastrous for the Organization 

 Data Backup plays a vital role 

We can also use the backup feature to move your data to another computer or share it with your 

accountant or auditor for verification.

Taking a Backup of the Company data daily from Tally, which will help in

 Retrieving the data when the existing data is lost 

 Forwarding the data backup for auditor 

 Tally helps you take the backup of one or more companies in a s

 The Format of Data Backup taken from Tally is TBK.1800.

Options to take-up Backup and Restore:

There are two options to take-up Backup as well to restore to Tally.

Option 1: This process is featured by Tally Prime. File shall be generated 

format. 

 

  

TBK1800_100098.001

Option 2: 

This is a shortcut method, where in user shall access the data backup from the software backend 

storage. File will be in the format of normal folder.

 

 

 

Data Backup: 

Data Backup from Tally Prime 

Steps to Back up Data in Tally Prime

Open Tally Prime 

Gateway of Tally>Alt+Y

Select Path And Company

 11.2  Software Solutions to Accounting

d the company data against hard drive crash and virus attack 

Any Data lost will be disastrous for the Organization  

Data Backup plays a vital role  

We can also use the backup feature to move your data to another computer or share it with your 

r auditor for verification. 

Taking a Backup of the Company data daily from Tally, which will help in 
Retrieving the data when the existing data is lost  

Forwarding the data backup for auditor  

Tally helps you take the backup of one or more companies in a single directory 

The Format of Data Backup taken from Tally is TBK.1800. 

up Backup and Restore: 

up Backup as well to restore to Tally. 

: This process is featured by Tally Prime. File shall be generated in TBK1800.001 

TBK1800_100098.001

 

This is a shortcut method, where in user shall access the data backup from the software backend 

storage. File will be in the format of normal folder. 

Data Backup from Tally Prime (Option 01) 

Steps to Back up Data in Tally Prime

Open Tally Prime 

Gateway of Tally>Alt+Y

Select ' Back Up'

Select Path And Company

Software Solutions to Accounting 

d the company data against hard drive crash and virus attack  

We can also use the backup feature to move your data to another computer or share it with your 

ingle directory  

in TBK1800.001 

This is a shortcut method, where in user shall access the data backup from the software backend 

 

Steps to Back up Data in Tally Prime
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Process: 

• Select Backup Destination Path: This is the location where your company data will be backed 

up. (Use Shortcut CTRL+V to paste the path)

• Select the Company which would like take Backup

• Select End of List 

• Select Enter 

• File shall be saved in the Backup Destination Path

 

Steps of Data Backup data in Tally (Option 

11.3 Restoring of Company Data

Steps to Backup in Tally Prime 

Go To My Computer

Find ' Tally Prime Folder"

Go to Data Back up Path

11.3 Acharya Nagarjuna University

• Select Backup Destination Path: This is the location where your company data will be backed 

up. (Use Shortcut CTRL+V to paste the path) 

• Select the Company which would like take Backup 

shall be saved in the Backup Destination Path  

Steps of Data Backup data in Tally (Option 

Restoring of Company Data: 

Steps to Backup in Tally Prime 

Go To My Computer

Go to 'd'Drive

Find ' Tally Prime Folder"

Go to Data Back up Path

Copy Data (Folder)

Acharya Nagarjuna University 

• Select Backup Destination Path: This is the location where your company data will be backed 
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Tally helps you restore the company data from the Backup file.

 

Data Restore to Tally Prime  

 11.4  Software Solutions to Accounting

Tally helps you restore the company data from the Backup file. 

Software Solutions to Accounting 
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Process: 

Select Restore Destination Path: This is the location where your company data will be restored.

• (Use Shortcut CTRL+V to paste the path)

• Select the Company which would like Restore

• Select End of List 

• Select Enter 

• New Company shall be Restored in Destination Path

Data Restore to Tally (option 2) 

Steps Data Restore data in Tally 

(Option No:01) 

Open Tally Software

Alt + Y (Data)

Select 'Restore'

Select Source & Destination
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Destination Path: This is the location where your company data will be restored.

• (Use Shortcut CTRL+V to paste the path) 

• Select the Company which would like Restore 

• New Company shall be Restored in Destination Path 

 

Steps Data Restore data in Tally 

(Option No:01) 

Open Tally Software

Alt + Y (Data)

Select 'Restore'

Select Source & Destination

Acharya Nagarjuna University 

Destination Path: This is the location where your company data will be restored. 
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Restore Screen in Tally (option 2)

 

11.4 Open Restored Company:

Open Tally Prime> Alt+F3 (Select Company)> and Select the company from the List of 

Companies and press ENTER. 

Steps to restore data in Tally (Option 2)

Go to 'My Computer'

Find out 'Tally Prime Folder'

Go to "Data Backup Path"

 11.6  Software Solutions to Accounting

Restore Screen in Tally (option 2)

Open Restored Company: 

Open Tally Prime> Alt+F3 (Select Company)> and Select the company from the List of 

Steps to restore data in Tally (Option 2)

Go to 'My Computer'

Go to d Drive

Find out 'Tally Prime Folder'

Go to "Data Backup Path"

Paste Data (Folder)

Software Solutions to Accounting 

 

 

Open Tally Prime> Alt+F3 (Select Company)> and Select the company from the List of 
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11.5 Business Scenario: 

Suhant Software Pvt. Ltd. had lost the company data due to a hard drive crash in the system.

The company auditor advised to take a backup at frequent intervals and ensure that the data 

backup is secured logically and physically by using the Backup feature in Tally Prime.

Now the company has decided to take a backup of the company data on daily basis from Tally 

Prime which will help in the below instances.

 Retrieving the data when the existing data is lost.

 Forwarding the data backup for auditor.

 

11.6 Security Features in Tally Prime:

Securing financial Information is a critical task of business owner, as most of the business 

depends on securing financial and maintain confidentially of information.

1. Maintaining financial information is crucial and especially difficult to re

lost  

2. Tally Prime is the safe platform to maintain all the business transactions 

 As it provides more additional security 

3. Create the different levels of Users to access the company data

4. Securing financial information using the security C

5. It will help the business to maintain company data confidentially by encrypting and 

protecting the data. 

6. To Protect the company data by providing the password and creating different user level 

rights 

7. Mainly used in multiple environm

scenario  

8. Plays significant role to secure the data to high standards
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Pvt. Ltd. had lost the company data due to a hard drive crash in the system.

The company auditor advised to take a backup at frequent intervals and ensure that the data 

backup is secured logically and physically by using the Backup feature in Tally Prime.

Now the company has decided to take a backup of the company data on daily basis from Tally 

Prime which will help in the below instances. 

Retrieving the data when the existing data is lost. 

Forwarding the data backup for auditor. 

Tally Prime: 

Securing financial Information is a critical task of business owner, as most of the business 

depends on securing financial and maintain confidentially of information. 

Maintaining financial information is crucial and especially difficult to replace if it gets 

Tally Prime is the safe platform to maintain all the business transactions  

As it provides more additional security  

Create the different levels of Users to access the company data 

Securing financial information using the security Control and Tally Vault 

It will help the business to maintain company data confidentially by encrypting and 

To Protect the company data by providing the password and creating different user level 

Mainly used in multiple environment configuration and conventional in a multi

Plays significant role to secure the data to high standards 
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Pvt. Ltd. had lost the company data due to a hard drive crash in the system. 

The company auditor advised to take a backup at frequent intervals and ensure that the data 

backup is secured logically and physically by using the Backup feature in Tally Prime. 

Now the company has decided to take a backup of the company data on daily basis from Tally 

Securing financial Information is a critical task of business owner, as most of the business 

place if it gets 

 

ontrol and Tally Vault  

It will help the business to maintain company data confidentially by encrypting and 

To Protect the company data by providing the password and creating different user level 

ent configuration and conventional in a multi-user 
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11.7 Overview on Security Control: 

Tally Prime provides robust security controls to ensure that your financial data is protected and 

accessible only to authorized users. Here are some key security features and how to configure 

them: 

Key Security Controls in Tally Prime 

1. User Access Control: 

   - Tally Prime allows you to create multiple user accounts with different levels of access and 

permissions. This helps in managing who can view, edit, and manage various aspects of your 

financial data. 

2. Password Protection: 

   - You can set passwords for users to prevent unauthorized access. Each user can have a unique 

username and password. 

3.User Roles and Rights: 

   - Define roles with specific permissions to control what each user can do within Tally Prime. 

Roles can be customized to fit the needs of your organization. 

 

4. Audit Trail (Edit Log): 

   - Tally Prime provides an audit trail feature that keeps a log of all changes made to the data. 

This helps in tracking who made changes and what changes were made, ensuring accountability 

and transparency. 

5. Encryption: 

   - Data encryption ensures that the data stored in Tally Prime is protected against unauthorized 

access, making it difficult for unauthorized users to read the data. 

6. Security Levels: 

   - Implement security levels to restrict access to sensitive information. Only users with 

appropriate permissions can access certain areas or features. 

 

11.8 Configuring Security Controls in Tally Prime 

Setting Up User Access Control 

1. Create User: 

   - Go to Gateway of Tally > Alt + K (Company) > Users and Passwords > Create User. 

   - Enter the Username and Password. 

   - Assign a security level (e.g., Owner, Data Entry, etc.). 

Tally Prime provides robust security controls to ensure that your financial data is protected and 

accessible only to authorized users. Here are some key security features and how to configure 

them: 

 

11.9 Key Security Controls in Tally Prime 

User Access Control: 
   - Tally Prime allows you to create multiple user accounts with different levels of access and 

permissions. This helps in managing who can view, edit, and manage various aspects of your 

financial data. 

 

2. Password Protection: 

   - You can set passwords for users to prevent unauthorized access. Each user can have a unique 

username and password. 
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3. User Roles and Rights: 

   - Define roles with specific permissions to control what each user can do within Tally Prime. 

Roles can be customized to fit the needs of your organization. 

4. Audit Trail (Edit Log): 

   - Tally Prime provides an audit trail feature that keeps a log of all changes made to the data. 

This helps in tracking who made changes and what changes were made, ensuring accountability 

and transparency. 

5. Encryption: 

   - Data encryption ensures that the data stored in Tally Prime is protected against unauthorized 

access, making it difficult for unauthorized users to read the data. 

6. Security Levels: 

   - Implement security levels to restrict access to sensitive information. Only users with 

appropriate permissions can access certain areas or features. 

 

11.10 Configuring Security Controls in Tally Prime 

Setting Up User Access Control 

1. Create User: 

   - Go to Gateway of Tally > Alt + K (Company) > Users and Passwords > Create User. 

   - Enter the Username and Password. 

   - Assign a security level (e.g., Owner, Data Entry, etc.). 

2. Define User Roles: 

   - Go to Gateway of Tally > Alt + K (Company) > Security Control > Types of Security. 

   - Create a new security level or modify existing ones to define specific permissions. 

 

2. Enabling Audit Trail (Edit Log) 

1. Enable Audit Trail: 

   - Go to Gateway of Tally > Alt + K (Company) > Features (F11) > Enable Edit Log for 

Vouchers. 

   - Set this option to Yes to activate the audit trail feature. 

2. View Edit Log: 

   - To view the audit trail, go to Gateway of Tally > Display More Reports > Statements of 

Accounts > Edit Log. 

3. Setting Passwords 

1. Set Password for Company: 

   - Go to Gateway of Tally > Alt + K (Company) > Security Control > Users and Passwords. 

   - Enter the Administrator username and password. 

   - For each user, set a password. 

2. User-Specific Passwords: 

   - Each user created can have a specific password assigned to them during the creation process. 

 

11.11 Enabling Data Encryption 

1. Data Encryption: 

   - During company creation or later via Gateway of Tally > Alt + K (Company) > Create/Alter 

Company, you can enable data encryption. 

   - Provide an encryption key (password) that will be used to encrypt the company data. 
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 Best Practices for Security in Tally Prime 

- Regular Password Updates: Encourage users to change their passwords periodically. 

- Access Logs: Regularly review access logs and audit trails to monitor any unauthorized or 

suspicious activities. 

- Data Backup: Regularly back up data and store backups securely. 

- User Training: Train users on the importance of data security and best practices for using Tally 

Prime securely. 

- Limit Access: Grant access only to those who need it and only to the extent necessary for their 

role. 

 

By configuring these security controls and following best practices, you can significantly 

enhance the security of your financial data in Tally Prime, protecting it from unauthorized access 

and ensuring data integrity. 

Define User Roles: 

   - Go to Gateway of Tally > Alt + K (Company) > Security Control > Types of Security. 

   - Create a new security level or modify existing ones to define specific permissions. 

 

2. Enabling Audit Trail (Edit Log) 

1. Enable Audit Trail: 

   - Go to Gateway of Tally > Alt + K (Company) > Features (F11) > Enable Edit Log for 

Vouchers. 

   - Set this option to Yes to activate the audit trail feature. 

 

2. View Edit Log: 

   - To view the audit trail, go to Gateway of Tally > Display More Reports > Statements of 

Accounts > Edit Log. 

 

3. Setting Passwords 

1. Set Password for Company: 

   - Go to Gateway of Tally > Alt + K (Company) > Security Control > Users and Passwords. 

   - Enter the Administrator username and password. 

   - For each user, set a password. 

2. User-Specific Passwords: 

   - Each user created can have a specific password assigned to them during the creation process. 

 

4. Enabling Data Encryption 

1. Data Encryption: 

   - During company creation or later via Gateway of Tally > Alt + K (Company) > Create/Alter 

Company, you can enable data encryption. 

   - Provide an encryption key (password) that will be used to encrypt the company data. 

Best Practices for Security in Tally Prime 

- Regular Password Updates: Encourage users to change their passwords periodically. 

- Access Logs: Regularly review access logs and audit trails to monitor any unauthorized or 

suspicious activities. 

- Data Backup: Regularly back up data and store backups securely. 
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- User Training: Train users on the importance of data security and best practices for using Tally 

Prime securely. 

- Limit Access: Grant access only to those who need it and only to the extent necessary for their 

role. 

 

By configuring these security controls and following best practices, you can significantly 

enhance the security of your financial data in Tally Prime, protecting it from unauthorized access 

and ensuring data integrity. 

 

11.12 Problems on Company Creation 

 

Problem No:01 

Create a Company with all Details 

 Company Name:  Satyam Electronics, Address: Shop No:1, SP Road, Bangalore,  

State: Karnataka, Pin Code: 560056, Financial Year From: 01-04-2024 

Books Beginning from: 01-04-2024. 

 

Problem No: 02 

Name M/s. Sandhya Traders 

Address D.NO:65-5-54, Canal Road, Near Vinayaka 

Temple, One Town 

City Vijayawada 

Pin Code 520 001  financial 1-4-2024 

State  Andhra Pradesh 

Country India 

Email ID Sandhyatraders@gmail.com 

Web Site www.sandhyatraders.com 

 

Problem No: 03 

Company Name Mitra Auto Traders 

Address Door No:292-2-2 ,Government  Vijayawada 

State Andhra Pradesh 

Pin Code 520002 

Financial Year from 01-04-2023 

Books Beginning from 01-01-2024 

 

Problem No: 04 

Name Play One Retail Private Limited 

Address D.NO: 256/1354a Near Hdfc Bank Upstairs 

of Varsha Homes, Miyapur 

City Hyderabad 

Pin Code 519 182 

State  Telangana 

Country India 

Email ID playonehyd@gmail.com 

Web Site www.playoneindia.com 
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Financial Year 2024-2025 

Books Beginning from 1-08-2024 

 

Problem No: 05 

Name Saritha Transport 

Address D.NO:436/13a Near Narayana School, 

lbnagar 

City Hyderabad 

Pin Code 519 165 

State  Telangana 

Country India 

Email ID transportsaritha@gmail.com 

Web Site www.satitha logitics.com 

Financial Year 2023-2024 

Books Beginning from 1-02-2024 

 

 

11.13 Keywords: 

 

1. Data Integration: Combining data from different sources to provide a unified view. 

2. Data Governance: Establishing policies and procedures to ensure data quality, consistency, 

and security. 

3. Data Analytics: Using advanced tools and techniques to analyze data and extract actionable 

insights. 

4. Data Security: Implementing measures to protect data from unauthorized access and breaches. 

 

11.14 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K.  Nadhani 

2. "Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 
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Lesson – 12 

MASTER CREATION IN TALLY PRIME 

 
Objective: 

1. Definition and Importance: Define accounting masters and explain their importance in Tally 

Prime. 

2. Types of Masters: Identify the different types of accounting masters such as ledgers and 

groups. 

3. Creation Process: Detail the process of creating various accounting masters in Tally Prime. 

4. Customization and Configuration: Explain how to customize and configure accounting 

masters to suit business needs. 

5. Best Practices: Discuss best practices for maintaining and managing accounting masters 

effectively. 

 

Structure: 

12.1 Introduction 

12.2 Accounting Masters in Tally Prime 

12.3 Inventory Masters in Tally Prime 

12.4 Accounting Master 

12.5 Ledgers 

12.6 Creation of Master Screen 

12.7 Creation of Ledger 

12.8 Alteration of Master 

12.9 Deletion of Master 

12.10 Problems on Ledgers Groupings 

12.11 Keywords 

12.12 Reference 

 
12.1 Introduction: 

 A chart of accounts is a listing of the names of the accounts that a company has identified 

and made available for recording transactions in its general ledger 

 A company has the flexibility to modify its chart of accounts to best suit its needs, adding 

accounts as needed. 

 A ‘Chart of Accounts’ is a list that depicts the accounts that a business uses to record 

transactions in its books of accounts.  

 Tally automatically displays a company’s chart of accounts, based on the ‘Ledger’ and 

‘Groups’ that are created for the company. 

 The purpose of creating a chart of accounts is  
 Classifying, recording, and reporting on your business transactions  

 To use as an aid (reference) for looking up accounts when recording transactions.  

 Without a chart of accounts, a business user would find it very difficult to find a list of all 

his accounts. 

 

12.2 Accounting Masters in Tally Prime 
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Accounting Masters are the foundational elements that enable efficient management and 

categorization of financial transactions. They ensure that all accounting entries are accurately 

recorded and organized, providing a clear financial picture of the business 

 

1. Groups: 

- Definition: Groups categorize and summarize ledgers to facilitate better financial reporting and 

analysis. 

- Purpose: They help in grouping similar natured ledgers under a single heading. For instance, all 

customer accounts can be grouped under 'Sundry Debtors'. 

- Types: There are primary groups and sub-groups. Tally Prime comes with predefined groups, 

but users can create custom groups as needed. 

 

2. Ledgers: 

- Definition: Ledgers are individual accounts where transactions related to assets, liabilities, 

incomes, and expenses are recorded. 

- Purpose: They record detailed transactions, and each ledger must be categorized under a 

specific group for accurate financial reporting. 

- Examples: Sales Ledger, Purchase Ledger, Bank Accounts, Expenses Ledger, etc. 

 

3. Cost Centers: 

- Definition: Cost centers allow tracking of expenses and incomes for different parts of the 

organization, like departments or projects. 

- Purpose: They facilitate detailed financial analysis by department or project, aiding in budget 

management and cost control. 

 

4. Cost Categories: 

- Definition: Cost categories allow grouping of multiple cost centers for a higher level of 

analysis. 

- Purpose: They enable comparison and reporting across different cost centers within the same 

category. 

 

5. Budgets: 

- Definition: Budgets in Tally Prime are tools for setting financial goals and tracking 

performance against those goals. 

- Purpose: They help in planning and controlling finances by comparing actual performance with 

budgeted figures. 

 

12.3 Inventory Masters in Tally Prime 

Inventory Masters are essential for managing stock items and ensuring that inventory data is 

accurate and well-organized. They support the effective management of stock levels, valuation, 

and reporting. 

 

1. Stock Groups: 

- Definition: Stock groups categorize stock items to facilitate better inventory management and 

reporting. 



Centre for Distance Education 12.3 Acharya Nagarjuna University 

 

- Purpose: They help in organizing stock items under meaningful categories, such as Raw 

Materials, Finished Goods, etc. 

- Hierarchy: Stock groups can be primary or sub-groups. 

 

2. Stock Items: 

- Definition: Stock items represent individual inventory items that a business trades in. 

- Purpose: They are the basic units for recording inventory transactions, including purchases, 

sales, and stock movements. 

- Details: Each stock item can have details such as unit of measure, opening balance, and rates. 

 

3. Units of Measure: 

- Definition: Units of measure define the measurement units for stock items. 

- Purpose: They standardize how stock quantities are recorded and reported, such as Kilograms, 

Liters, Pieces, etc. 

- Types: Can be simple (single unit) or compound (e.g., dozen). 

 

 4. Godowns: 

- Definition: Godowns are locations where stock items are stored. 

- Purpose: They help in tracking the location-wise availability and movement of inventory. 

- Hierarchy: Multiple godowns can be created to represent different storage locations within the 

organization. 

 

5. Stock Categories: 

- Definition: Stock categories allow for the classification of stock items based on similar 

characteristics. 

- Purpose: They facilitate detailed reporting and analysis across different categories of stock 

items. 

 

6. Stock Valuation Methods: 

- Definition: Stock valuation methods determine how the value of inventory is calculated. 

- Purpose: They impact the financial statements by affecting the cost of goods sold and ending 

inventory valuation. 

- Types:Common methods include FIFO (First In First Out), LIFO (Last In First Out), and 

Weighted Average. 

 

Summary: 

In Tally Prime, accounting and inventory masters form the core structure for efficient data 

management and reporting. Proper setup and management of these masters ensure accurate 

financial records, insightful reporting, and streamlined business operations.  

 

- Accounting Masters focus on the categorization and recording of financial transactions through 

groups, ledgers, cost centers, cost categories, and budgets. 

- Inventory Masters deal with the organization and management of stock items through stock 

groups, stock items, units of measure, godowns, stock categories, and stock valuation methods. 
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Understanding and properly configuring these masters is crucial for the smooth functionin

any business using Tally Prime. 

 

 

12.4 Accounting Master: 

Ledger Groups: 

The Accounting Groups and its impact in the Financial Statements are shown

 For a newly created company, there are 

in the Chart of Accounts of many organizations. Out of these, 15 groups are primary groups and 

the remaining 13 are sub-groups.

Among the 15 primary Group(s), 9 group(s) are Balance Sheet items, and the remaining 6 

Group(s) are Profit & Loss A/c items. All thes

 

Navigation Path: 

From Gateway of Tally>Chart of Accounts >

Master Creation in Tally Prime        12.4  Software Solutions to Accounting

Understanding and properly configuring these masters is crucial for the smooth functionin

 

The Accounting Groups and its impact in the Financial Statements are shown. 

For a newly created company, there are 28 pre-defined group(s) in Tally, which are the features 

e Chart of Accounts of many organizations. Out of these, 15 groups are primary groups and 

groups. 

Among the 15 primary Group(s), 9 group(s) are Balance Sheet items, and the remaining 6 

Group(s) are Profit & Loss A/c items. All these 13 Sub-Group(s) are Balance Sheet items.

Chart of Accounts >Under Accounting Masters> Enter on

Software Solutions to Accounting 

Understanding and properly configuring these masters is crucial for the smooth functioning of 

defined group(s) in Tally, which are the features 

e Chart of Accounts of many organizations. Out of these, 15 groups are primary groups and 

Among the 15 primary Group(s), 9 group(s) are Balance Sheet items, and the remaining 6 

Group(s) are Balance Sheet items. 

 

 

> Enter on Group 
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In Tally Prime, ledger groups are used to categorize and summarize ledger accounts to facilitate 

better financial reporting and analysis. There are 28 predefined ledger groups in Tally Prime, and 

these groups are essential for organizing your financial data. Below is a list of these groups, 

along with explanations and examples for each: 

List of 28 Ledger Groups in Tally Prime 

 1. Capital Account: 

   - Explanation: Used to account for capital, reserves, surplus, drawings, and other transactions 

related to the owner's equity. 

   - Example: Owner’s Capital, Partners’ Capital, Reserves and Surplus. 

 

 2. Reserves and Surplus: 

   - Explanation: Accounts for retained earnings, reserves, and any surplus profits. 

   - Example: General Reserve, Retained Earnings, Dividend Equalization Reserve. 

3. Current Liabilities: 

   - Explanation: Accounts for short-term liabilities that are due within a year. 

   - Example: Sundry Creditors, Outstanding Expenses, Advances Received from Customers. 

 

4. Sundry Creditors: 

   - Explanation: Records amounts payable to suppliers for goods or services received. 

   - Example: Creditors for Raw Materials, Creditors for Services. 

 

5. Provisions: 

   - Explanation: Accounts for provisions made for liabilities and expenses that are anticipated. 

   - Example: Provision for Taxation, Provision for Doubtful Debts. 

 

6. Duties and Taxes: 

   - Explanation: Accounts for various taxes and duties payable to the government. 

   - Example: GST Payable, VAT Payable, Income Tax Payable. 

 

7. Deposits (Liability): 

   - Explanation: Records deposits received by the business which are liabilities. 

   - Example: Security Deposits from Customers, Rent Deposits Received. 

 

8. Loans (Liability): 

   - Explanation: Accounts for loans and borrowings that are liabilities. 

   - Example: Bank Loan, Loan from Financial Institutions. 

9. Bank OD Accounts: 

   - Explanation: Accounts for overdraft accounts with banks. 

   - Example: Overdraft with State Bank of India, Overdraft with HDFC Bank. 

 

10. Current Assets: 

  - Explanation: Accounts for assets that are expected to be converted into cash within a year. 

   - Example: Sundry Debtors, Inventory, Cash in Hand. 

 11. Sundry Debtors: 

   - Explanation: Records amounts receivable from customers for goods or services provided. 

   - Example: Debtors for Product Sales, Debtors for Services. 
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12. Cash-in-Hand: 

   - Explanation: Accounts for all cash balances available on hand. 

   - Example: Petty Cash, Cash at Head Office. 

 

13. Bank Accounts: 

   - Explanation: Accounts for all bank balances and transactions. 

   - Example: Savings Account with ICICI Bank, Current Account with Axis Bank. 

 

14. Deposits (Asset): 

   - Explanation: Records deposits made by the business which are assets. 

   - Example: Security Deposit with Landlord, Fixed Deposits. 

15. Loans and Advances (Asset): 

   - Explanation: Accounts for loans and advances given to other entities. 

   - Example: Loan to Employees, Advance to Suppliers. 

16. Fixed Assets: 

   - Explanation: Accounts for long-term assets used in the business operations. 

   - Example: Land, Buildings, Machinery, Vehicles. 

 

17. Investments: 

   - Explanation: Records investments made by the business. 

   - Example: Investment in Mutual Funds, Shares in Other Companies. 

 

18. Branch/Divisions: 

   - Explanation: Accounts for transactions related to different branches or divisions of the 

business. 

   - Example: Branch Office Mumbai, Division A. 

 

19. Sales Accounts: 

   - Explanation: Records all sales transactions of the business. 

   - Example: Domestic Sales, Export Sales. 

 

20. Purchase Accounts: 

   - Explanation: Accounts for all purchase transactions of the business. 

   - Example:Raw Material Purchases, Capital Goods Purchases. 

 

21. Direct Income: 

   - Explanation: Records income directly related to the core business operations. 

   - Example: Commission Received, Discount Received. 

 

 

22. Indirect Income: 

   - Explanation: Accounts for income that is not directly related to the core business activities. 

   - Example: Interest Received, Rent Received. 

 

23. Direct Expenses: 
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   - Explanation: Records expenses directly related to the product

   - Example: Raw Material Costs, Direct Labor Costs.

 

24. Indirect Expenses: 

   - Explanation: Accounts for expenses not directly tied to the production of goods or services.

   -Example: Administrative Expenses, Selling and Distribution Expenses.

 

25. Miscellaneous Expenses (Asset):

   - Explanation: Records miscellaneous expenses considered as assets until they are written off.

   -Example: Preliminary Expenses, Deferred Reve

 

26. Suspense Account: 

   - Explanation: Temporarily holds amounts that are yet to be classified.

   - Example: Unidentified Receipts, Unallocated Expenses.

 

27. Profit and Loss Account: 

   - Explanation: Summarizes the revenues and expens

period. 

   - Example: This account is automatically updated and shows the net result of all income and 

expenses. 

28. Expenses (Direct and Indirect):

   - Explanation: This is a broad category that includes all expe

indirect. 

   - Example: Direct expenses could include manufacturing expenses, while indirect expenses 

could include office rent. 

 

Summary: 

These predefined ledger groups in Tally Prime help organize financial data systematical

making it easier to track and manage various transactions and generate accurate financial reports. 

Proper categorization using these groups ensures that financial statements reflect the true 

financial position and performance of the business.

 

12.5 Ledgers: 

In Every Newly created company, there are two pre

The list of Pre-defined Ledgers

2 Pre

Cash
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Explanation: Records expenses directly related to the production of goods or services.

Example: Raw Material Costs, Direct Labor Costs. 

Explanation: Accounts for expenses not directly tied to the production of goods or services.

Example: Administrative Expenses, Selling and Distribution Expenses. 

Miscellaneous Expenses (Asset): 

Explanation: Records miscellaneous expenses considered as assets until they are written off.

Example: Preliminary Expenses, Deferred Revenue Expenditure. 

Explanation: Temporarily holds amounts that are yet to be classified. 

Example: Unidentified Receipts, Unallocated Expenses. 

Explanation: Summarizes the revenues and expenses to show the net profit or loss for the 

Example: This account is automatically updated and shows the net result of all income and 

28. Expenses (Direct and Indirect): 

Explanation: This is a broad category that includes all expense accounts, both direct and 

Example: Direct expenses could include manufacturing expenses, while indirect expenses 

These predefined ledger groups in Tally Prime help organize financial data systematical

making it easier to track and manage various transactions and generate accurate financial reports. 

Proper categorization using these groups ensures that financial statements reflect the true 

financial position and performance of the business. 

In Every Newly created company, there are two pre-defined ledgers available in Tally

defined Ledgers 

2 Pre-Defined 
Ledgers 

Cash
Profit & 
Loss A/c

Acharya Nagarjuna University 

ion of goods or services. 

Explanation: Accounts for expenses not directly tied to the production of goods or services. 

Explanation: Records miscellaneous expenses considered as assets until they are written off. 

es to show the net profit or loss for the 

Example: This account is automatically updated and shows the net result of all income and 

nse accounts, both direct and 

Example: Direct expenses could include manufacturing expenses, while indirect expenses 

These predefined ledger groups in Tally Prime help organize financial data systematically, 

making it easier to track and manage various transactions and generate accurate financial reports. 

Proper categorization using these groups ensures that financial statements reflect the true 

defined ledgers available in Tally 
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Navigation Path: 

From Gateway of Tally > Chart of Accounts > Under Accounting Masters >Enter on 

Ledgers 

In the List of Ledgers screen, those accounts which are listed in 

sub-groups; accounts listed in italic

accounts, that is groups or ledgers.

 

12.6 Creation of Master Screen:

Tally Prime allows you to group your ledger accounts right at the time of creating your accounts 

chart. Your reports and statements always reflect the desired classification. You can create any 

number of masters in Tally. 

From Gateway of Tally> Under 

 

 

Creation of Ledger Groups: 

If Account groups are not created, it would be difficult to determine the Accounting nature of all 

the ledgers in books. Groups help in easy classification and organization of Ledgers. 
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From Gateway of Tally > Chart of Accounts > Under Accounting Masters >Enter on 

In the List of Ledgers screen, those accounts which are listed in bold are the parent groups and 

italic are ledgers. This will help the user to identify the nature of 

accounts, that is groups or ledgers. 

ter Screen: 

Tally Prime allows you to group your ledger accounts right at the time of creating your accounts 

chart. Your reports and statements always reflect the desired classification. You can create any 

Under MASTERS> the list of masters appears 

If Account groups are not created, it would be difficult to determine the Accounting nature of all 

the ledgers in books. Groups help in easy classification and organization of Ledgers. 
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From Gateway of Tally > Chart of Accounts > Under Accounting Masters >Enter on 

 
are the parent groups and 

are ledgers. This will help the user to identify the nature of 

Tally Prime allows you to group your ledger accounts right at the time of creating your accounts 

chart. Your reports and statements always reflect the desired classification. You can create any 

 

If Account groups are not created, it would be difficult to determine the Accounting nature of all 

the ledgers in books. Groups help in easy classification and organization of Ledgers.  
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You can create unlimited groups in Tally and configure the details as 

requirement. 

Now, let us illustrate the creation of 

Suhant Software Pvt. Ltd. has customers across India, so the company wanted to classify the 

customers based on the regions North, South, East

 

Account groups are maintained to determine the hierarchy of Ledger Accounts which helps 

determine and present meaningful and compliant reports.

Let us create the Sundry Debtors and Classify based on the region 

 

 

Navigation Path: 

From Gateway of Tally>Create 

Enter the Name as Debtors North Zone > Under Debtors

Similarly let us create other Groups

Group to be created 

Debtors- East Zone 

Debtors-West Zone 

Debtors-South Zone 

 

Debtors

Debtors

Debtors

Debtors
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You can create unlimited groups in Tally and configure the details as per the business 

Now, let us illustrate the creation of Groups in the books of  

. has customers across India, so the company wanted to classify the 

North, South, East and West. 

oups are maintained to determine the hierarchy of Ledger Accounts which helps 

determine and present meaningful and compliant reports. 

Let us create the Sundry Debtors and Classify based on the region  

Create > under AccountingMasters> Group 

Enter the Name as Debtors North Zone > Under Debtors 

Similarly let us create other Groups 

Classification/ Under 

Sundry Debtors 

Sundry Debtors 

Sundry Debtors 

Classification/Under 

Sundry Debtors

Debtors-North Zone

Debtors-South Zone

Debtors-East Zone

Debtors-West Zone
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per the business 

. has customers across India, so the company wanted to classify the 

oups are maintained to determine the hierarchy of Ledger Accounts which helps 
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12.7 Creation of Ledger: 

Ledgers are maintained to keep a record of all the transactions of an accounting entity.

 Without ledgers, it would be difficult to organize all the transactions of an 

accounting entity. 

 Ledgers are essential accountin

transactions of a particular accounting entity.

 Tally has only two default ledgers, i.e.., 

 Creation of ledgers are necessary for recording transactions that involve other 

accounts. 

Let us create the Ledger by using Tally, 

From Gateway of Tally > Create > Under Accounting Master > Ledger

For Example: 

 

Owners 
Capital A/c 

Capital 
Account 
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Ledgers are maintained to keep a record of all the transactions of an accounting entity.

Without ledgers, it would be difficult to organize all the transactions of an 

accounting entity.  

Ledgers are essential accounting books which serve to keep a record of all the 

transactions of a particular accounting entity. 

Tally has only two default ledgers, i.e.., Cash and Profit & Loss A/c

Creation of ledgers are necessary for recording transactions that involve other 

Let us create the Ledger by using Tally,  
From Gateway of Tally > Create > Under Accounting Master > Ledger 

Ledger 

Owners 
Capital A/c 

Capital 
Account 

Sky 
Solution

s 

Sundry 
Debtors 
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Ledgers are maintained to keep a record of all the transactions of an accounting entity. 

Without ledgers, it would be difficult to organize all the transactions of an 

g books which serve to keep a record of all the 

Profit & Loss A/c 

Creation of ledgers are necessary for recording transactions that involve other 
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12.8 Alteration of Master: 

We have learnt how to create Accounting Groups, Ledgers in TallyPrime. 

Now, let us walkthrough Tally how to alter the Masters which are already created.

Navigation Path: 

From Gateway of Tally > Alter > Under Accounting Master > Ledger

In the books of Nidhi Sales Pvt. Ltd., alter the Ledger named owners capital

To Capital Account. 
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We have learnt how to create Accounting Groups, Ledgers in TallyPrime.  

how to alter the Masters which are already created.

From Gateway of Tally > Alter > Under Accounting Master > Ledger 

In the books of Nidhi Sales Pvt. Ltd., alter the Ledger named owners capital 
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how to alter the Masters which are already created. 
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12.9 Deletion of Master: 

Any masters created by the user such as Ledgers can be deleted from the alteration screen by 

using ALT+D option.  

You cannot delete ledgers and groups from the Multiple Group/ Ledger Alteration mode.

12.10 

 

Problem No: 01 

NAME OF LEDGER

PRINTING & STATIONERY 

PURCHASES 

SALES 

COMISSION RECEIVED 

RENT RECEIVED 

CAR 

TAXES PAID 

CAPITAL 

LAND & BUILDINGS 

DRAWINGS 

SURESH (CREDIT SALES) 

RAMESH (CREDIT PURCHASES)

ICICI BANK 

LOAN (UNSECURED LOANS)

RENT PAID 

BANK OD 

CGST 

SGST 

CASH IN HAND 

CASH AT BANK 

TRADEMARKS 

PATENTS 

Master Creation in Tally Prime        12.12  Software Solutions to Accounting

Any masters created by the user such as Ledgers can be deleted from the alteration screen by 

You cannot delete ledgers and groups from the Multiple Group/ Ledger Alteration mode.

 
12.10 Problems on Ledgers Groupings 

NAME OF LEDGER LEDGER GROUP 

Indirect Expenses 

Purchases Account 

Sales Account 

Indirect Income 

Indirect Income 

Fixed Asset 

Indirect Expenses 

Capital Account 

Fixed Asset 

Capital Account 

Sundry Debtors 

RAMESH (CREDIT PURCHASES) Sundry Creditors 

Bank Account 

LOAN (UNSECURED LOANS) Unsecured Loan 

Indirect Expenses 

Bank OD 

Duties & Taxes 

Duties & Taxes 

Cash In Hand 

Current Assets 

Fixed Assets 

Fixed Assets 

Software Solutions to Accounting 

Any masters created by the user such as Ledgers can be deleted from the alteration screen by 

You cannot delete ledgers and groups from the Multiple Group/ Ledger Alteration mode. 
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INVESTMENTS (SHORT) Investments 

 

Problem No: 02 

 NAME OF THE LEDGER UNDER GROUP 

CAPITAL Capital Account 

DRAWINGS Capital Account 

PURCHASES Purchases Account 

PURCHASE RETURNS Purchases Account 

SALES Sales Account 

SALES RETURN Sales Account 

COMMISSION PAID Indirect Expenses 

CGST Duties & Taxes 

MOBILE PHONE  Fixed Assets 

ANIL (CREDIT SALE) Sundry Debtors 

TEJA (CREDIT PURCHASE) Sundry Creditors 

RENT RECEIVED Indirect Income 

BANK OD Bank OD 

CANARA BANK Bank Account 

IGST Duties & Taxes 

PATENTS Fixed Assets 

SALARIES PAID Indirect Expenses 

ADDITIONAL CAPTIAL Capital Account 

LOAN (SECURED) Secured Loan 

LAND & BUILDINGS Fixed Assets 

TRADE MARKS Fixed Assets 

 

Problem No: 03 

  NAME OF THE LEDGER                         UNDER GROUP 

CAPITAL Capital Account 

PURCHASES Purchases Account 

COMMISSION RECEVIED Indirect Income 

SALES RETURN Sales Account 

CGST Duties & Taxes 

LAND & BUILDINGS Fixed Assets 

RENT PAID Indirect Expenses 

FACTORY GAS Direct Expenses 

Factory Lighting Direct Expenses 

DRAWINGS Capital Account 

CASH-IN-HAND Current Assets 

SALARIES PAID Indirect expenses 

INTEREST ON CAPITAL Capital Account 

INVESTMENTS Investments 

HDFC BANK Bank Accounts 

PURCHASES RETURN Purchases Account 

SANDEEP (CREDIT SALE) Sundry Debtors 
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SATISH (CREDIT PURCHASE) Sundry Creditors 

SGST Duties & Taxes 

SALES Sales Accounts 

COMMISSION PAID Indirect Expenses 

TDS Duties & Taxes 

BANK OD Bank OD 

DONATION RECEVIED Indirect Income 

BILLS PAYABLE Current Liabilities 

 

Problem No: 04 

  NAME OF THE LEDGER                    UNDER GROUP 

DONATIONS PAID Indirect Expenses 

PURCHASES RETURN Purchases Accounts 

RAMESH (CREDIT SALES) Sundry Debtors 

INSURANCE PAID Indirect Expenses 

FACTORY LIGHTING Direct Expenses 

DISCOUNT ALLOWED Indirect Expenses 

TCS (TAX COLLECTION SOURCE) Duties & Taxes 

VAT ( VALUE ADDED TAX) Duties & Taxes 

SURESH (CREDIT PURCHASES) Sundry Creditors 

SECURED LOAN Secured Loan 

 

Problem No: 05 

NAME OF THE LEDGER UNDER GROUP 

GOODWILL Fixed Assets 

FACTORY GAS Direct Expenses 

PURCHASES Purchases Account 

VAT (VALUE ADDED TAX) Duties & Taxes 

LOAN TAKEN FROM FRIENDS Unsecured Loan 

HDFC BANK Bank Accounts 

SALARIES PAID Indirect Expenses 

RENT RECEVIED Indirect Incomes 

BROKERAGE RECEIVED Indirect Incomes 

TRADE PAYABLE Current Liabilities 

RETURN INWARDS Sales Accounts 

ADDITIONAL CAPITAL Capital Accounts 

INTEREST ON CAPITAL Capital Accounts 

SHARES PURCHASED 

(INVESTMENTED) IN ABC PVT LTD 

Investment Account 

CGST (CENTRAL GOODS & SERVICES 

TAX) 

Duties & Taxes 

PATENTS Fixed Assets 

BANK OD Bank OD 

OPENING STOCK Stock-in-Hand 

GUNTUR BRANCH Branch/Division 
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RAJU (CREDIT PURCHASES) Sundry Creditors 

GEETHA ( CREDIT SALES) Sundry Debtors 

RETURN OUTWARDS Purchases Accounts 

 

12.11 Keywords: 

1. Financial Reporting: In-depth understanding of preparing and analyzing financial statements 

in compliance with regulatory standards. 

2. Cost Management: Techniques and strategies for managing and reducing costs to enhance 

business profitability. 

3. Auditing: Comprehensive knowledge of internal and external auditing processes to ensure 

accuracy and compliance with financial regulations. 

4. Taxation: Expertise in tax laws and regulations to optimize tax strategies and ensure adherence 

to legal requirements. 
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INVENTORY MASTER

Objective: 

1. Purpose of Inventory Masters: Explain the role of inventory masters in managing stock and 

inventory. 

2. Types of Inventory Masters: Identify the different types of inventory masters such as stock 

groups, stock items, and units of measure.

3. Creation and Configuration: Detail the steps to create and configure inventory masters in Tally 

Prime. 

4. Inventory Tracking: Describe how inventory masters help in tracking inventory levels and 

movements. 

5. Integration with Accounting: Discuss the integration of inventory masters with accounting 

entries and financial statements. 

 

Structure: 

13.1 Introduction 

13.2 Inventory Management 

13.3 Why is inventory management important?

13.4 What are the challenges of inventory manag

13.5 Process of inventory management

13.6 Inventory Types 

13.7 Alteration of Stock Groups, Stock Category, Stock Items, Units of Measures

13.8 Deletion of Master 

13.9 Problems on Inventory Master

13.10 Keywords 

13.11 Reference 

 

13.1 Introduction: 

Inventory is an idle stock of physical goods that contain economic value and are held in various 

forms by an organization. Inventories are held in various forms, it can be a stock awaiting 

packing, processing, transformation, use or sale in a future point 

Any organization which is into production, trading, sales and service of a product will 

necessarily hold inventories to aid in future consumption and sale.

Lesson - 13 

INVENTORY MASTER 

 

1. Purpose of Inventory Masters: Explain the role of inventory masters in managing stock and 

2. Types of Inventory Masters: Identify the different types of inventory masters such as stock 

items, and units of measure. 

3. Creation and Configuration: Detail the steps to create and configure inventory masters in Tally 

4. Inventory Tracking: Describe how inventory masters help in tracking inventory levels and 

h Accounting: Discuss the integration of inventory masters with accounting 

 

13.3 Why is inventory management important? 

13.4 What are the challenges of inventory management? 

13.5 Process of inventory management 

13.7 Alteration of Stock Groups, Stock Category, Stock Items, Units of Measures

13.9 Problems on Inventory Master 

Inventory is an idle stock of physical goods that contain economic value and are held in various 

forms by an organization. Inventories are held in various forms, it can be a stock awaiting 

packing, processing, transformation, use or sale in a future point of time. 

Any organization which is into production, trading, sales and service of a product will 

necessarily hold inventories to aid in future consumption and sale. 

1. Purpose of Inventory Masters: Explain the role of inventory masters in managing stock and 

2. Types of Inventory Masters: Identify the different types of inventory masters such as stock 

3. Creation and Configuration: Detail the steps to create and configure inventory masters in Tally 

4. Inventory Tracking: Describe how inventory masters help in tracking inventory levels and 

h Accounting: Discuss the integration of inventory masters with accounting 

13.7 Alteration of Stock Groups, Stock Category, Stock Items, Units of Measures 

Inventory is an idle stock of physical goods that contain economic value and are held in various 

forms by an organization. Inventories are held in various forms, it can be a stock awaiting 

Any organization which is into production, trading, sales and service of a product will 
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13.2 Inventory Management: 

• Inventory management can be defined as a whole lot of activities done to maintain an optimum 

number of inventories to ensure uninterrupted production, sales, high customer satisfaction, and 

reduced inventory handling cost and so on. 

• In simple words, inventory management is all about striking the balance between overstocking 

and understocking. Overstocking will lead to cash flow blockage and additional cost for 

managing excess stock. On the flip side, understocking leads to loss of sale due to non-

availability of stock at the right time. 

• Thus, it's all about maintaining the right level inventories at the right time and keeping the 

inventory handling cost at low. 

• To be efficient in inventory management, a whole lot of activities/ techniques are to be 

followed by the business. 

 

13.3 Why is inventory management important? 

• Inventory management determines the stock a business should keep and when it should 

replenish it. 

• It aims to avoid understocking and overstocking for the proper functioning of the business 

while meeting customer demand at all times. 

• Businesses that can manage inventory well function better because they don't have unsold stock 

or deadstock in hand. 

• A business should ideally have sufficient inventory to meet demand and be prepared for 

unforeseen circumstances when there is a demand surge. 

• Inventory management formulas determine the ideal amount of stock, when to replenish stock, 

and how much to keep aside to be prepared in case of emergencies. 

• Depending on our inventory type, we keep, we can use some or all of the inventory formulas 

for better insights into our business inventory. 

• Inventory management boosts revenue by selling the inventory at the right time. Inventory 

management applies to every business; whether we are an e-commerce business or even if we 

operate a brick-and-mortar store. 

 

13.4 What are the challenges of inventory management? 

Inventory management is a challenging process, and here are some reasons 

1. Difficult to predict demand 

• Customer demand can change, and a lot of factors can affect demand. Take the pandemic for 

example. It changed consumer preferences and put the spotlight on certain essential products. As 

it is difficult to predict customer demand, managing inventory is a tough task because it is never 

guaranteed what a customer will want in the next instant. 

2. Space utilization is tricky 

• The way the inventory is managed can be challenging, especially when a business has several 

product lines. Businesses need to use the warehouse space well otherwise it can easily lead to 

unsold stock. If the business has multiple warehouses, then it becomes trickier to store 

efficiently. A lot of time is required to properly manage every warehouse. 

3. Determining stock in hand 

Many methods of determining the inventory at hand exist. However, it is still a challenge many 

businesses struggle with because it is a tedious and time-intensive task. It is prone to error 
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especially when there is no proper inventory management system in place. This can impact the 

other aspects of our business because our staff will spend mostof the time counting inventory. 

4. Unexpected problems in the supply chain 

• If any disruptions occur in the supply chain, they will directly impact our business which can 

cause problems. Natural disasters and other problems can cause delays in receiving orders and 

disrupt our everyday business. It is difficult to always predict when a problem can happen and so 

businesses can never be fully prepared for it. 

 

13.5 Process of inventory management: 

Step 1: Order inventory 

The first step starts with ordering raw materials and the required components required for the 

finished goods. 

Step 2: Monitor and store inventory 

Monitor the inventory received from supplier and then store it as required to ensure it is safe and 

easily retrievable. Have a system in place for efficient inventory storage.  

Step 3: Check inventory levels 

Check the inventory levels and keep them noted somewhere. Use any inventory management 

system to reduce errors. 

Step 4: Customers place orders 

Customers place orders depending on where we are selling and setting up a storefront. These 

orders are then approved by a system. 

Step 5: Send orders to customers 

We then find the necessary items the customers ordered and send them to our customers after 

packaging. 

Step 6: Update inventory level 

When the item has been sent, we will update inventory levels, so it accurately reflects the 

inventory we now have at hand. 

Step 7: Restock inventory 

We are going to restock our inventory as required before the stocks are too low. Restock will 

depend on demand forecasting and other insights along with past orders. 

 

13.6 Inventory Types: 

One of crucial for efficient inventory management is to know and understand the different types 

of inventories we deal with. This because, importance, requirements, inventory level, treatment 

etc. differs basics the type of inventory. For example, the way we look at raw material differs 

from the finished product. 
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Steps for Inventory Management in Tally Prime:

Inventory management in Tally Prime refers to a set of features that help

control the stock of items they buy, sell, or manufacture. It essentially allows us to monitor the 

flow of goods throughout our business cycle, from purchasing raw materials to selling finished 

products. 

 

Step 1: Create a Company, ensure that accounts is Integrated with Inventory & Enable GST.

 Enable GST > Yes > Enter Particular details as per Company Requirement.

 

 

Classify Stock Groups, Stock Categories and Stocks Items:

Managing stock items in groups help in easily locating them, especially when we need to track 

different stock items sharing a common feature 

used, and so on. We can get a consolidated view of the total stock ite

13.4  Software Solutions to Accounting

Steps for Inventory Management in Tally Prime: 

Inventory management in Tally Prime refers to a set of features that help businesses track and 

control the stock of items they buy, sell, or manufacture. It essentially allows us to monitor the 

flow of goods throughout our business cycle, from purchasing raw materials to selling finished 

ure that accounts is Integrated with Inventory & Enable GST.

Enable GST > Yes > Enter Particular details as per Company Requirement.

Classify Stock Groups, Stock Categories and Stocks Items: 

Managing stock items in groups help in easily locating them, especially when we need to track 

different stock items sharing a common feature - say a common brand, product type, material 

used, and so on. We can get a consolidated view of the total stock items available under that 

Software Solutions to Accounting 

 

businesses track and 

control the stock of items they buy, sell, or manufacture. It essentially allows us to monitor the 

flow of goods throughout our business cycle, from purchasing raw materials to selling finished 

ure that accounts is Integrated with Inventory & Enable GST. 

 
Enable GST > Yes > Enter Particular details as per Company Requirement. 

 

Managing stock items in groups help in easily locating them, especially when we need to track 

say a common brand, product type, material 

ms available under that 
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group. Stock items under a group need to have the same unit of measurement for consolidation 

and better management. This also helps in reporting of stock items group

statements. 

 

Step 2: Create Stock Group 

• Gateway of Tally > Create > type or select Stock Group and press Enter.

Alternatively, press Alt+G (Go To) > Create Master > type or select Stock Group > and press 

Enter. 

• Name & alias: As in other masters, we can specify multiple aliases for the stock item

• Under: Select Primary or an existing Stock Group. If we have not created any Stock Group, we 

can create one in Tallyprime to assign to the stock group.

As always, press Alt+C, to create a master on the fly. Alternatively, press Alt+G (Go To) > Create 

Master > type or select Stock Group > press Enter.

• Should quantities of items be added:

Stock Items that we would categorise under the Stock Group. The Stock Items categorised under 

the group should have similar units for them to be added up. We cannot add quantities in Kgs to 

quantities in Pcs. 

• Set/alter GST Details: Enable this option to define the GST rate.

Accept the screen. As always, press Ctrl+A to save.

 

 

 

 

 

 

 

 

 

Step 3: Create Stock Category 

Stock category offers a parallel classification of stock items, categorizing items is that we can 

classify the stock category based on functionality together in a group. We can classify the stock 

category across different stock groups which enables us t

substitutes for a stock item. 

• Gateway of Tally > Create > type or select Stock Category and press Enter.

Alternatively, press Alt+G (Go To) > Create Master > type or select Stock Category > and press 

Enter. 

• Name & alias: As in other masters, we can specify multiple aliases for the stock item.

• Under: Select Primary or an existing Stock Group. If we have not created any Stock Group, we 

can create one in Tally Prime to assign to the stock categories.

 

 

As always, press Alt+C, to create a master on the fly. Alternatively, press Alt+G (Go To) > Create 

Master > type or select Stock Category> press Enter. Accept the screen. As always, press Ctrl+A 

to save. 
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group. Stock items under a group need to have the same unit of measurement for consolidation 

and better management. This also helps in reporting of stock items group-wise in the financial 

teway of Tally > Create > type or select Stock Group and press Enter. 

Alternatively, press Alt+G (Go To) > Create Master > type or select Stock Group > and press 

As in other masters, we can specify multiple aliases for the stock item

: Select Primary or an existing Stock Group. If we have not created any Stock Group, we 

can create one in Tallyprime to assign to the stock group. 

As always, press Alt+C, to create a master on the fly. Alternatively, press Alt+G (Go To) > Create 

aster > type or select Stock Group > press Enter. 

Should quantities of items be added: It pertains to information on measuring the units of the 

Stock Items that we would categorise under the Stock Group. The Stock Items categorised under 

have similar units for them to be added up. We cannot add quantities in Kgs to 

Enable this option to define the GST rate. 

Accept the screen. As always, press Ctrl+A to save. 

 

Stock category offers a parallel classification of stock items, categorizing items is that we can 

classify the stock category based on functionality together in a group. We can classify the stock 

category across different stock groups which enables us to obtain reports on alternatives or 

• Gateway of Tally > Create > type or select Stock Category and press Enter. 

Alternatively, press Alt+G (Go To) > Create Master > type or select Stock Category > and press 

: As in other masters, we can specify multiple aliases for the stock item.

Select Primary or an existing Stock Group. If we have not created any Stock Group, we 

can create one in Tally Prime to assign to the stock categories. 

press Alt+C, to create a master on the fly. Alternatively, press Alt+G (Go To) > Create 

Master > type or select Stock Category> press Enter. Accept the screen. As always, press Ctrl+A 
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group. Stock items under a group need to have the same unit of measurement for consolidation 

wise in the financial 

Alternatively, press Alt+G (Go To) > Create Master > type or select Stock Group > and press 

As in other masters, we can specify multiple aliases for the stock item. 

: Select Primary or an existing Stock Group. If we have not created any Stock Group, we 

As always, press Alt+C, to create a master on the fly. Alternatively, press Alt+G (Go To) > Create 

It pertains to information on measuring the units of the 

Stock Items that we would categorise under the Stock Group. The Stock Items categorised under 

have similar units for them to be added up. We cannot add quantities in Kgs to 

Stock category offers a parallel classification of stock items, categorizing items is that we can 

classify the stock category based on functionality together in a group. We can classify the stock 

o obtain reports on alternatives or 

Alternatively, press Alt+G (Go To) > Create Master > type or select Stock Category > and press 

: As in other masters, we can specify multiple aliases for the stock item. 

Select Primary or an existing Stock Group. If we have not created any Stock Group, we 

press Alt+C, to create a master on the fly. Alternatively, press Alt+G (Go To) > Create 

Master > type or select Stock Category> press Enter. Accept the screen. As always, press Ctrl+A 
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We should use Stock Groups and Stock Categories in Tally 

organize and analyze your inventory

• Stock Groups: Ideal for reports on groups with similar properties (e.g., total clothing vs. 

electronics). Use them when inherent item properties are the focus (brand, type, size).

• Stock Categories: Useful for analyzing usage of interchangeable items across Stock Groups 

(e.g., formal shirts and pants). Use them when functionality across groups is important.

Imagine a clothing store. Stock Groups are like departments (Shirts, Pants) whi

Categories are styles (Formal Wear, Casual Wear) that can cut across departments.

Step 4: Create Units of Measurement:

Depending on our business, we may be selling or buying stock items in different units. For 

example, we can use simple units like

boxes of standard sizes - say 100 kg for a box, using TallyPrime, we can create all different units 

as per our needs. 

4A. Simple Unit 

• While creating a stock item, press Alt+C, to create a unit ma

The Unit Creation (Secondary) screen opens.

Enter the details in the Unit Creation screen.

a. Enter the Symbol. By default, the Type field will be selected as Simple.

b. Enter the Formal name for the simple unit.

c. Select the Unit Quantity Code (UQC)

The list consists of the number of Unit Quantity Codes (UQC)

commodity as declared by the Government or GSTN.

d. Specify the Number of decimal

Press Y to accept the screen. As always, we can press Ctrl+A to create a Simple unit.

 

4B. Compound Unit: 

While creating a stock item, press Alt+C to create a unit master on the fly.

The Unit Creation (Secondary) screen 

Enter the details in the Unit Creation screen:

a. Press Backspace and select Compound if the Type is selected as Simple.

b. Enter the Compound unit as the First unit. For example, Kg.

c. Enter the Conversion For example, 1000.

13.6  Software Solutions to Accounting

We should use Stock Groups and Stock Categories in Tally Prime depending on how we want to 

organize and analyze your inventory 

Ideal for reports on groups with similar properties (e.g., total clothing vs. 

electronics). Use them when inherent item properties are the focus (brand, type, size).

Useful for analyzing usage of interchangeable items across Stock Groups 

(e.g., formal shirts and pants). Use them when functionality across groups is important.

Imagine a clothing store. Stock Groups are like departments (Shirts, Pants) whi

Categories are styles (Formal Wear, Casual Wear) that can cut across departments.

Step 4: Create Units of Measurement: 

Depending on our business, we may be selling or buying stock items in different units. For 

example, we can use simple units like Meters, Centimeters, or Nos. If we sell items in bags and 

say 100 kg for a box, using TallyPrime, we can create all different units 

• While creating a stock item, press Alt+C, to create a unit master on the fly. 

The Unit Creation (Secondary) screen opens. 

Enter the details in the Unit Creation screen. 

By default, the Type field will be selected as Simple. 

for the simple unit. 

y Code (UQC) relevant to the stock item from the list provided.

number of Unit Quantity Codes (UQC) available for our product or 

commodity as declared by the Government or GSTN. 

Number of decimal places required based on our business needs. 

Press Y to accept the screen. As always, we can press Ctrl+A to create a Simple unit.

While creating a stock item, press Alt+C to create a unit master on the fly. 

The Unit Creation (Secondary) screen opens. 

Enter the details in the Unit Creation screen: 

a. Press Backspace and select Compound if the Type is selected as Simple. 

b. Enter the Compound unit as the First unit. For example, Kg. 

c. Enter the Conversion For example, 1000. 

Software Solutions to Accounting 

Prime depending on how we want to 

Ideal for reports on groups with similar properties (e.g., total clothing vs. 

electronics). Use them when inherent item properties are the focus (brand, type, size). 

Useful for analyzing usage of interchangeable items across Stock Groups 

(e.g., formal shirts and pants). Use them when functionality across groups is important. 

Imagine a clothing store. Stock Groups are like departments (Shirts, Pants) while Stock 

Categories are styles (Formal Wear, Casual Wear) that can cut across departments. 

Depending on our business, we may be selling or buying stock items in different units. For 

Meters, Centimeters, or Nos. If we sell items in bags and 

say 100 kg for a box, using TallyPrime, we can create all different units 

relevant to the stock item from the list provided. 

available for our product or 

 

 

 

 

 

 

 

 

Press Y to accept the screen. As always, we can press Ctrl+A to create a Simple unit. 
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Note: Compound units can be created up to any level. For example, milligram <gram < kilogram 

< quintal < tonne. However, the relationship between the units should be convertible.

d Enter the Second unit. For Example Gm

 

Step 5: Stock Items: 

A stock item in Tally Prime is requ

business deals with. Once we have created stock item, we can record our business transactions 

and keep track of the stock item details. Simply enter the name of the stock item we want to 

create and save it. Also, provide the opening balance details such as quantity, rate, value 

applicable tax rates so that we can record transactions in less time, without the need to enter all 

of these details each time in the transactions.

A. Create Stock Items 

• Gateway of Tally > Create > type or select Stock Item > and press Enter.

Alternatively, press Alt+G (Go To) > Create Master > type or select Stock Item > and press 

Enter. 

• Name & alias: As in other masters, we can specify multiple aliases for the sto

• Under: Select Primary or an existing Stock Group. If we have not created any Stock Group, we 

can create one in Tally Prime to assign to the stock item.

As always, press Alt+C, to create a master on the fly. Alternatively, press Alt+G (Go To) > C

Master > type or select Stock Items > press Enter.

• Units: Select the unit of measurement applicable for the stock item. If the unit is not listed, we 

can create the unit of measurement in Tally Prime to assign to the stock item.

. 

As always, press Alt+C, to create a master on the fly. Alternatively, press Alt+G (Go To) > Create 

Master > type or select Units > press Enter.

Statutory Details: Set the applicable Taxability option for the stock item under Statutory details. 

The option will depend on the option enabled in the F11 (Features) screen. Opening Balance: 

Specify the opening balance for the Stock Item as on the date of Beginning of Books.

a. Quantity: Specify the stock item Quantity.

b. Rate: Specify the stock item Rate.

c. Value: Tally Prime automatically calculates the value by multiplying the Quantity and Rate. 

We can also edit the value, Tally Prime automatically refreshes the Rate field accordingly. Accept 

the screen. As always, press Ctrl+A to save. 
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can be created up to any level. For example, milligram <gram < kilogram 

< quintal < tonne. However, the relationship between the units should be convertible.

d Enter the Second unit. For Example Gm 

A stock item in Tally Prime is required to fill in information about the stock or inventory that our 

business deals with. Once we have created stock item, we can record our business transactions 

and keep track of the stock item details. Simply enter the name of the stock item we want to 

ate and save it. Also, provide the opening balance details such as quantity, rate, value 

applicable tax rates so that we can record transactions in less time, without the need to enter all 

of these details each time in the transactions. 

• Gateway of Tally > Create > type or select Stock Item > and press Enter. 

Alternatively, press Alt+G (Go To) > Create Master > type or select Stock Item > and press 

• Name & alias: As in other masters, we can specify multiple aliases for the stock item.

• Under: Select Primary or an existing Stock Group. If we have not created any Stock Group, we 

can create one in Tally Prime to assign to the stock item. 

As always, press Alt+C, to create a master on the fly. Alternatively, press Alt+G (Go To) > C

Master > type or select Stock Items > press Enter. 

• Units: Select the unit of measurement applicable for the stock item. If the unit is not listed, we 

can create the unit of measurement in Tally Prime to assign to the stock item. 

Alt+C, to create a master on the fly. Alternatively, press Alt+G (Go To) > Create 

Master > type or select Units > press Enter. 

Statutory Details: Set the applicable Taxability option for the stock item under Statutory details. 

option enabled in the F11 (Features) screen. Opening Balance: 

Specify the opening balance for the Stock Item as on the date of Beginning of Books.

a. Quantity: Specify the stock item Quantity. 

b. Rate: Specify the stock item Rate. 

c. Value: Tally Prime automatically calculates the value by multiplying the Quantity and Rate. 

We can also edit the value, Tally Prime automatically refreshes the Rate field accordingly. Accept 

the screen. As always, press Ctrl+A to save.  
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can be created up to any level. For example, milligram <gram < kilogram 

< quintal < tonne. However, the relationship between the units should be convertible. 

ired to fill in information about the stock or inventory that our 

business deals with. Once we have created stock item, we can record our business transactions 

and keep track of the stock item details. Simply enter the name of the stock item we want to 

ate and save it. Also, provide the opening balance details such as quantity, rate, value 

applicable tax rates so that we can record transactions in less time, without the need to enter all 

Alternatively, press Alt+G (Go To) > Create Master > type or select Stock Item > and press 

ck item. 

• Under: Select Primary or an existing Stock Group. If we have not created any Stock Group, we 

As always, press Alt+C, to create a master on the fly. Alternatively, press Alt+G (Go To) > Create 

• Units: Select the unit of measurement applicable for the stock item. If the unit is not listed, we 

Alt+C, to create a master on the fly. Alternatively, press Alt+G (Go To) > Create 

Statutory Details: Set the applicable Taxability option for the stock item under Statutory details. 

option enabled in the F11 (Features) screen. Opening Balance: 

Specify the opening balance for the Stock Item as on the date of Beginning of Books. 

c. Value: Tally Prime automatically calculates the value by multiplying the Quantity and Rate. 

We can also edit the value, Tally Prime automatically refreshes the Rate field accordingly. Accept 
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13.7 Alteration of Stock Groups, Stock Category, Stock Items, Units of Measures:

We have learnt how to create Stock Groups, Stock Categories, Stock Items, Units of Measure 

and Godowns in Tally Prime.  

 

Navigation Path: 

From Gateway of Tally>Alter

Category/Stock Items/ Units of Measures.

 

Open the Required option to Alter the respective information and then Modification or Update 

Information want to be saved with Ctrl+A.

Then Automatically the modified information migh
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Alteration of Stock Groups, Stock Category, Stock Items, Units of Measures:

We have learnt how to create Stock Groups, Stock Categories, Stock Items, Units of Measure 

Alter> under Inventory Masters> Stock Groups/Stock 

Category/Stock Items/ Units of Measures. 

Open the Required option to Alter the respective information and then Modification or Update 

Information want to be saved with Ctrl+A. 

Then Automatically the modified information might be updated in fraction of seconds.
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Alteration of Stock Groups, Stock Category, Stock Items, Units of Measures: 

We have learnt how to create Stock Groups, Stock Categories, Stock Items, Units of Measure 

Stock Groups/Stock 

Open the Required option to Alter the respective information and then Modification or Update 

t be updated in fraction of seconds. 
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13.8Deletion of Master: 

Any masters created by the user such as Ledgers, Groups, Stock Groups, Stock Category, Stock 

Item, Unit and Godowns can be deleted from the alteration screen by using ALT+D option. 

You cannot delete ledgers and groups from the Multiple Group/ Ledger Alter
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Any masters created by the user such as Ledgers, Groups, Stock Groups, Stock Category, Stock 

Item, Unit and Godowns can be deleted from the alteration screen by using ALT+D option. 

You cannot delete ledgers and groups from the Multiple Group/ Ledger Alteration mode.

Acharya Nagarjuna University 

Any masters created by the user such as Ledgers, Groups, Stock Groups, Stock Category, Stock 

Item, Unit and Godowns can be deleted from the alteration screen by using ALT+D option.  

ation mode. 
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13.9 Problems on Inventory Master

 

Problem No:01 

Creation of Stock Group. 

Problem No:02 

Creation of Stock Category 

 

Problem No:03 

Creation of Stock Items. 
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Problems on Inventory Master 
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Problem No: 04 

Creation of Stock Groups, Stock Category, Units of Measures, 

 

13.10 Keywords: 

1. Inventory Management, Stock Control, Product Catalog, Warehouse Tracking

2. Supply Chain, Item Classification, Inventory Accuracy, Reorder Levels

3. Barcode System, Inventory Audits, Stock Valuation, Item Ledger

4. Inventory Optimization, Demand Forecasting, Inventory Turnover, Safety Stock
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Creation of Stock Groups, Stock Category, Units of Measures, Stock Item Name.

1. Inventory Management, Stock Control, Product Catalog, Warehouse Tracking

2. Supply Chain, Item Classification, Inventory Accuracy, Reorder Levels 

3. Barcode System, Inventory Audits, Stock Valuation, Item Ledger 
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"Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 
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Lesson - 14 

 VOUCHER TYPES 

 
Objective: 

1. Definition of Voucher Types: Define what voucher types are and their role in accounting. 

2. Common Voucher Types: Identify and describe common voucher types such as sales, 

purchases, receipts, and payments. 

3. Creation and Customization: Explain how to create and customize voucher types in Tally 

Prime. 

4. Automation and Efficiency: Discuss how using appropriate voucher types can automate and 

improve accounting efficiency. 

5. Voucher Management: Provide best practices for managing and maintaining vouchers in an 

organized manner. 

 

Structure: 

14.1 Introduction 

14.2 Process of Voucher Entry 

14.3 Voucher Entry 

14.4 Alter Voucher types & Details (Master Alteration) 

14.5 Alter a Pre-defined Voucher Type 

14.6 Delete Voucher Types in Tally Prime 

14.7 Keywords 

14.8 Reference 

 

14.1 Introduction: 

A voucher entry in accounting refers to the process of recording a financial transaction in an 

accounting system. In Tally Prime and other accounting software, a voucher is essentially a 

document that supports and records a transaction. Here's a detailed explanation of what voucher 

entry means: 

 

Definition 

Voucher Entry: The process of inputting financial transaction details into the accounting 

system, categorized by the type of transaction, to maintain accurate financial records. 

 

Key Points 

1.Documentation of Transactions: 

   - Vouchers serve as evidence of transactions, ensuring that each transaction is properly 

documented and traceable. 

 

2. Types of Vouchers: 

   - Vouchers are classified based on the nature of transactions. Common types include payment 

vouchers, receipt vouchers, sales vouchers, purchase vouchers, contra vouchers, journal 

vouchers, credit notes, and debit notes. 

 

3. Components of a Voucher Entry: 

   - Date: The date when the transaction occurred. 
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   - Ledger Accounts: The accounts involved in the transaction, such as cash, bank, sales, 

purchases, expenses, etc. 

   - Amount: The monetary value of the transaction. 

   - Narration: A brief description of the transaction. 

   - Supporting Documents: Attachments like invoices, receipts, bills, etc., to substantiate the 

transaction. 

 

4. Purpose of Voucher Entry: 

   - To maintain systematic and accurate financial records. 

   - To ensure compliance with accounting standards and legal requirements. 

   - To facilitate financial reporting and analysis. 

   - To provide an audit trail for verification and reconciliation purposes. 

 

14.2 Process of Voucher Entry 

1. Identify the Transaction: 

   - Determine the type and nature of the transaction. 

2. Select the Appropriate Voucher Type: 

   - Choose the correct voucher type in the accounting system to record the transaction (e.g., 

payment voucher for payments, sales voucher for sales transactions). 

3. Enter Transaction Details: 

   - Input all relevant details such as date, ledger accounts, amounts, and narration. 

4. Verify and Save: 

   - Review the entered details for accuracy and save the voucher entry. 

Benefits 

- Accuracy: Ensures precise recording of financial transactions. 

- Compliance: Helps in adhering to regulatory and statutory requirements. 

- Transparency: Provides a clear and traceable record of all financial activities. 

- Efficiency: Streamlines the accounting process, making it easier to manage and report financial 

data. 

Voucher entries are fundamental to maintaining an organized and reliable accounting 

system, playing a crucial role in the financial management and auditing processes of a business. 

Accounting is the practice of maintaining a record of the financial dealings of a business.  

It involves Identifying business transactions, Recording them, and Summarising the same in 

such a way that, important financial information can be communicated to stakeholders of the 

business.  

Recording of a financial transaction is the first step in an accounting cycle.  

Every day, business concerns are involved in business activities like making purchases, sales, 

making payments to vendors, receiving payments from customers and so on.  

If any one of the transactions is not recorded properly or is missed out, the financial reports will 

not reflect the correct financial performance or financial position of the company. 

 

14.3 Voucher Entry: 

In Tally Prime, a voucher entry refers to the process of recording a financial transaction using a 

specific voucher type. These vouchers act as the building blocks for accounting records, 

providing a detailed and organized way to track business's financial activity. 

 



Centre for Distance Education 

 

Breakdown of the key points: 

Vouchers: They are digital documents in Tally Prime that represent various financial 

transactions, such as purchases, sales, payments, receipts, and adjustments.

Voucher types: These act as pre-

entries. 

Essentially, creating a voucher entry involves selecting the appropriate voucher type, entering the 

relevant details such as accounts involved, amount, and narration (optio

transaction. This process helps to maintain a clear and auditable record of all business's financial 

activities. 

 

Voucher: 

A voucher is a document that contains details of a financial transaction and is required for 

recording the same into the books of accounts.

• For every transaction, we can use the appropriate Tally voucher to enter the details into the 

ledgers and update the financial position of the company. This process is called Voucher Entry in 

Tally.  

• In simple terms passing journal entries in Tally is called as Voucher Entry.

• In fact, the user will not use the word "Journal Entry" while working in Tally. However, 

"Journal Voucher" is a type of voucher entry.

• Voucher type includes Purchase, Sales, Receipt, Payment, Contra,

 

Voucher Types in Tally Prime: 

There are 24 pre-defined voucher types in Tally Prime for accounting, inventory, payroll and 

orders. We can create more voucher types under these pre

business needs. 

Example: 

•for cash payments and bank payments, the predefined voucher type is Payment Voucher.

• we can also have two or more sales voucher types in Tally Prime for different kinds of sales 

transactions like credit sales, cash sales, and so on.

 

 

Navigation Path for list of Voucher Types in Tally Prime:

Gateway of Tally > Chart of Accounts > type or select Voucher Type.

Alternatively, press Alt + G (Go To) > type or select Chart of Accounts > Voucher Type. The 

screen appears as shown below: 
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They are digital documents in Tally Prime that represent various financial 

transactions, such as purchases, sales, payments, receipts, and adjustments. 

-defined templates that categorize and format the voucher 

Essentially, creating a voucher entry involves selecting the appropriate voucher type, entering the 

relevant details such as accounts involved, amount, and narration (optional), and saving the 

transaction. This process helps to maintain a clear and auditable record of all business's financial 

A voucher is a document that contains details of a financial transaction and is required for 

into the books of accounts. 

• For every transaction, we can use the appropriate Tally voucher to enter the details into the 

ledgers and update the financial position of the company. This process is called Voucher Entry in 

journal entries in Tally is called as Voucher Entry. 

• In fact, the user will not use the word "Journal Entry" while working in Tally. However, 

"Journal Voucher" is a type of voucher entry. 

• Voucher type includes Purchase, Sales, Receipt, Payment, Contra, Journal, etc. 

 

defined voucher types in Tally Prime for accounting, inventory, payroll and 

orders. We can create more voucher types under these pre-defined voucher types as per the 

•for cash payments and bank payments, the predefined voucher type is Payment Voucher.

• we can also have two or more sales voucher types in Tally Prime for different kinds of sales 

transactions like credit sales, cash sales, and so on. 

for list of Voucher Types in Tally Prime: 

Gateway of Tally > Chart of Accounts > type or select Voucher Type. 

Alternatively, press Alt + G (Go To) > type or select Chart of Accounts > Voucher Type. The 
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They are digital documents in Tally Prime that represent various financial 

defined templates that categorize and format the voucher 

Essentially, creating a voucher entry involves selecting the appropriate voucher type, entering the 

nal), and saving the 

transaction. This process helps to maintain a clear and auditable record of all business's financial 

A voucher is a document that contains details of a financial transaction and is required for 

• For every transaction, we can use the appropriate Tally voucher to enter the details into the 

ledgers and update the financial position of the company. This process is called Voucher Entry in 

• In fact, the user will not use the word "Journal Entry" while working in Tally. However, 

 

defined voucher types in Tally Prime for accounting, inventory, payroll and 

defined voucher types as per the 

•for cash payments and bank payments, the predefined voucher type is Payment Voucher. 

• we can also have two or more sales voucher types in Tally Prime for different kinds of sales 

 

Alternatively, press Alt + G (Go To) > type or select Chart of Accounts > Voucher Type. The 
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14.4 Alter Voucher types & Details (Master Alteration):

Go to Gateway of Tally > Alter > Voucher Type.

Alternatively, press Alt + G (Go To) > type or select Alter Master > Voucher Type.

The List of Voucher Types appears as shown below:

 

 

 

 

 

 

 

 

 

 

 

 

We can do the 

• Activate / 

as per your business 

 • Use different 

methods. 

• Specify the prefix 

numbering the 

 • Use the effective 

• Mark some 

optional vouchers by 

• Use common 

for each ledger selected in the voucher. Enable the option to print immediately after saving the 

vouchers. 
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types & Details (Master Alteration): 

Go to Gateway of Tally > Alter > Voucher Type. 

Alternatively, press Alt + G (Go To) > type or select Alter Master > Voucher Type.

The List of Voucher Types appears as shown below: 

following 

Deactivate voucher type 

need. 

voucher numbering 

and suffix details for 

vouchers.

dates for the vouchers.

vouchers to

default.

narration or narration 

for each ledger selected in the voucher. Enable the option to print immediately after saving the 
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Alternatively, press Alt + G (Go To) > type or select Alter Master > Voucher Type. 

following alteration: 

Deactivate voucher type 

voucher numbering 

and suffix details for 

vouchers. 

dates for the vouchers. 

vouchers to open as 

default. 

narration or narration 

for each ledger selected in the voucher. Enable the option to print immediately after saving the 
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14.5 Alter a Pre-defined Voucher Type:

Pre-defined voucher types in Tally

• Gateway of Tally > Alter > type or select Voucher Type > Sales.

Alternatively, Alt + G (Go To) > type or select Alter Master > Voucher Type > Sales.

• The Voucher Type Alteration screen appears as sh

 

14.6 Delete Voucher Types in Tally Prime:

You may want to delete Voucher Types in Tally Prime.

Such a need occurs in the following scenarios:

• Created a Voucher Type long ago, and you haven't used it.

• Created a Voucher Type, which is simil

• The Voucher Type was created by mistake.
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defined Voucher Type: 
defined voucher types in Tally Prime can be altered to suit invoicing requirements. 

• Gateway of Tally > Alter > type or select Voucher Type > Sales. 

Alternatively, Alt + G (Go To) > type or select Alter Master > Voucher Type > Sales.

• The Voucher Type Alteration screen appears as shown below: 

Delete Voucher Types in Tally Prime: 

You may want to delete Voucher Types in Tally Prime. 

Such a need occurs in the following scenarios: 

• Created a Voucher Type long ago, and you haven't used it. 

• Created a Voucher Type, which is similar to an already existing Voucher type. 

• The Voucher Type was created by mistake. 

Nagarjuna University 

Prime can be altered to suit invoicing requirements.  

Alternatively, Alt + G (Go To) > type or select Alter Master > Voucher Type > Sales. 
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• Created a new Company, which is a copy of an existing Company. However, some of the 

Voucher Types are not required in the new Company 

Although deleting a Voucher Type is very simple in Tally Prime, we can only delete it if the 

following pre-requisites are met. 

• The Voucher Type is not a default one such as Sales, Purchase, and others provided in Tally 

Prime. 

• In the Company data, there is no voucher recorded using the Voucher Type. 

• We may want to delete a Voucher Type, even if we have recorded transactions using it. In such 

a case, we will need to delete all the transactions recorded using that specific Voucher Type. 

• Before deleting transactions, take a Company data backup so that we can restore those 

transactions by restoring the Company data in the future if needed 

We can delete the transactions by drilling down on the Statistics report in Tally Prime. 

Follow the path given below: 

1. Press Alt + G (Go To) > type or select Statistics and press Enter. Alternatively, Gateway of 

Tally > Display More Reports > Statements of Accounts > Statistics and press Enter. 

2. Drilldown to the transactions. 

• Drilldown on the required Voucher Type. 

• The Voucher Monthly Register screen appears. 

• Drilldown on the months in which the transactions were recorded. 

• The Voucher Register screen appears where all the transactions for the month are listed. 

Select all the transactions using Spacebar and press Alt + D. 

Now that we have ensured that there are no transactions recorded using the Voucher Type, we 

can go ahead and delete the Voucher Type. 

To delete a Voucher Type in Tally Prime, follow the procedure given below 

1. Press Alt + G (Go To) > Voucher Type > type or select the Voucher Type and press Enter. 

Alternatively, Gateway of Tally > Alter > Voucher Type > type or select the Voucher Type and 

press Enter.  

2. Press Alt + D and then press Y to accept. 

14.7 Keywords: 

1. Sales Vouchers: Used for recording sales transactions and sales returns. 

2. Purchase Vouchers: Used for recording purchase transactions and purchase returns. 

14.8 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K.  Nadhani 

2. "Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 
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Lesson - 15 

VOUCHERS WITHOUT TAX 

 
Objective: 

1. Understanding Non-Tax Vouchers: Explain the concept and use of non-tax vouchers in 

accounting. 

2. Types of Non-Tax Vouchers: Identify different types of non-tax vouchers and their purposes. 

3. Creation Process: Detail the process of creating non-tax vouchers in Tally Prime. 

4. Record Keeping: Discuss the importance of maintaining accurate records of non-tax vouchers. 

5. Impact on Financial Statements: Explain how non-tax vouchers affect financial statements and 

reporting. 

 

Structure: 

15.1 Introduction to Purchase bill without GST 

15.2 Introduction to Sale bill without GST 

15.3 Keywords 

15.4 Reference 

 

15.1 Introduction to Purchase bill without GST: 

Purchase is the cost incurred by the business concern during a period, for further sale of 

inventory. Purchase is an expense to the company. It is included in the income statement and is 

also considered under the cost of goods sold. 

 

In Accounting, the purpose and type of purchases is important. Purchase of fixed assets for own 

consumption will be accounted as foxed assets and shown in balance sheet, while purchases 

made for further sale will be accounted as expenses.  

 

In Tally Prime, A Purchase voucher is used to record transactions, when a company purchases 

some goods on cash, cheque or on credit basis. A purchases voucher can be recorded in following 

three modes: 

 

1. Voucher Mode 

2. Item Invoice Mode 

3. Account Invoice Mode 

 

Recording a Purchase Bill in Tally Prime (Without GST) 

Here's a step-by-step guide on how to record a purchase bill in Tally Prime without GST: 

Step 1: Open Tally Prime and Select the Company 

1. Open Tally Prime. 

2. Select the company for which you want to record the purchase bill. 
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 Step 2: Configure Purchase Voucher

1. Go to Gateway of Tally. 

2. Navigate to F11: Features 

3. Select Accounting Features 

4. Ensure that the options Use Purchase Order Processing and Use Tracking Numbers 

(Delivery/Receipt Notes) are set to No unless required for your specific needs.

 

Step 3: Record the Purchase Vouche

1. Go to Gateway of Tally. 

2. Navigate to Vouchers. 

3. Select F9: Purchase This opens the Purchase Voucher screen.

 

 

Step 4: Enter Purchase Details 

1. Date: Enter the date of the purchase transaction.

2. Party A/c Name: Select the supplier’s account fro

is not already in the system, create a new ledger under the group `Sundry Creditors`.

15.2  Software Solutions to Accounting

Step 2: Configure Purchase Voucher 

4. Ensure that the options Use Purchase Order Processing and Use Tracking Numbers 

(Delivery/Receipt Notes) are set to No unless required for your specific needs. 

Step 3: Record the Purchase Voucher 

This opens the Purchase Voucher screen. 

 

Enter the date of the purchase transaction. 

Select the supplier’s account from the list of ledger accounts. If the supplier 

is not already in the system, create a new ledger under the group `Sundry Creditors`.

Software Solutions to Accounting 

 

4. Ensure that the options Use Purchase Order Processing and Use Tracking Numbers 

m the list of ledger accounts. If the supplier 

is not already in the system, create a new ledger under the group `Sundry Creditors`. 
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3. Purchase Ledger: Select the purchase ledger. If there is no specific ledger, you can use a 

general `Purchases` ledger under the group `Purchase Accounts`.

4. Invoice Details: Fill in the invoice number and other details as needed.

 

 

Step 5: Enter Item Details 

1. Name of Item: Select the item being purchased. If the item is not already in the system, create 

a new stock item. 

2. Quantity: Enter the quantity of the item.

3. Rate: Enter the rate per unit of the item.

4. Amount: Tally Prime will automatically calculate the total amount (Quantity x Rate).

 

 

Step 6: Complete and Save the Voucher
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Select the purchase ledger. If there is no specific ledger, you can use a 

der the group `Purchase Accounts`. 

Fill in the invoice number and other details as needed. 

: Select the item being purchased. If the item is not already in the system, create 

Enter the quantity of the item. 

Enter the rate per unit of the item. 

Tally Prime will automatically calculate the total amount (Quantity x Rate).

Step 6: Complete and Save the Voucher 
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Select the purchase ledger. If there is no specific ledger, you can use a 

 

: Select the item being purchased. If the item is not already in the system, create 

Tally Prime will automatically calculate the total amount (Quantity x Rate). 
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1. Narration: Enter any additional details or notes about the transaction.

2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the voucher.

 

 

 

 

Example 01: 

Example 02: 

15.4  Software Solutions to Accounting

additional details or notes about the transaction. 

2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the voucher.

Software Solutions to Accounting 

2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the voucher. 
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In the screenshot: 

1. Header Section: Shows the type of voucher (Purchase), d

2. Party Details: Where you select the supplier.

3. Item Details Section: Where you enter the stock item, quantity, rate, and amount.

4. Bottom Section: Where you can add narration and save the voucher.

 

Note: Screenshots and actual screens may vary slightly based on your Tally Prime version and 

configurations. 

This process helps ensure that all purchase transactions are accurately recorded, keeping your 

financial data organized and up-to

 

 

15.2 Introduction to Sale bill without GST:

A Sales voucher is used when a company sells goods to customers on cash, cheque or credit 

basis. Sales entries lead to an increase in sales revenue.

 

Here's a step-by-step guide on how to record a sales bill in Tally Prime without GST:

 

Step 1: Open Tally Prime and Select the Company

1. Open Tally Prime. 

2. Select the company for which you want to record the sales bill.
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1. Header Section: Shows the type of voucher (Purchase), date, and voucher number.

2. Party Details: Where you select the supplier. 

3. Item Details Section: Where you enter the stock item, quantity, rate, and amount.

4. Bottom Section: Where you can add narration and save the voucher. 

l screens may vary slightly based on your Tally Prime version and 

This process helps ensure that all purchase transactions are accurately recorded, keeping your 

to-date. 

without GST: 

A Sales voucher is used when a company sells goods to customers on cash, cheque or credit 

basis. Sales entries lead to an increase in sales revenue. 

step guide on how to record a sales bill in Tally Prime without GST:

: Open Tally Prime and Select the Company 

for which you want to record the sales bill. 
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ate, and voucher number. 

3. Item Details Section: Where you enter the stock item, quantity, rate, and amount. 

l screens may vary slightly based on your Tally Prime version and 

This process helps ensure that all purchase transactions are accurately recorded, keeping your 

A Sales voucher is used when a company sells goods to customers on cash, cheque or credit 

step guide on how to record a sales bill in Tally Prime without GST: 
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Step 2: Configure Sales Voucher

1. Go to Gateway of Tally. 

2. Navigate to `F11: Features`. 

3. Select `Accounting Features`. 

4. Ensure that the options Use Invoice Mode and Integrate Accounts and Inventory` are set to 

`Yes`. This will allow you to enter sales details in an itemized format and link inventory with 

accounting. 

 

Step 3: Record the Sales Voucher

1. Go to Gateway of Tally. 

2. Navigate to `Vouchers`. 

3. Select `F8: Sales`. This opens the Sales Voucher screen.

 

Step 4: Enter Sales Details 

1. Date: Enter the date of the sales transaction.

15.6  Software Solutions to Accounting

Step 2: Configure Sales Voucher 

 

4. Ensure that the options Use Invoice Mode and Integrate Accounts and Inventory` are set to 

`Yes`. This will allow you to enter sales details in an itemized format and link inventory with 

Step 3: Record the Sales Voucher 

3. Select `F8: Sales`. This opens the Sales Voucher screen. 

Enter the date of the sales transaction. 
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4. Ensure that the options Use Invoice Mode and Integrate Accounts and Inventory` are set to 

`Yes`. This will allow you to enter sales details in an itemized format and link inventory with 
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2. Party A/c Name: Select the customer’s account from the list of ledger 

customer is not already in the system, create a new ledger under the group `Sundry Debtors`.

3. Sales Ledger: Select the sales ledger. If there is no specific ledger, you can use a general 

`Sales` ledger under the group `Sales Accounts`.

4.Invoice Details: Fill in the invoice number and other details as needed.

 

 

Step 5: Enter Item Details 

1. Name of Item: Select the item being sold. If the item is not already in the system, create a 

new stock item. 

2. Quantity: Enter the quantity of the item.

3. Rate: Enter the rate per unit of the item.

4. Amount: Tally Prime will automatically calculate the total amount (Quantity x Rate).
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: Select the customer’s account from the list of ledger accounts. If the 

customer is not already in the system, create a new ledger under the group `Sundry Debtors`.

Select the sales ledger. If there is no specific ledger, you can use a general 

`Sales` ledger under the group `Sales Accounts`. 

Fill in the invoice number and other details as needed. 

Select the item being sold. If the item is not already in the system, create a 

Enter the quantity of the item. 

: Enter the rate per unit of the item. 

Tally Prime will automatically calculate the total amount (Quantity x Rate).
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accounts. If the 

customer is not already in the system, create a new ledger under the group `Sundry Debtors`. 

Select the sales ledger. If there is no specific ledger, you can use a general 

 

Select the item being sold. If the item is not already in the system, create a 

Tally Prime will automatically calculate the total amount (Quantity x Rate). 
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Step 6: Complete and Save the Voucher

1. Narration: Enter any additional details or no

2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the voucher.

 

Example 01: 

 

 

 

 

Example 02: 
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Step 6: Complete and Save the Voucher 

1. Narration: Enter any additional details or notes about the transaction. 

2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the voucher.
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2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the voucher. 
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 Sample Screenshot Explanation:

Since I can't provide an actual screenshot, you can visualize the fol

Sales Voucher screen: 

 

- Sales Voucher Screen: 

    - Date: 02-06-2024 

    - Party A/c Name: XYZ Enterprises

    - Sales Ledger: Sales 

    - Item Details: 

        - Name of Item: Stationery 

        - Quantity: 5 

        - Rate:10/- 

        - Amount:50/- 

    - Narration:"Sold 5 units of stationery."

 

This process helps ensure that all sales transactions are accurately recorded, keeping your 

financial data organized and up-to

Steps in Detail with Visual Aid 

1. Open Tally Prime 

- Launch Tally Prime from your desktop or application list.

- Select your company from the list of companies available.

 

2. Configure Sales Voucher 

- Go to Gateway of Tally 

- Navigate to `F11: Features`. 

- Select `Accounting Features`. 

  - Ensure the following options are set correctly:

    - `Use Invoice Mode`: Yes 

    - `Integrate Accounts and Inventory`: Yes

 

3. Record the Sales Voucher 

- Go to Gateway of Tally. 

- Navigate to `Vouchers`. 

- Select `F8: Sales` to open the Sales Voucher 
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Sample Screenshot Explanation: 

Since I can't provide an actual screenshot, you can visualize the following setup in Tally Prime's 

Party A/c Name: XYZ Enterprises 

 

Narration:"Sold 5 units of stationery." 

This process helps ensure that all sales transactions are accurately recorded, keeping your 

to-date.  

Launch Tally Prime from your desktop or application list. 

Select your company from the list of companies available. 

Ensure the following options are set correctly: 

`Integrate Accounts and Inventory`: Yes 

Select `F8: Sales` to open the Sales Voucher screen. 
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This process helps ensure that all sales transactions are accurately recorded, keeping your 
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4. Enter Sales Details 

- Date: Enter the transaction date. 

- Party A/c Name: Select or create the customer’s account (e.g., XYZ Enterprises). 

- Sales Ledger: Select or create the sales ledger (e.g., Sales). 

 

5. Enter Item Details 

- Name of Item: Select or create the item (e.g., Stationery). 

- Quantity: Enter the quantity sold (e.g., 5). 

- Rate: Enter the rate per unit (e.g., 10/-). 

- Amount: Tally Prime calculates the total automatically (e.g., 50/-). 

 

6. Complete and Save the Voucher 

- Narration: Add a brief description of the transaction (e.g., "Sold 5 units of stationery"). 

- Save the Voucher: Press `Ctrl+A` to save. 

 

15.3 Keywords: 

In Tally Prime, voucher types are essential for recording various financial transactions. Here are 

four lines of keywords related to voucher types: 

1. Sales Vouchers: Used for recording sales transactions and sales returns. 

2. Purchase Vouchers: Used for recording purchase transactions and purchase returns. 

3. How to record the transaction of purchase and sale invoice without gst. 

4. how to create a party ledger in tally prime. 

 

15.4 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K.  Nadhani 

2. "Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 

  

        M.P. Eshwera Rao 



  Lesson - 16  

INTRODUCTION TO GST 

 
Objective: 

1. Basics of Taxation: Provide an overview of the basic concepts of taxation. 

2. Types of Taxes: Identify and describe different types of taxes such as direct and indirect taxes. 

3. Tax Compliance: Discuss the importance of tax compliance for businesses and individuals. 

4. Tax Filing Process: Explain the process of filing tax returns and the necessary documentation. 

5. Impact on Accounting: Describe how taxes impact accounting practices and financial 

reporting. 

 

Structure: 

16.1 Introduction 

16.2 FEATURES OF INDIRECT TAXES 

16.3 Types of Transactions in GST 

16.4 GST Registration 

16.5 Mandatory Registration 

16.6 Types of Registration under GST 

16.7 Classification of goods and services (HSN & SAC) 

16.8 Keywords 

16.9 Reference 

 
16.1 Introduction: 

 India is a federal country where both the Central and the State Government have the 

powers to levy and collect taxes through appropriate legislation. 

 GST was introduced in India on 1st July 2017. 

 GST is a business reform, and beyond just modification of the rate of tax GST is 

changing the process of compliance, thereby resulting in a shift in the way businesses 

operate.  

 With the concept of invoice matching, instead of filing summarized returns, you will need 

to submit the details of all your sales invoices periodically, based on their criteria of filing 

returns/annexures, either monthly or quarterly. This urges every business to digitize its 

bookkeeping. 

1. A tax may be defined as a "pecuniary burden laid upon individuals or property owners to 

support the Government; a payment exacted by legislative authority.  

2. A tax "is not a voluntary payment or donation, but an enforced contribution, exacted pursuant 

to legislative authority".  

3. In simple words, tax is nothing but money that people have to pay to the Government, which 

is used to provide public services. 

 

TYPES OF TAXES: Taxes are broadly classified into direct and indirect taxes. 

1. Direct Taxes: 

a. A direct tax is a kind of charge, which is imposed directly on the taxpayer and paid directly to 

the Government by the persons (juristic or natural) on whom it is imposed. 

b. A direct tax is one that cannot be shifted by the taxpayer to someone else.  
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c. A significant direct tax imposed in India is income tax.  

 

2. Indirect Taxes: 
a. If the taxpayer is just a conduit(channel) and at every stage the tax incidence is passed on till it 

finally reaches the consumer, who really bears the brunt of it, such tax is indirect tax.  

b. An indirect tax is one that can be shifted by the taxpayer to someone else.  

c. Its incidence is borne by the consumers who ultimately consume the product or the service, 

while the immediate liability to pay the tax may fall upon another person such as a manufacturer 

or provider of service or seller of goods.  

d. Also called consumption taxes, they are regressive in nature because they are not based on the 

principle of ability to pay.  

e. All the consumers, including the economically challenged bear the brunt of the indirect taxes 

equally.  

f. Indirect taxes are levied on consumption, expenditure, privilege, or right but not on income or 

property. 

 

GOODS AND SERVICES TAX: Goods and services tax means  

a. any tax on supply of goods, or services or both  

b. except taxes on the supply of the alcoholic liquor for human consumption. 

 

16.2 FEATURES OF INDIRECT TAXES: 

a. An important source of revenue: Indirect taxes are a major source of tax revenues for 

Governments worldwide and continue to grow as more countries move to consumptionoriented 

tax regimes. In India, indirect taxes contribute more than 50% of the total tax revenues of Central 

and State Governments.  

b. Tax on commodities and services: It is levied on commodities at the time of supply or 

manufacture or purchase or sale or import/export thereof. Hence, it is also known as commodity 

taxation. It is also levied on supply of services.  

c. Shifting of burden: There is a clear shifting of tax burden in respect of indirect taxes. For 

example, GST paid by the supplier of the goods is recovered from the buyer by including the tax 

in the cost of the commodity.  

d. No perception of direct pinch: Since value of indirect taxes is generally inbuilt in the price 

of the commodity, most of the time the tax payer/consumer pays the same without actually 

knowing that he is paying tax to the Government. Thus, tax payer does not perceive a direct 

pinch while paying indirect taxes. 

e. Inflationary: Tax imposed on commodities and services causes an all-round price spiral. In 

other words, indirect taxation directly affects the prices of commodities and services and leads to 

inflationary trend.  

f. Wider tax base: Unlike direct taxes, the indirect taxes have a wide tax base. Majority of the 

products or services are subject to indirect taxes with low thresholds. 

g. Promotes social welfare: Higher taxes are imposed on the consumption of harmful products 

(also known as ‘sin goods’) such as alcoholic products, tobacco products etc. This not only 

checks their consumption but also enables the State to collect substantial revenue.  

h. Regressive in nature: Generally, the indirect taxes are regressive in nature. The rich and the 

poor have to pay the same rate of indirect taxes on certain commodities of mass consumption. 

This may further increase the income disparities between the rich and the poor. 
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16.3 Types of Transactions in GST: 

In the context of goods and services taxation in India, intra-state and inter-state transactions are 

defined based on the geographical location of the seller and buyer within the country. 

Understanding these transactions is essential for compliance with GST (Goods and Services Tax) 

regulations. 

Intra-State Transactions 

Intra-state transactions refer to transactions where the location of the supplier and the place of 

supply are in the same state or union territory. 

 

Characteristics: 

1. Same State: Both the seller and buyer are located within the same state. 

2. Tax Applicability: Intra-state transactions are subject to two types of GST: 

o CGST (Central Goods and Services Tax): Collected by the central government. 

o SGST (State Goods and Services Tax): Collected by the state government. 

 

Example: 

 Seller: Located in Maharashtra. 

 Buyer: Also located in Maharashtra. 

Taxes Levied: If the transaction amount is ₹10,000 and the applicable GST rate is 18%, then: 

 CGST: ₹900 (9% of ₹10,000) 

 SGST: ₹900 (9% of ₹10,000) 

 

Inter-State Transactions 

Inter-state transactions refer to transactions where the location of the supplier and the place of 

supply are in different states or union territories. 

Characteristics: 

1. Different States: The seller and buyer are located in different states. 

2. Tax Applicability: Inter-state transactions are subject to: 

o IGST (Integrated Goods and Services Tax): Collected by the central 

government and later shared between the central and state governments. 

Example: 

 Seller: Located in Maharashtra. 

 Buyer: Located in Gujarat. 

 Taxes Levied: If the transaction amount is ₹10,000 and the applicable GST rate is 18%, 

then: 

o IGST: ₹1,800 (18% of ₹10,000) 

 

16.4 GST Registration: 

 Under the GST taxation system, all businesses will be unified under the ‘One Tax’ 

– GST. This leads to a unified tax registration of all businesses. 

 Being registered under the GST law means a business is acknowledged by the 

Government of India, as a supplier of Goods and Services. 

 Only registered (Regular) businesses are allowed to claim Input Tax Credit. 

 GSTIN Structure 
 On registration, each business will be allocated a unique 15-digit PAN-based registration 

number. 
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16.5 Mandatory Registration: 

The following category of the person have to mandatorily register, irrespective of their turnover. 

 A person responsible to deduct TDS. 

 Casual and non-residents taxable persons. 

 Input service distributors. 

 Businessess liable to pay tax under reverse charge. 

 E-commerce operators 

 Agent supplying on behalf of taxable persons 

 A person supplying online information and database access services from outside India to 

an unregistered person in India. 

 Sellers of goods on E-Commerce platforms and threshold exemption is applicable for the 

seller of service on the e-commerce platform. 

 A Taxable person carrying on Interstate Supply. 

 

16.6 Types of Registration under GST: 

 

Regular Dealer Registration: 

 Business crossing the defined annual aggregate turnover threshold is liable to register 

under GST. The Aggregate turnover includes the value of all taxable, exempt, and export 

supplies made across India by a business with the same PAN. 

 

Composition Dealer Registration 
 Composition Scheme under GST is a simple and easy mechanism for small taxpayers, 

wherein the taxpayers have less tedious GST formalities and pay GST at a lower tax rate 

on their turnover. 

 

Tax Rate Structure 
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16.7 Classification of goods and services (HSN & SAC)

Every good or service are classified using a numbering system to identify and tax them correctly. 

For goods, HSN is used and for the services, 

a. Harmonized System of Nomenclature (HSN):

HSN code stands for "Harmonized System of Nomenclature". This system has been introduced 

for the systematic classification of goods all over the world. HSN code is a 6 to 8

code that classifies 5000+ products and is accepted worldwide. It was developed by the World 

Customs Organization (WCO) and it came into effect from 1988.

For example: The HSN for Handkerchiefs made of Textile matters is 62139010.

As a GST learner, we need to know that every product has an HSN number and are taxed based 

on HSN, hence knowing the HSN of the product is very important to ensure that the correct GST 

tax rate is applied. 

b. Services Accounting Code (SAC):
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Classification of goods and services (HSN & SAC) 

Every good or service are classified using a numbering system to identify and tax them correctly. 

For goods, HSN is used and for the services, SAC is used. Let us understand them:

a. Harmonized System of Nomenclature (HSN): 

HSN code stands for "Harmonized System of Nomenclature". This system has been introduced 

for the systematic classification of goods all over the world. HSN code is a 6 to 8

code that classifies 5000+ products and is accepted worldwide. It was developed by the World 

Customs Organization (WCO) and it came into effect from 1988. 

For example: The HSN for Handkerchiefs made of Textile matters is 62139010. 

learner, we need to know that every product has an HSN number and are taxed based 

on HSN, hence knowing the HSN of the product is very important to ensure that the correct GST 

b. Services Accounting Code (SAC): 
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Every good or service are classified using a numbering system to identify and tax them correctly. 

SAC is used. Let us understand them: 

HSN code stands for "Harmonized System of Nomenclature". This system has been introduced 

for the systematic classification of goods all over the world. HSN code is a 6 to 8-digit uniform 

code that classifies 5000+ products and is accepted worldwide. It was developed by the World 

 

learner, we need to know that every product has an HSN number and are taxed based 

on HSN, hence knowing the HSN of the product is very important to ensure that the correct GST 
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Like goods, services are also classified uniformly for recognition, measurement and taxation. 

Codes for services are called Services Accounting Code or SAC. 

For example: Legal documentation and certification services concerning patents, copyrights and 

other intellectual property rights: 998213 

• The first two digits are same for all services i.e. 99 

• The next two digits (82) represent the major nature of service, in this case, legal services 

The last two digits (13) represent detailed nature of service ie legal documentation for patents 

etc., 

Important note: 

The Turnover check needs to be done on all India basis for each PAN, which means that the total 

turnover across the country under the same business PAN i.e. for one legal entity (Company, 

Firm, sole proprietorship etc.) needs to added and checked if that crosses the turnover threshold. 

Turnover limits for Regular Registration: 

a. For Supplier of 'Goods' or 'Services': 

• Threshold Limit - Rs. 10 Lakhs (Manipur, Mizoram, Nagaland, Tripura) 

• Threshold Limit - Rs. 20 Lakhs (Arunachal Pradesh, Meghalaya, Sikkim, Uttarakhand, 

Puducherry, Telangana) 

b. For Supplier of 'Services' or 'Both Goods & Services': 

• Threshold Limit - Rs. 20 Lakhs (J&K, Assam, Himachal Pradesh, All otherstates) 

c. For Supplier of 'Goods' only: 

• Threshold Limit - Rs. 40 Lakhs (J&K, Assam, Himachal Pradesh, All Other States) 

States with threshold limit of 

10 Lakhs for Supplier of 

Goods and/or Services 

States/UTs with threshold 

limit of 20 Lakhs for 

Supplier of Goods and/or 

Services  

States/UTs with threshold limit of 

20 Lakhs for Supplier of Services/ 

both of goods and Services and 40 

Lakhs for Supplier of Goods (intra 

state) 

Manipur 

Mizoram 

Nagaland 

Tripura 

Arunachal Pradesh 

Meghalaya 

Sikkim 

Uttarakhand 

Puducherry 

Telangana 

Jammu & Kashmir 

Assam 

Himachal Pradesh 

All other states 

 

 

16.8 Keywords: 

1. GST Configuration Enable GST in Tally Prime to manage and track tax transactions. 

2. Tax Ledgers Create and categorize GST tax ledgers for accurate accounting. 

3. Invoicing: Generate GST-compliant invoices with automated tax calculations. 

4.Returns Filing: Simplify GST return filings with integrated reports and data validation. 

 

16.9 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K.Nadhani 

2. "Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 
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    INVOICES WITH  INTRA STATE TRANSACTION

Objective: 

1. Understanding Intra State Transactions: Define intra

GST. 

2. Creating Intra State Invoices: Detail the process of creating invoices for 

in Tally Prime. 

3. GST Calculation: Explain how GST is calculated and applied on intra

4. Compliance and Reporting: Discuss the compliance requirements for intra

GST. 

5. Integration with ITC: Illustrate how intra

claims. 

 

Structure: 

17.1 Introduction to Purchases Voucher in Tally Prime

17.2 Introduction to Sale Voucher with GST

17.3 Keywords 

17.4 Reference 

 

17.1 Introduction to Purchases Voucher

Recording a purchase bill in Tally Prime with GST involves several steps, including configuring 

GST details, creating necessary ledgers, and entering the purchase details in the purchase 

voucher. Here’s a detailed step-by

process. 

 

Step-by-Step Guide to Record a Purchase Bill with GST in Tally Prime

 

Step 1: Open Tally Prime and Select the Company

1. Open Tally Prime. 

2. Select the company for which you want to record the purchase bi

Step 2: Enable GST Features 
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1. Understanding Intra State Transactions: Define intra-state transactions and their significance in 

2. Creating Intra State Invoices: Detail the process of creating invoices for intra-

3. GST Calculation: Explain how GST is calculated and applied on intra-state invoices.

4. Compliance and Reporting: Discuss the compliance requirements for intra-state invoices under 

lustrate how intra-state invoices are integrated with Input Tax Credit 

17.1 Introduction to Purchases Voucher in Tally Prime 

17.2 Introduction to Sale Voucher with GST 

Introduction to Purchases Voucher in Tally Prime: 

Recording a purchase bill in Tally Prime with GST involves several steps, including configuring 

GST details, creating necessary ledgers, and entering the purchase details in the purchase 

by-step guide along with an explanation for each part of the 

Step Guide to Record a Purchase Bill with GST in Tally Prime 

Step 1: Open Tally Prime and Select the Company 

2. Select the company for which you want to record the purchase bill. 

INVOICES WITH  INTRA STATE TRANSACTION 

state transactions and their significance in 

state transactions 

state invoices. 

state invoices under 

state invoices are integrated with Input Tax Credit 

Recording a purchase bill in Tally Prime with GST involves several steps, including configuring 

GST details, creating necessary ledgers, and entering the purchase details in the purchase 

with an explanation for each part of the 
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1. Go to Gateway of Tally. 

2. Navigate to `F11: Features`. 

3. Select  Statutory & Taxation`. 

4. Enable `Goods and Services Tax (GST)` by setting it to `Yes`.

5. Enter the required GST details, such as GSTIN, applicable 

applicable (CGST, SGST, IGST).

 

Step 3: Create Necessary Ledgers

1. Create Supplier Ledger: 

   - Go to Gateway of Tally > Accounts Info > Ledgers > Create.

   - Name: Enter the supplier's name (e.g., ABC Supplies).

   - Under: Sundry Creditors. 

   - Maintain balances bill-by-bill: Yes.

   - GSTIN: Enter the supplier's GSTIN.

   - Set/alter GST details: Yes, then fill in the applicable GST details.

 

2. Create Purchase Ledger: 

   -Go to Gateway of Tally > Accounts Info > Ledger
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4. Enable `Goods and Services Tax (GST)` by setting it to `Yes`. 

5. Enter the required GST details, such as GSTIN, applicable state, and the types of GST 

applicable (CGST, SGST, IGST). 

Step 3: Create Necessary Ledgers 

Gateway of Tally > Accounts Info > Ledgers > Create. 

Name: Enter the supplier's name (e.g., ABC Supplies). 

bill: Yes. 

GSTIN: Enter the supplier's GSTIN. 

Set/alter GST details: Yes, then fill in the applicable GST details. 

 

Go to Gateway of Tally > Accounts Info > Ledgers > Create. 
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state, and the types of GST 
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   - Name: Purchases. 

   - Under: Purchase Accounts. 

   - Type of Ledger: Not applicable (since it’s a general purchase ledger).

   - Set/alter GST details: Yes, then select `Goods` as the type of supply and fill in the necessary 

GST rates (e.g., 18%). 

3. Create Input CGST Ledger 

   - Go to Gateway of Tally > Accounts Info > Ledgers > Create.

   - Name: Input CGST. 

   - Under: Duties & Taxes. 

   - Type of Duty/Tax: GST. 

   - GST Tax Type: Central Tax (CGST).

   - Percentage of Calculation: Enter the applicable rate (e.g., 0%).

4. Create Input SGST Ledger 

   - Go to Gateway of Tally > Accounts Info > Ledgers > Create.

   - Name: Input SGST. 

   - Under: Duties & Taxes. 

   - Type of Duty/Tax: GST. 

   - GST Tax Type: State Tax (SGST).

   - Percentage of Calculation: Enter the applicable rate (e.g., 0%).

17.3 Acharya Nagarjuna University

Type of Ledger: Not applicable (since it’s a general purchase ledger). 

Set/alter GST details: Yes, then select `Goods` as the type of supply and fill in the necessary 

 

Go to Gateway of Tally > Accounts Info > Ledgers > Create. 

GST Tax Type: Central Tax (CGST). 

Percentage of Calculation: Enter the applicable rate (e.g., 0%). 

 

Go to Gateway of Tally > Accounts Info > Ledgers > Create. 

Type: State Tax (SGST). 

Percentage of Calculation: Enter the applicable rate (e.g., 0%). 
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Set/alter GST details: Yes, then select `Goods` as the type of supply and fill in the necessary 
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5. Create Input IGST Ledger: 

   - Go to Gateway of Tally > Accounts Info > Ledgers > Create.

   - Name: Input IGST. 

   - Under: Duties & Taxes. 

   - Type of Duty/Tax: GST. 

   - GST Tax Type: Integrated Tax (IGST).

   - Percentage of Calculation: Enter the applicable rate (e.g., 0%).

 

Step 4: Record the Purchase Voucher
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Go to Gateway of Tally > Accounts Info > Ledgers > Create. 

GST Tax Type: Integrated Tax (IGST). 

Percentage of Calculation: Enter the applicable rate (e.g., 0%). 

Step 4: Record the Purchase Voucher 
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1. Go to Gateway of Tally. 

2. Navigate to `Vouchers`. 

3. Select `F9: Purchase`. This opens t

 

Step 5: Enter Purchase Details 

1. Date: Enter the date of the purchase transaction.

2. Party A/c Name: Select the supplier’s account (e.g., ABC Supplies).

3. Purchase Ledger: Select the purchase ledger (e.g., Purchases).

 

4. Name of Item: Select the item being purchased. If the item is not already in the system, create 

a new stock item. While, at the time of creation of item enter the HSN Code of such Product (or) 

SAC Code for such Services to be rendered by the Consumer fr

5. Quantity: Enter the quantity of the item.

6. Rate: Enter the rate per unit of the item.

7. Amount: Tally Prime will automatically calculate the total amount (Quantity x Rate).
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3. Select `F9: Purchase`. This opens the Purchase Voucher screen. 

 

1. Date: Enter the date of the purchase transaction. 

2. Party A/c Name: Select the supplier’s account (e.g., ABC Supplies). 

3. Purchase Ledger: Select the purchase ledger (e.g., Purchases). 

4. Name of Item: Select the item being purchased. If the item is not already in the system, create 

a new stock item. While, at the time of creation of item enter the HSN Code of such Product (or) 

SAC Code for such Services to be rendered by the Consumer from the supplier. 

5. Quantity: Enter the quantity of the item. 

6. Rate: Enter the rate per unit of the item. 

7. Amount: Tally Prime will automatically calculate the total amount (Quantity x Rate).
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4. Name of Item: Select the item being purchased. If the item is not already in the system, create 

a new stock item. While, at the time of creation of item enter the HSN Code of such Product (or) 

 

7. Amount: Tally Prime will automatically calculate the total amount (Quantity x Rate). 
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Step 6: Enter GST Details 

1. Input CGST: Select the Input CGST ledger.

2. Input SGST: Select the Input SGST ledger.

3. Input IGST: Select the Input IGST ledger (if applicable).

4.Amount: Tally Prime will automatically calculate the GST amounts based on the purchase 

value. 

 

Step 7: Complete and Save the Voucher

1. Narration: Enter any additional details or notes about the transaction.

2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the voucher.
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CGST ledger. 

2. Input SGST: Select the Input SGST ledger. 

3. Input IGST: Select the Input IGST ledger (if applicable). 

4.Amount: Tally Prime will automatically calculate the GST amounts based on the purchase 

Step 7: Complete and Save the Voucher 

1. Narration: Enter any additional details or notes about the transaction. 

2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the voucher.
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4.Amount: Tally Prime will automatically calculate the GST amounts based on the purchase 

 

2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the voucher. 
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Example: 

Let's assume you are purchasing 10 units of an item called "Stationery" at 

supplier named "ABC Supplies" with an 18% GST rate (9% CGST and 9% SGST).

 

1. Open Purchase Voucher (`F9`).

2. Date: 02-06-2024. 

3. Party A/c Name: ABC Supplies.

4. Purchase Ledger: Purchases. 

5. Name of Item: Stationery. 

6. Quantity: 10. 

7. Rate: ₹500. 

8. Amount: Automatically calculated as 

9. Input CGST: ₹450 (9% of ₹5,000).

10.Input SGST: ₹450 (9% of ₹5,000).

11. Narration: "Purchased 10 units of stationery with GST."

 

- Header Section:  

  - Date: 08-06-2024 

  - Voucher Type: Purchase 

- Party Details:  

  - Party A/c Name: ABC Supplies

 

- Purchase Ledger:Purchases 

- Item Details Section:  

  - Name of Item: Stationery 

  - Quantity: 10 

  - Rate: ₹500 

  - Amount: ₹5,000 

 

- GST Details: 
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Let's assume you are purchasing 10 units of an item called "Stationery" at ₹500 p

supplier named "ABC Supplies" with an 18% GST rate (9% CGST and 9% SGST).

1. Open Purchase Voucher (`F9`). 

3. Party A/c Name: ABC Supplies. 

8. Amount: Automatically calculated as ₹5,000. 

₹450 (9% of ₹5,000). 

₹450 (9% of ₹5,000). 

11. Narration: "Purchased 10 units of stationery with GST." 

Party A/c Name: ABC Supplies 
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₹500 per unit from a 

supplier named "ABC Supplies" with an 18% GST rate (9% CGST and 9% SGST). 
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  - Input CGST: ₹450 (9%) 

  - Input SGST: ₹450 (9%) 

 

- Narration:Purchased 10 units of stationery with GST.

 

By following these steps, you can accurately record a purchase bill with GST in Tally Prime, 

ensuring compliance with GST regulations and maintaining organized financial recor

 

17.2 Introduction to Sale Voucher with GST:

Recording a sales bill in Tally Prime with GST involves several steps, including configuring 

GST details, creating necessary ledgers, and entering the sales details in the sales voucher. Here’s 

a detailed step-by-step guide along with an explanation for each part of the process.

 

Step-by-Step Guide to Record a Sales Bill with GST in Tally Prime

Step 1: Open Tally Prime and Select the Company

1. Open Tally Prime. 

2. Select the company for which you want to 

Step 2: Enable GST Features 

1. Go to Gateway of Tally. 

2. Navigate to `F11: Features`. 

3. Select Statutory & Taxation`. 

4. Enable `Goods and Services Tax (GST)` by setting it to `Yes`.

5. Enter the required GST details, such as GST

applicable (CGST, SGST, IGST).
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Narration:Purchased 10 units of stationery with GST. 

By following these steps, you can accurately record a purchase bill with GST in Tally Prime, 

ensuring compliance with GST regulations and maintaining organized financial recor

Introduction to Sale Voucher with GST: 

Recording a sales bill in Tally Prime with GST involves several steps, including configuring 

GST details, creating necessary ledgers, and entering the sales details in the sales voucher. Here’s 

step guide along with an explanation for each part of the process.

Step Guide to Record a Sales Bill with GST in Tally Prime 

Step 1: Open Tally Prime and Select the Company 

2. Select the company for which you want to record the sales bill. 

 

4. Enable `Goods and Services Tax (GST)` by setting it to `Yes`. 

5. Enter the required GST details, such as GSTIN, applicable state, and the types of GST 

applicable (CGST, SGST, IGST). 

Software Solutions to Accounting 

By following these steps, you can accurately record a purchase bill with GST in Tally Prime, 

ensuring compliance with GST regulations and maintaining organized financial records. 

Recording a sales bill in Tally Prime with GST involves several steps, including configuring 

GST details, creating necessary ledgers, and entering the sales details in the sales voucher. Here’s 

step guide along with an explanation for each part of the process. 

 

IN, applicable state, and the types of GST 
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Step 3: Create Necessary Ledgers

1. Create Customer Ledger: 

   - Go to Gateway of Tally > Accounts Info > Ledgers > Create.

   - Name: Enter the customer's name (e.g., XYZ Enterpr

   - Under: Sundry Debtors. 

   - Maintain balances bill-by-bill: Yes.

   - GSTIN: Enter the customer's GSTIN.

   - Set/alter GST details: Yes, then fill in the applicable GST details.

2. Create Sales Ledger: 
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Step 3: Create Necessary Ledgers 

Go to Gateway of Tally > Accounts Info > Ledgers > Create. 

Name: Enter the customer's name (e.g., XYZ Enterprises). 

bill: Yes. 

GSTIN: Enter the customer's GSTIN. 

Set/alter GST details: Yes, then fill in the applicable GST details. 
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   - Go to Gateway of Tally > Accounts Info > Ledgers > Create.

   - Name: Sales. 

   - Under: Sales Accounts. 

   - Type of Ledger: Not applicable (since it’s a general sales ledger).

   - Set/alter GST details: Yes, then select `Goods` or `Services` as the type of supply and fill in 

the necessary GST rates (e.g., 0%).

 

3. Create Output CGST Ledger:

   - Go to Gateway of Tally > Accounts Info > Ledgers > Create.

   - Name: Output CGST. 

   - Under: Duties & Taxes. 

   - Type of Duty/Tax: GST. 

   - GST Tax Type: Central Tax (CGST).

   - Percentage of Calculation: Enter the applicable rate (e.g., 0%).
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Accounts Info > Ledgers > Create. 

Type of Ledger: Not applicable (since it’s a general sales ledger). 

Set/alter GST details: Yes, then select `Goods` or `Services` as the type of supply and fill in 

he necessary GST rates (e.g., 0%). 

Create Output CGST Ledger: 

Go to Gateway of Tally > Accounts Info > Ledgers > Create. 

GST Tax Type: Central Tax (CGST). 

Percentage of Calculation: Enter the applicable rate (e.g., 0%). 

Software Solutions to Accounting 

Set/alter GST details: Yes, then select `Goods` or `Services` as the type of supply and fill in 
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4. Create Output SGST Ledger:

   - Go to Gateway of Tally > Accounts Info > Ledgers > Create.

   - Name: Output SGST. 

   - Under: Duties & Taxes. 

   - Type of Duty/Tax: GST. 

   - GST Tax Type: State Tax (SGST).

   - Percentage of Calculation: Enter the applicable rate (e.g., 0%).

 

5. Create Output IGST Ledger:

   - Go to Gateway of Tally > Accounts Info > Ledgers > Create.

   - Name: Output IGST. 

   - Under: Duties & Taxes. 

   - Type of Duty/Tax: GST. 

   - GST Tax Type: Integrated Tax (IGST).

   - Percentage of Calculation: Enter the applicable rate (e.g., 0%).

 

Step 4: Record the Sales Voucher

1. Go to Gateway of Tally. 
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4. Create Output SGST Ledger: 

Go to Gateway of Tally > Accounts Info > Ledgers > Create. 

Tax Type: State Tax (SGST). 

Percentage of Calculation: Enter the applicable rate (e.g., 0%). 

5. Create Output IGST Ledger: 

Go to Gateway of Tally > Accounts Info > Ledgers > Create. 

GST Tax Type: Integrated Tax (IGST). 

Percentage of Calculation: Enter the applicable rate (e.g., 0%). 

Step 4: Record the Sales Voucher 
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2. Navigate to `Vouchers`. 

3. Select `F8: Sales`. This opens 

 

Step 5: Enter Sales Details 

1. Date: Enter the date of the sales transaction.

2. Party A/c Name: Select the customer’s account (e.g., XYZ Enterprises).

3. Sales Ledger: Select the sales ledger (e.g., Sales).

 

4. Name of Item: Select the item being sold. If the item is not already in the system, create a new 

stock item. At the time of purchases then only item shall be created so we can use the existing 

item only. And along that at the time of

Creation itself the HSN Code of suc

GST Rate for such Item shall be entered Mandatory.

 

5. Quantity: Enter the quantity of the item.
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3. Select `F8: Sales`. This opens the Sales Voucher screen. 

1. Date: Enter the date of the sales transaction. 

2. Party A/c Name: Select the customer’s account (e.g., XYZ Enterprises). 

3. Sales Ledger: Select the sales ledger (e.g., Sales). 

Select the item being sold. If the item is not already in the system, create a new 

stock item. At the time of purchases then only item shall be created so we can use the existing 

item only. And along that at the time of 

Creation itself the HSN Code of such Product or SAC Code of Such Services and also enter the 

GST Rate for such Item shall be entered Mandatory. 

5. Quantity: Enter the quantity of the item. 

Software Solutions to Accounting 

 

 

Select the item being sold. If the item is not already in the system, create a new 

stock item. At the time of purchases then only item shall be created so we can use the existing 

h Product or SAC Code of Such Services and also enter the 
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6. Rate: Enter the rate per unit of the item.

7. Amount: Tally Prime will automatically calculate the

 

Step 6: Enter GST Details 

1. Output CGST: Select the Output CGST ledger.

2. Output SGST: Select the Output SGST ledger.

3. Output IGST: Select the Output IGST ledger (if applicable).

4. Amount: Tally Prime will automatic

 

 

Step 7: Complete and Save the Voucher

1. Narration: Enter any additional details or notes about the transaction.

2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the 

enter key upto the end then also it shall be save
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6. Rate: Enter the rate per unit of the item. 

7. Amount: Tally Prime will automatically calculate the total amount (Quantity x Rate).

1. Output CGST: Select the Output CGST ledger. 

2. Output SGST: Select the Output SGST ledger. 

3. Output IGST: Select the Output IGST ledger (if applicable). 

4. Amount: Tally Prime will automatically calculate the GST amounts based on the sales value.

Step 7: Complete and Save the Voucher 

1. Narration: Enter any additional details or notes about the transaction. 

2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the voucher (or) Press 

enter key upto the end then also it shall be save 
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total amount (Quantity x Rate). 

 

ally calculate the GST amounts based on the sales value. 

 

voucher (or) Press 
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Example: 

Let's assume you are selling 5 units of an item called "Stationery" at 

customer named "XYZ Enterprises" with an 18% GST rate (9% CGST and 9% SGST).

 

1. Open Sales Voucher (`F8`). 

2. Date: 01-06-2024. 

3. Party A/c Name: XYZ Enterprises.

4. Sales Ledger: Sales. 

5. Name of Item: Stationery. 

6. Quantity: 5. 

7. Rate: ₹1,000. 

8. Amount: Automatically calculated as 

9. Output CGST: ₹450 (9% of ₹5,000).

10. Output SGST: ₹450 (9% of ₹5,000).

11. Narration: "Sold 5 units of stationery with GST."

 

- Header Section: 

  - Date: 08-06-2024 

  - Voucher Type: Sales 

- Party Details:XYZ Enterprises 

- Sales Ledger:Sales 

- Item Details Section: 

  - Name of Item: Stationery 

  - Quantity: 5 

  - Rate: ₹1,000 

  - Amount: ₹5,000 

- GST Details: 

  - Output CGST: ₹450 (9%)&Output SGST: ₹450 (9%)

- Narration:Sold 5 units of stationery with GST.

By following these steps, you can accurately record a sales bill with GST in Tally 

ensuring compliance with GST regulations and maintaining organized financial records.
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Let's assume you are selling 5 units of an item called "Stationery" at ₹1,000 per unit to a 

customer named "XYZ Enterprises" with an 18% GST rate (9% CGST and 9% SGST).

3. Party A/c Name: XYZ Enterprises. 

8. Amount: Automatically calculated as ₹5,000. 

₹450 (9% of ₹5,000). 

₹450 (9% of ₹5,000). 

11. Narration: "Sold 5 units of stationery with GST." 

 

₹450 (9%)&Output SGST: ₹450 (9%) 

Narration:Sold 5 units of stationery with GST. 

By following these steps, you can accurately record a sales bill with GST in Tally 

ensuring compliance with GST regulations and maintaining organized financial records.

Software Solutions to Accounting 

 

₹1,000 per unit to a 

customer named "XYZ Enterprises" with an 18% GST rate (9% CGST and 9% SGST). 

By following these steps, you can accurately record a sales bill with GST in Tally Prime, 

ensuring compliance with GST regulations and maintaining organized financial records. 
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17.3 Keywords for Purchase: 

- Voucher: Purchase Invoice 

- Description: Recording purchase of goods within the state. 

- Steps: Enter supplier details, item details, and GSTIN. Verify and save. 

 

Keywords for Sale: 

- Voucher: Sales Invoice 

- Description: Documenting sale of goods within the state. 

- Steps: Input customer details, item details, and GSTIN. Validate and save. 

In Tally Prime, ensure accurate GSTIN entry for intra-state transactions to comply with GST 

norms effectively 

 

17.4 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K.  Nadhani 

2. "Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 

 

          B. Rama Rao 

 



INVOICES WITH INTER STATE TRANSACTION

Objective: 

1. Understanding Inter State Transactions: Define inter

GST. 

2. Creating Inter State Invoices: Detail the process of creating invoices for inter

in Tally Prime. 

3. IGST Calculation: Explain how Integrated GST (IGST) is calculated and applied on inter

invoices. 

4. Documentation Requirements: Highlight the necessary documentation for inter

transactions. 

5. Reporting and Compliance: Discuss the reporting and compliance requirements for inter

invoices under GST. 

 

Structure: 

18.1 Purchase Invoice with Inter State Transactions

18.2 Sale Invoice with Inter State Transactions

18.3 How to Alter and Delete a Purchase or Sales Vo

18.4 Important Notes 

18.5 Keywords 

18.6 Reference 

 

18.1 Purchase Invoice with Inter State Transactions:

Recording an inter-state purchase bill with Integrated GST (IGST) in Tally Prime involves 

configuring GST details, creating necessa

purchase voucher. Here’s a detailed step

the process. 

 

Step-by-Step Guide to Record an Inter

Step 1: Open Tally Prime and Select the Company

1. Open Tally Prime. 

2. Select the company for which you want to record the purchase bill.

 

Lesson - 18 

INVOICES WITH INTER STATE TRANSACTION

 

1. Understanding Inter State Transactions: Define inter-state transactions and their relevance in 

2. Creating Inter State Invoices: Detail the process of creating invoices for inter-state 

3. IGST Calculation: Explain how Integrated GST (IGST) is calculated and applied on inter

4. Documentation Requirements: Highlight the necessary documentation for inter

iance: Discuss the reporting and compliance requirements for inter

18.1 Purchase Invoice with Inter State Transactions 

18.2 Sale Invoice with Inter State Transactions 

18.3 How to Alter and Delete a Purchase or Sales Voucher in Tally Prime 

Purchase Invoice with Inter State Transactions: 

state purchase bill with Integrated GST (IGST) in Tally Prime involves 

configuring GST details, creating necessary ledgers, and entering the purchase details in the 

purchase voucher. Here’s a detailed step-by-step guide along with an explanation for each part of 

Step Guide to Record an Inter-State Purchase Bill with IGST in Tally Prime

Open Tally Prime and Select the Company 

2. Select the company for which you want to record the purchase bill. 

INVOICES WITH INTER STATE TRANSACTION 

state transactions and their relevance in 

state transactions 

3. IGST Calculation: Explain how Integrated GST (IGST) is calculated and applied on inter-state 

4. Documentation Requirements: Highlight the necessary documentation for inter-state 

iance: Discuss the reporting and compliance requirements for inter-state 

state purchase bill with Integrated GST (IGST) in Tally Prime involves 

ry ledgers, and entering the purchase details in the 

step guide along with an explanation for each part of 

State Purchase Bill with IGST in Tally Prime 
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Step 2: Enable GST Features 

1. Go to Gateway of Tally. 

2. Navigate to `F11: Features`. 

3. Select `Statutory & Taxation`. 

4. Enable `Goods and Services Tax (GST)` by setting it to `Yes`.

5. Enter the required GST details, such as GSTIN, applicable state, and the types of GST 

applicable (CGST, SGST, IGST).

 

 

 

Step 3: Create Necessary Ledgers

1. Create Supplier Ledger: 

   - Go to Gateway of Tally > Accounts Info > Ledgers > Create.

   - Name: Enter the supplier's name (e.g., DEF Supplies).

   - Under: Sundry Creditors. 

   - Maintain balances bill-by-bill: Yes.

   - GSTIN: Enter the supplier's GSTIN.

   - Set/alter GST details: Yes, then fill in the applicable GST details.

  - State: Gujrat 

Invoices with Inter State Transaction             18.2                      Software Solutions to Accounting

 

4. Enable `Goods and Services Tax (GST)` by setting it to `Yes`. 

5. Enter the required GST details, such as GSTIN, applicable state, and the types of GST 

applicable (CGST, SGST, IGST). 

Step 3: Create Necessary Ledgers 

o to Gateway of Tally > Accounts Info > Ledgers > Create. 

Name: Enter the supplier's name (e.g., DEF Supplies). 

bill: Yes. 

GSTIN: Enter the supplier's GSTIN. 

Yes, then fill in the applicable GST details. 

Software Solutions to Accounting 

5. Enter the required GST details, such as GSTIN, applicable state, and the types of GST 
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2. Create Purchase Ledger: 

   - Go to Gateway of Tally > Accounts Info > Ledgers > Create.

   - Name: Purchases. 

   - Under: Purchase Accounts. 

   - Type of Ledger: Not applicable (since it

   - Set/alter GST details: Yes, then select `Goods` as the type of supply and fill in the necessary 

GST rates (e.g., 0%). 

 

 

3. Create Input IGST Ledger: 

   - Go to Gateway of Tally > Accounts Info > Ledgers > Create.

   - Name: Input IGST. 

   - Under: Duties & Taxes. 

   - Type of Duty/Tax: GST. 

   - GST Tax Type: Integrated Tax (IGST).

   - Percentage of Calculation: Enter the applicable rate (e.g., 0%).

 

Step 4: Record the Purchase Voucher

1. Go to Gateway of Tally. 

18.3 Acharya Nagarjuna University

Go to Gateway of Tally > Accounts Info > Ledgers > Create. 

Type of Ledger: Not applicable (since it’s a general purchase ledger). 

Set/alter GST details: Yes, then select `Goods` as the type of supply and fill in the necessary 

 

Go to Gateway of Tally > Accounts Info > Ledgers > Create. 

GST Tax Type: Integrated Tax (IGST). 

Percentage of Calculation: Enter the applicable rate (e.g., 0%). 

Step 4: Record the Purchase Voucher 

Acharya Nagarjuna University 

Set/alter GST details: Yes, then select `Goods` as the type of supply and fill in the necessary 
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2. Navigate to `Vouchers`. 

3. Select `F9: Purchase`. This opens the Purchase Voucher screen.

 

Step 5: Enter Purchase Details 

1. Date: Enter the date of the purchase transaction.

2. Party A/c Name: Select the supplier’s account (e.g., DEF Supplies).

3. Purchase Ledger: Select the purchase ledger (e.g., Purchases).

 

 

 

4. Name of Item: Select the item being purchased. If the item is not already in the system, create 

a new stock item. 

5. Quantity: Enter the quantity of the item.

6. Rate: Enter the rate per unit of the item.

7. Amount: Tally Prime will automatically calculate the total amount (Quantity x Rate).
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3. Select `F9: Purchase`. This opens the Purchase Voucher screen. 

 

1. Date: Enter the date of the purchase transaction. 

2. Party A/c Name: Select the supplier’s account (e.g., DEF Supplies). 

urchase Ledger: Select the purchase ledger (e.g., Purchases). 

4. Name of Item: Select the item being purchased. If the item is not already in the system, create 

5. Quantity: Enter the quantity of the item. 

unit of the item. 

7. Amount: Tally Prime will automatically calculate the total amount (Quantity x Rate).

Software Solutions to Accounting 

 

 

4. Name of Item: Select the item being purchased. If the item is not already in the system, create 

7. Amount: Tally Prime will automatically calculate the total amount (Quantity x Rate). 



Centre for Distance Education 

 

 

Step 6: Enter IGST Details 

1. Input IGST: Select the Input IGST ledger.

2. Amount: Tally Prime will automatically calculate the IGST amount based

value. 

 

Step 7: Complete and Save the Voucher

1. Narration: Enter any additional details or notes about the transaction.

2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the voucher.
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1. Input IGST: Select the Input IGST ledger. 

2. Amount: Tally Prime will automatically calculate the IGST amount based on the purchase 

Step 7: Complete and Save the Voucher 

1. Narration: Enter any additional details or notes about the transaction. 

2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the voucher.

Acharya Nagarjuna University 

 

on the purchase 

 

2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the voucher. 
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Example: 

Let's assume you are purchasing 10 units of an item called "Stationery" at 

supplier named "ABC Supplies" in a different state with an 18% GST rate (IGST).

 

1. Open Purchase Voucher (`F9`).

2. Date: 01-06-2024. 

3. Party A/c Name: DEF Supplies.

4. Purchase Ledger: Purchases. 

5. Name of Item: Stationery. 

6. Quantity& Rate: 10&  ₹500 

8. Amount: Automatically calculated as 

9. Input IGST: ₹900 (18% of ₹5,000).

10. Narration: "Purchased 10 units of stationery with IGST."

 

By following these steps, you can accurately record an inter

Tally Prime, ensuring compliance with GST regulations and maintaining organized financial 

records. 

18.2 Sale Invoice with Inter State Transactions:

Recording an inter-state sales bill with I

configuring GST details, creating necessary ledgers, and entering the sales details in the sales 

voucher. Here’s a detailed step-by

process. 

 

Step-by-Step Guide to Record an Inter

 

Step 1: Open Tally Prime and Select the Company

1. Open Tally Prime. 
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u are purchasing 10 units of an item called "Stationery" at ₹500 per unit from a 

supplier named "ABC Supplies" in a different state with an 18% GST rate (IGST).

1. Open Purchase Voucher (`F9`). 

3. Party A/c Name: DEF Supplies. 

8. Amount: Automatically calculated as ₹5,000. 

₹900 (18% of ₹5,000). 

10. Narration: "Purchased 10 units of stationery with IGST." 

u can accurately record an inter-state purchase bill with IGST in 

Tally Prime, ensuring compliance with GST regulations and maintaining organized financial 

Sale Invoice with Inter State Transactions: 

state sales bill with Integrated GST (IGST) in Tally Prime involves 

configuring GST details, creating necessary ledgers, and entering the sales details in the sales 

by-step guide along with an explanation for each part of the 

p Guide to Record an Inter-State Sales Bill with IGST in Tally Prime

Step 1: Open Tally Prime and Select the Company 

Software Solutions to Accounting 

 

₹500 per unit from a 

supplier named "ABC Supplies" in a different state with an 18% GST rate (IGST). 

state purchase bill with IGST in 

Tally Prime, ensuring compliance with GST regulations and maintaining organized financial 

ntegrated GST (IGST) in Tally Prime involves 

configuring GST details, creating necessary ledgers, and entering the sales details in the sales 

step guide along with an explanation for each part of the 

State Sales Bill with IGST in Tally Prime 
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2. Select the company for which you want to record the sales bill.

 

 

Step 2: Enable GST Features 

1. Go to Gateway of Tally. 

2. Navigate to `F11: Features`. 

3. Select `Statutory & Taxation`. 

4. Enable `Goods and Services Tax (GST)` by setting it to `Yes`.

5. Enter the required GST details, such as GSTIN, applicable state, and the types of GST 

applicable (CGST, SGST, IGST).

 

 

 

Step 3: Create Necessary Ledgers

1. Create Customer Ledger: 
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2. Select the company for which you want to record the sales bill. 

 

4. Enable `Goods and Services Tax (GST)` by setting it to `Yes`. 

5. Enter the required GST details, such as GSTIN, applicable state, and the types of GST 

). 

Step 3: Create Necessary Ledgers 

Acharya Nagarjuna University 

5. Enter the required GST details, such as GSTIN, applicable state, and the types of GST 
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   - Go to Gateway of Tally > Accounts Info > Ledgers > Create.

   - Name: Enter the customer's name (e.g., XYZ Imports).

   - Under: Sundry Debtors. 

   - Maintain balances bill-by-bill: Yes.

   - GSTIN: Enter the customer's GSTIN.

   - Set/alter GST details: Yes, then fill in the applicable GST details.

    State: Bihar 

2. Create Sales Ledger: 

   - Go to Gateway of Tally > Accounts Info > Ledgers > C

   - Name: Sales. 

   - Under: Sales Accounts. 

   - Type of Ledger: Not applicable (since it’s a general sales ledger).

   - Set/alter GST details: Yes, then select `Goods` or `Services` as the type of supply and fill in 

the necessary GST rates (e.g., 0%).
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Go to Gateway of Tally > Accounts Info > Ledgers > Create. 

Name: Enter the customer's name (e.g., XYZ Imports). 

bill: Yes. 

GSTIN: Enter the customer's GSTIN. 

Set/alter GST details: Yes, then fill in the applicable GST details. 

Go to Gateway of Tally > Accounts Info > Ledgers > Create. 

Type of Ledger: Not applicable (since it’s a general sales ledger). 

Set/alter GST details: Yes, then select `Goods` or `Services` as the type of supply and fill in 

the necessary GST rates (e.g., 0%). 

Software Solutions to Accounting 

 

Set/alter GST details: Yes, then select `Goods` or `Services` as the type of supply and fill in 
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3. Create Output IGST Ledger

   - Go to Gateway of Tally > Accounts Info > Ledgers > Create.

   - Name: Output IGST. 

   - Under: Duties & Taxes. 

   - Type of Duty/Tax: GST. 

   - GST Tax Type: Integrated Tax (IGST).

   - Percentage of Calculation**: Enter the applicable rate (e.g., 0%).

 

Step 4: Record the Sales Voucher

1. Go to Gateway of Tally. 

2. Navigate to `Vouchers`. 

3. Select `F8: Sales`. This opens the Sales Voucher screen.

 

 

 

Step 5: Enter Sales Details 

1. Date: Enter the date of the sales transaction.

2. Party A/c Name: Select the customer’s account (e.g., XYZ Imports).

3. Sales Ledger: Select the sales led

18.9 Acharya Nagarjuna University

3. Create Output IGST Ledger: 

Go to Gateway of Tally > Accounts Info > Ledgers > Create. 

GST Tax Type: Integrated Tax (IGST). 

Percentage of Calculation**: Enter the applicable rate (e.g., 0%). 

Step 4: Record the Sales Voucher 

3. Select `F8: Sales`. This opens the Sales Voucher screen. 

1. Date: Enter the date of the sales transaction. 

2. Party A/c Name: Select the customer’s account (e.g., XYZ Imports). 

3. Sales Ledger: Select the sales ledger (e.g., Sales). 
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4. Name of Item: Select the item being sold. If the item is not already in the system, create a new 

stock item. 

5. Quantity: Enter the quantity of the item.

6. Rate: Enter the rate per unit of the item.

7. Amount: Tally Prime will automatically calculate the total amount (Quantity x Rate).

 

 

Step 6: Enter IGST Details 

1. Output IGST: Select the Output IGST ledger.

2. Amount: Tally Prime will automatically calculate the IGST amount based on the sales value.

 

Step 7: Complete and Save the Voucher

1.Narration: Enter any additional details or notes about the transaction.

2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the voucher.
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4. Name of Item: Select the item being sold. If the item is not already in the system, create a new 

5. Quantity: Enter the quantity of the item. 

6. Rate: Enter the rate per unit of the item. 

automatically calculate the total amount (Quantity x Rate).

1. Output IGST: Select the Output IGST ledger. 

2. Amount: Tally Prime will automatically calculate the IGST amount based on the sales value.

Save the Voucher 

1.Narration: Enter any additional details or notes about the transaction. 

2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the voucher.

Software Solutions to Accounting 

4. Name of Item: Select the item being sold. If the item is not already in the system, create a new 

automatically calculate the total amount (Quantity x Rate). 

 

2. Amount: Tally Prime will automatically calculate the IGST amount based on the sales value. 

 

2. Save the Voucher: After entering all the details, press `Ctrl+A` to save the voucher. 
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Example: 

Let's assume you are selling 10 units of an item called "Station

customer named "XYZ Enterprises" located in a different state with an 18% GST rate (IGST).

 

1. Open Sales Voucher (`F8`). 

2. Date: 08-06-2024. 

3. Party A/c Name: XYZ Enterprises.

4. Sales Ledger: Sales. 

5. Name of Item: Stationery. 

6. Quantity & Rate : 10  & ₹1,000.

7.Amount: Automatically calculated as 

8. Output IGST: ₹1,800 (18% of ₹10,000).

9. Narration: "Sold 10 units of stationery with IGST."

By following these steps, you can accurately record an inter

Prime, ensuring compliance with GST regulations and maintaining organized financial records.

 

18.3 How to Alter and Delete a Purchase or Sales Voucher in Tally Prime

In Tally Prime, you might need to alter or delete a purchase or 

update information. Here’s a detailed step

vouchers. 

 

Step-by-Step Guide to Alter a Voucher

1.Open Tally Prime and Select the Company

   - Open Tally Prime. 

   - Select the company in which the voucher you want to alter exists.

 

2. Navigate to Voucher Alteration Screen

   - Go to Gateway of Tally. 

   - Navigate to `Display` > `Day Book`** or **`Display` > `Account Books` > `Ledger`**.

   - Select the ledger account (e.g., Sund
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Let's assume you are selling 10 units of an item called "Stationery" at ₹1,000 per unit to a 

customer named "XYZ Enterprises" located in a different state with an 18% GST rate (IGST).

3. Party A/c Name: XYZ Enterprises. 

₹1,000. 

7.Amount: Automatically calculated as ₹10,000. 

₹1,800 (18% of ₹10,000). 

9. Narration: "Sold 10 units of stationery with IGST." 

By following these steps, you can accurately record an inter-state sales bill with IGST in Tally 

Prime, ensuring compliance with GST regulations and maintaining organized financial records.

How to Alter and Delete a Purchase or Sales Voucher in Tally Prime 

In Tally Prime, you might need to alter or delete a purchase or sales voucher to correct errors or 

update information. Here’s a detailed step-by-step guide on how to alter and delete these 

Step Guide to Alter a Voucher 

1.Open Tally Prime and Select the Company 

ompany in which the voucher you want to alter exists. 

Navigate to Voucher Alteration Screen 

Navigate to `Display` > `Day Book`** or **`Display` > `Account Books` > `Ledger`**.

Select the ledger account (e.g., Sundry Creditors for purchases or Sundry Debtors for sales).
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₹1,000 per unit to a 

customer named "XYZ Enterprises" located in a different state with an 18% GST rate (IGST). 

bill with IGST in Tally 

Prime, ensuring compliance with GST regulations and maintaining organized financial records. 

sales voucher to correct errors or 

step guide on how to alter and delete these 

Navigate to `Display` > `Day Book`** or **`Display` > `Account Books` > `Ledger`**. 

ry Creditors for purchases or Sundry Debtors for sales). 
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   - Find and select the voucher you want to alter by scrolling through the list or using the `F2: 

Period` option to filter by date. 

 

3. Alter the Voucher 

   - Press `Enter` on the voucher you want to alter. 

   - The voucher will open in the alteration mode. 

   - Make the necessary changes (e.g., changing the quantity, rate, or date). 

   - Save the voucher by pressing `Ctrl + A`. 

 

Example: Altering a Purchase / Sale Voucher 

1. Select the Purchase Voucher: 

   - Go to Gateway of Tally > Display > Day Book. 

   - Locate the purchase voucher you want to alter. 

 

2. Open the Voucher: 

   - Press `Enter` on the selected voucher. 

   - The voucher will open in alteration mode. 

3. Make Changes: 

   - Update the necessary fields (e.g., change the quantity from 10 to 15 units). 

   - Save the voucher by pressing `Ctrl + A`. 

 

Step-by-Step Guide to Delete a Voucher: 

1. Open Tally Prime and Select the Company 

   - Open Tally Prime. 

   - Select the company in which the voucher you want to delete exists. 

2. Navigate to Voucher Deletion Screen: 

   - Go to Gateway of Tally. 

   - Navigate to `Display` > `Day Book` or `Display` > `Account Books` > `Ledger`. 

   - Select the ledger account (e.g., Sundry Creditors for purchases or Sundry Debtors for sales). 

   - Find and select the voucher you want to delete by scrolling through the list or using the `F2: 

Period` option to filter by date. 

3. Delete the Voucher: 

   - Press `Enter` on the voucher you want to delete to open it. 

   - Press `Alt + D` to delete the voucher. 

   - Confirm the deletion by pressing `Y` when prompted. 

 

Example: Deleting a Sales / purchase Voucher 

1.Select the Sales Voucher: 

   - Go to Gateway of Tally > Display > Day Book. 

   - Locate the sales voucher you want to delete. 

 

2. Open the Voucher: 

   - Press `Enter` on the selected voucher. 

   - The voucher will open. 

 

3. Delete the Voucher: 
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   - Press `Alt + D` to delete the voucher. 

   - Confirm the deletion by pressing `Y`. 

 

18.4 Important Notes 

- Backup: Always take a backup of your company data before making significant changes like 

altering or deleting vouchers. 

- Audit Trail: Maintain an audit trail if required for compliance purposes to keep track of all 

alterations and deletions. 

 

By following these steps, you can efficiently manage alterations and deletions of purchase and 

sales vouchers in Tally Prime, ensuring your financial records remain accurate and up-to-date. 

 

18.5 Keywords: 

1. Purchase: Record inbound goods with IGST for interstate transactions. 

2. Sale: Issue invoices with IGST for goods sold across state borders. 

3. GST: Ensure accurate GST filing; reconcile Input Tax Credit (ITC). 

4. Reports: Generate GSTR-1, GSTR-3B for compliance; monitor CGST, SGST, IGST. 

These terms highlight the essential aspects of handling interstate transactions in Tally Prime, 

focusing on compliance with GST regulations and efficient reporting. 

18.6 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K.Nadhani 

2. "Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 

  

          B. Rama Rao 



 

 

Lesson - 19 

REPORTS GENERATION 
 
Objective: 

1. Importance of Reports: Explain the importance of generating reports for business analysis and 

decision-making. 

2. Types of Reports: Identify different types of reports that can be generated in Tally Prime, such as 

financial statements and inventory reports. 

3. Customization of Reports: Describe how to customize reports to meet specific business needs. 

4. Automated Reporting: Discuss the benefits of automated reporting and how to set it up in Tally Prime. 

5. Interpretation of Reports: Provide guidelines on how to interpret various reports for actionable insights. 

 

Structure: 

19.1 Introduction 

19.2 Trail Balance 

19.3 Profit And Loss Account 

19.4 Balance Sheet 

19.5 Cash Flow Analysis 

19.6 Fund Flow Analysis 

19.7 MIS Reports 

19.8 Item Wise Profitability Analysis 

19.9 Stock Query 

19.10 Daybook 

19.11 Purchases Register 

19.12 Sales Register 

19.13 Problems on Purchase & Sale Invoice 

19.14 Keywords 

19.15 Reference 

 

19.1 Introduction: 

Every business organisation is required to prepare financial reports that show the business profit 

or loss (Profit and Loss account) and financial position of the company (Balance Sheet) at the 

end of a financial period. 

In this Chapter Introduction to Tally, you were introduced to the Trading Account, Profit and 

Loss Account and balance sheet  

The focus will be on how to View and Generate there Reports in Tally. 

Why does every Organisation need to generate Financial Reports ? 
 Track the financial performance regularly 

 To make key decisions about the company’s future and essential for the capital 

providers and Investors  

 To know about the profitability and financial stability of the company   

 

19.2 Trail Balance: 

The Tally comes with a diverse set of available Financial and MIS Reports with powerful and 

actionable insights.  

It helps you to make informed decisions for your business growth.  

Reports will help you manage all the aspects better with extremely easy discovery. and 

navigation  



Reports Generation 19.2  Software Solutions to Accounting 

 

 

What is Trail Balance?  
 A statement showing the balance or total of debit and Credits.  

 It helps in the preparation of financial statements. 

 The balance of various accounts are listed in a statements. 

 All revenue and expense accounts appearing in the Trail Balance are transferred      

to the trading and Profit and Loss accounts. 

 Navigation path:From Gateway of Tally > Display More Reports > Trial Balance 

 To view the Trial Balance in the detailed format press Alt+F5:Detailed 

 To view only the ledger wise trial balance, click on F5: Ledger wise  

 In Trial  Balance in the Monthly view click F6: Monthly  

Hence the monthly summary report is automated based on the transactions recorded in 

each month.  

Further , you can enter on enter on each month to view the Trail Balance for every month. 

 

19.3 Profit And Loss Account: 

 It is a periodic statement  

 Shows the net result of a business operations for a specific period  

 All the expenses incurred, and incomes earned during the reporting period are recorded  

Profit and Loss Account in Tally  
 Display the information based on the default primary groups  

 Update instantly with every transactions / Voucher 

 Navigation Path: From Gateway of Tally >Profit & Loss A/c 

 

Once after generating the Profit & Loss A/c the following activity can be done. 
 To view Profit & Loss A/c in the detailed format Press Alt+F5:Detailed.   

 To View Profit & Loss A/c in the Vertical & Horizontal format Press Ctrl+H: 

Change view . 
 We can view the Negative ledger from the report by pressing Ctrl+J :Exception 

Report. 
 We can change the date in Profit & Loss account using F2:Period option.  

 In Profit & Loss A/c we can use F12:Configure option and set the required 

parameters in Tally. 

 You can observe that in the Vertical view of Profit & Loss A/c, the statement gets split 

into two- Trading Account with the Gross Profit, and Income Statement with the Nett 

Profit. 

 

19.4 Balance Sheet: 

A Balance sheet is a financial statement that reports a business financial position on a specific 

date. 

If  you observe the term balance sheet implies that the report shows the balance between two 

figures: the assets and liablities of a business. 

 

The fundamental accounting equation is Assets: 

Liability + Owner’s Equity 

Navigation Path: From Gateway of Tally > Balance Sheet 
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19.5 Cash Flow Analysis: 

 Records the amount in cash and cash equivalents entering and leaving a Company  

 It completes the Balance sheet and Profit and Loss account  

 It helps to understand how or from where the company’s money is coming and where it is 

spent  

 Shows only the actual cash inflows and outflows of a company  

 Navigation Path: From Gateway of Tally > Display More Reports > Cash Flow>Enter on 

April  

19.6 Fund Flow Analysis: 

A Fund Flow statement is a report, which explains the movement of funds during an accounting 

period. 

The statement consists of Two Parts  
 Source of Funds: The transactions which increase working capital  

 Application of Funds: The transactions which decrease working capital Application of 

funds  

 It is supplement to the two principle financial statements 

 It describes the source from which additional funds were derived and which funds were 

used.  

Navigation Path: From Gateway of Tally > Display More Reports > Fund Flow>Enter on April  

 

19.7 MIS Reports: 

We can generate MIS reports and print from Tally Prime. Reports like Stock Summary, Day 

Book, Cash Book, Bank Book, Sales Register, Purchase Register, Journal Register can be easily 

generated and explore the different options in Tally Prime. 

 

Stock Summary Analysis: 

Inventory is a crucial process; it helps the organisation track the details of inventories. 

Instant delivery of this information will help an organisation to make the business decision faster 

. 

In Tally Inventory Operates as mentioned below: 
 In Tally, reports can be displayed, modified and print 

 Based on the vouchers entered, inventory reports are gets generated in Tally  

 Customized reports can be used to compare inventory data between different companies, 

periods of the financial year  

 A Stock Summary is a statement of the stock-in-hand on a date. It is one of the primary 

inventory statement that is generated  in Tally.  

 This report updates the stock record in real-time as and when transactions are entered. 

Navigation Path: From Gateway of Tally > Stock Summary 

 

19.8 Item Wise Profitability Analysis: 

It is one of the significant inventory reports which enables the business owner to know the 

profitability of each item consider ring the cost and the price.  

Advantages  
 Stock item wise profitability report in Tally tells you the date when the item is 

sold first and the date of the last date  
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 The report also helps in making better buying decisions without having to put extra 

efforts to go through the marketing trends  

 Assessing the profits according to the selling of each stock-item will give a clear picture 

of how an item is performing in the market which will further give insights into the 

investment that needs to be made in that product. 

 From Gateway of Tally > Stock Summary 

 Press Alt+F5: Detailed, to view the Stock Summary in the detailed format. 

 Click F7: Show Profit to display the profit for stock items 

 
 

19.9 Stock Query: 

The Stock Query report provides complete information about a stock item. 

The Stock Query report is broadly categorized into four sections: 

 Purchases  

 Sales 

 Godown/Batch Details  

 Items of the same Category 

For Example: The stock position of a selected stock item at any point of time, latest purchase, 

and sales, godown where such stock is available etc. 

Navigation Path: From Gateway of Tally > Display More Reports > Statements of Inventory > 

Stock Query 

 

19.10 Daybook: 

 The Day Book contains a record of all transactions made by a business, irrespective of 

the type of transaction.  

 By default, the display is set to the date of the last voucher entry made, but this can be set 

to list all the transactions made over a certain period.  

 Transactions include all financial vouchers, reversing and memorandum journals as well 

as inventory vouchers. 

 

Navigation Path: From Gateway of Tally > Display More Reports > Day Book 

Cash Book And Bank Book: 

 Helps to record individual transactions details entered 

 Items are posted to different ledgers  

 Tally allows you to bring all the transactions together of one category books of Accounts 
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Navigation Path: From Gateway of Tally > Display More Reports > Account Books > Cash/Bank 

Book(s) 

 

19.11 Purchases Register: 
Purchase Register contains the information related to all purchases made by a business concern. 

1) From Gateway of Tally > Display More Reports> Account Books > Purchase Register > 

Purchase Register Monthly Summary screen appears,  

2) Enter on April to display the Ledger Vouchers with the list of purchase vouchers recorded 

for April. 

3) Click F8: Columnar to generate columnar register of purchase.  

 

19.12 Sales Register: 

A Sales Register displays the monthly summary of all sales transactions and the closing balances 

at the end of each month, for the selected period.  

The list of transactions of any month can be viewed by selecting the required month.  

Tally enables change of display according to the information required. 

1) From Gateway of Tally > Display More Reports> Account Books > Sales Register > 

Sales Register Monthly Summary screen appears,  

2) Enter on June to display the Ledger Vouchers with the list of sales vouchers recorded for 

June. 

3) Click F8: Columnar to generate columnar register of sales. 

 

19.13 Problems on Purchase & Sale Invoice 

Company Creation Details 

Company Name: ElectroGadgetsPvt. Ltd. 

Address: 123 Tech Street, Bangalore, Karnataka, India 

State: Karnataka 

Country:India 

PIN Code: 560001 

GSTIN: 29ABCDE1234F1Z5 

Units of Measure for Stock Items 

1. Unit: Nos (Numbers) 

2. Unit: Box (each box contains 10 items) 

Parties and their GSTIN 

1. Party Name: Tech Distributors Pvt. Ltd. 

   - Address: Mumbai, Maharashtra 

   - GSTIN: 27ABCDE5678G1Z2 

2. Party Name: Gadget Supplies Ltd. 

   -Address: Chennai, Tamil Nadu 

   - GSTIN: 33ABCDE9012H1Z3 

3. Party Name: Local Retailer 

   - Address: Bangalore, Karnataka 

   - GSTIN: 29FGHIJ1234K1Z6 

4. Party Name: Quick Mart 

   - Address: Hyderabad, Telangana 

   - GSTIN: 36ABCDE3456L1Z7 
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5. Party Name: City Electronics 

   - Address: Bangalore, Karnataka 

   - GSTIN: 29LMNOP7890M1Z8 

Stock Items (Electronic Gadgets) 

1. Stock Item 1: Smart TV (Units: Nos) 

2. Stock Item 2: Laptop (Units: Nos) 

3. Stock Item 3: Smartphone (Units: Nos) 

4. Stock Item 4: Tablet (Units: Nos) 

5. Stock Item 5: Bluetooth Speaker (Units: Nos) 

6. Stock Item 6: Wireless Headphones (Units: Nos) 

7. Stock Item 7: Gaming Console (Units: Nos) 

8. Stock Item 8: Smartwatch (Units: Nos) 

9. Stock Item 9: Digital Camera (Units: Nos) 

10. Stock Item 10: Home Theater System (Units: Nos) 

Transactions: 

Transaction 1: Purchase (Inter-State) from Tech Distributors Pvt. Ltd. 

Date: 01-Jun-2024 

Items Purchased: 

1. Smart TV - 10 Nos @ ₹30,000 each 

2. Laptop - 5 Nos @ ₹50,000 each 

3. Smartphone - 20 Nos @ ₹20,000 each 

4. Tablet - 15 Nos @ ₹15,000 each 

- Total: ₹11,75,000 

GST: 

- IGST @ 18%: ₹2,11,500 

- Total Invoice Amount: ₹13,86,500 

Transaction 2: Sale (Intra-State) to Local Retailer 

Date: 02-Jun-2024 

Items Sold: 

1. Bluetooth Speaker - 30 Nos @ ₹2,000 each 

2. Wireless Headphones - 20 Nos @ ₹3,000 each 

3. Gaming Console - 5 Nos @ ₹25,000 each 

4. Smartwatch - 10 Nos @ ₹10,000 each 

Total Amount: ₹3,45,000 

GST: 

- CGST @ 9%: ₹31,050 

- SGST @ 9%: ₹31,050 

- Total Invoice Amount:₹4,07,100 

Transaction 3: Purchase (Inter-State) from Gadget Supplies Ltd. 

Date: 01-Jul-2024 

Items Purchased: 

1. Digital Camera - 8 Nos @ ₹35,000 each 

2. Home Theater System - 5 Nos @ ₹40,000 each 

3. Laptop - 10 Nos @ ₹50,000 each 

4. Smartphone - 10 Nos @ ₹20,000 each 

Total Amount:11,80,000 
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GST: 

- IGST @ 18%: ₹2,12,400 

- Total Invoice Amount: ₹13,92,400 

Transaction 4: Sale (Inter-State) to Quick Mart 

Date: 31-Jul-2024 

Items Sold: 

1. Smart TV - 5 Nos @ ₹30,000 each 

2. Tablet - 10 Nos @ ₹15,000 each 

3. Wireless Headphones - 10 Nos @ ₹3,000 each 

4. Smartwatch - 5 Nos @ ₹10,000 each 

Total Amount:₹3,80,000 

GST: 

- IGST @ 18%: ₹68,400 

- Total Invoice Amount:₹4,48,400 

 

Transaction 5: Sale (Intra-State) to City Electronics 

Date:-02 -Aug-2024 

Items Sold: 

1. Digital Camera - 4 Nos @ ₹35,000 each 

2. Home Theater System - 2 Nos @ ₹40,000 each 

3. Gaming Console - 3 Nos @ ₹25,000 each 

4. Bluetooth Speaker - 10 Nos @ ₹2,000 each 

Total Amount:₹3,15,000 

GST: 

- CGST @ 9%: ₹28,350 

- SGST @ 9%: ₹28,350 

- Total Invoice Amount: ₹3,71,700 

 

19.14 Keywords: 

1. Gateway of Tally: Access all functionalities and reports from the Gateway of Tally. 

2. Report: Select the specific report you need (e.g., Balance Sheet, Profit & Loss). 

3. Period: Define the reporting period (e.g., current month, year-to-date). 

4. Export: Export reports to various formats for further analysis or sharing. 

 

19.15 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K. Nadhani 

2. "Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 
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GODOWN CREATION
 

Objective: 

1. Purpose of Godowns: Explain the purpose of creating godowns for inventory management.

2. Creation Process: Detail the steps to create and configure godowns in Tally Prime.

3. Godown Types: Identify different 

4. Inventory Allocation: Discuss how to allocate inventory to different godowns for better 

tracking and management. 

5. Reporting and Analysis: Explain how to generate reports related to godown inventory and 

analyze the data for business decisions.

 

Structure: 

20.1 Manage Inventory Storage Using Godowns/Locations in Tally Prime

20.2 Problems on Godown Creation

20.3 Keywords 

20.4 Reference 

 

20.1 Manage Inventory Storage Using Godowns/Locations in TallyPrime

In our business, we may be managing the inventory in multiple physical locations, such as shops, 

warehouses, bins, racks, cabinets, and so on. In this case, we can use the Godowns/Locations 

capability of TallyPrime. Using godowns will help we keep a record of inv

one project or manufacturing stage to another. Similarly, we can also track the stock moving in 

and out of our business premises for consignment sales or job work. We can view stock reports 

for each godown and account for the movement of

A. Create Godowns/Locations:

To start allocating our stock items in godowns, we need to create a godown first.

1. Gateway of Tally > Create > select Godowns> press Enter.

Alternatively. Alt+G (Go To) > Create Master > type or select

When we create a Godown/Location in TallyPrime for the first time, we are prompted to alter the 

existing internal godown (Main Location), where all our inventory is stored by default.

2. Name & alias: As in other masters, we can spec

3. Under: Select Primary or Main Location.

 

Lesson - 20 

GODOWN CREATION 

1. Purpose of Godowns: Explain the purpose of creating godowns for inventory management.

2. Creation Process: Detail the steps to create and configure godowns in Tally Prime.

3. Godown Types: Identify different types of godowns and their specific uses. 

4. Inventory Allocation: Discuss how to allocate inventory to different godowns for better 

5. Reporting and Analysis: Explain how to generate reports related to godown inventory and 

the data for business decisions. 

20.1 Manage Inventory Storage Using Godowns/Locations in Tally Prime 

20.2 Problems on Godown Creation 

Manage Inventory Storage Using Godowns/Locations in TallyPrime 

business, we may be managing the inventory in multiple physical locations, such as shops, 

warehouses, bins, racks, cabinets, and so on. In this case, we can use the Godowns/Locations 

capability of TallyPrime. Using godowns will help we keep a record of inventory moving from 

one project or manufacturing stage to another. Similarly, we can also track the stock moving in 

and out of our business premises for consignment sales or job work. We can view stock reports 

for each godown and account for the movement of stock between godowns. 

A. Create Godowns/Locations: 

To start allocating our stock items in godowns, we need to create a godown first.

1. Gateway of Tally > Create > select Godowns> press Enter. 

Alternatively. Alt+G (Go To) > Create Master > type or select Godowns> press Enter.

When we create a Godown/Location in TallyPrime for the first time, we are prompted to alter the 

existing internal godown (Main Location), where all our inventory is stored by default.

2. Name & alias: As in other masters, we can specify multiple aliases for the godown name.

3. Under: Select Primary or Main Location. 

1. Purpose of Godowns: Explain the purpose of creating godowns for inventory management. 

2. Creation Process: Detail the steps to create and configure godowns in Tally Prime. 

4. Inventory Allocation: Discuss how to allocate inventory to different godowns for better 

5. Reporting and Analysis: Explain how to generate reports related to godown inventory and 

business, we may be managing the inventory in multiple physical locations, such as shops, 

warehouses, bins, racks, cabinets, and so on. In this case, we can use the Godowns/Locations 

entory moving from 

one project or manufacturing stage to another. Similarly, we can also track the stock moving in 

and out of our business premises for consignment sales or job work. We can view stock reports 

To start allocating our stock items in godowns, we need to create a godown first. 

Godowns> press Enter. 

When we create a Godown/Location in TallyPrime for the first time, we are prompted to alter the 

existing internal godown (Main Location), where all our inventory is stored by default. 

ify multiple aliases for the godown name. 



Godown Creation 

 

B. Create Multiple Godowns/Locations:

If we have stored our inventory in more than one location, in TallyPrime we can choose to create 

godowns one by one, or create multiple godowns from a single screen. We can choose the parent 

godown from the same screen when creating multiple godowns.

1. Gateway of Tally Create type or select Chart of Accounts.

2. In the Chart of Accounts screen, press Alt+H (Multi

3. Under Godown: 

•If we select Under Godown > All Items, we will be prompted to select the parent godown for 

each godown name that we specify under the Name column.

• If we select any other godown, say Under Godown > Main Location, this 

parent godown for all the godowns we create. However, we can change the hierarchy anytime. 

later to suit our business preferences.

A sample Multi Godown Creation screen is shown below:

 

 

C. Allocate Stock Items to Godowns/Locations:

Once we have created the required locations, we can allocate our stock items to one or more 

locations. 

1. Open the Stock Item Allocation screen.

2. To allocate the opening balance of our stock, in the Stock Item Alteration screen, select 

Opening Balance and press Enter.

3. To allocate stock items during voucher entry, in the Voucher Creation screen, select the stock 

item and press Enter. 

4. In the Stock Item Allocation screen, provide the Quantity if UoM is defined for the item; 

otherwise, provide the Amount. A sample Stock Item Allocation screen is as shown.
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B. Create Multiple Godowns/Locations: 

If we have stored our inventory in more than one location, in TallyPrime we can choose to create 

multiple godowns from a single screen. We can choose the parent 

godown from the same screen when creating multiple godowns. 

1. Gateway of Tally Create type or select Chart of Accounts. 

2. In the Chart of Accounts screen, press Alt+H (Multi-Masters) > and select Multi Create

•If we select Under Godown > All Items, we will be prompted to select the parent godown for 

each godown name that we specify under the Name column. 

• If we select any other godown, say Under Godown > Main Location, this godown is treated the 

parent godown for all the godowns we create. However, we can change the hierarchy anytime. 

later to suit our business preferences. 

A sample Multi Godown Creation screen is shown below: 

C. Allocate Stock Items to Godowns/Locations: 

Once we have created the required locations, we can allocate our stock items to one or more 

1. Open the Stock Item Allocation screen. 

2. To allocate the opening balance of our stock, in the Stock Item Alteration screen, select 

nd press Enter. 

3. To allocate stock items during voucher entry, in the Voucher Creation screen, select the stock 

4. In the Stock Item Allocation screen, provide the Quantity if UoM is defined for the item; 

nt. A sample Stock Item Allocation screen is as shown.

Software Solutions to Accounting 

If we have stored our inventory in more than one location, in TallyPrime we can choose to create 

multiple godowns from a single screen. We can choose the parent 

elect Multi Create 

•If we select Under Godown > All Items, we will be prompted to select the parent godown for 

godown is treated the 

parent godown for all the godowns we create. However, we can change the hierarchy anytime. 

 

Once we have created the required locations, we can allocate our stock items to one or more 

2. To allocate the opening balance of our stock, in the Stock Item Alteration screen, select 

3. To allocate stock items during voucher entry, in the Voucher Creation screen, select the stock 

4. In the Stock Item Allocation screen, provide the Quantity if UoM is defined for the item; 

nt. A sample Stock Item Allocation screen is as shown. 
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The quantities and amount entered in the allocations screen are consolidated and displayed in the 

voucher. The Opening Balance Quantity or Value specified in the stock item must be completely 

allocated among the selected locations.

 

20.2 Problem No:01 

Step No 1: Create a Company with all Details

 Company Name:  Satyam Electronics ,Address: Shop No:1,  SP Road, Bangalore, 

State: Karnataka, Pin Code: 560056, Financial Year From : 01

Books Beginning from: 01-04-2019

Step No: 2 : Enable GST  Details

Go to F11 – F3 (Statutory Features)

Enable Goods & Servies Tax : Yes, Set/Alter GST Details : Yes

State : Karnataka,     Registration Type: Regular

Assessee of other Terrirory: NO,  GSTIN 

Applicable from : 01-04-2019, Peridicioty of GSTR1: Monthly

e-Way Bill  Applicable: Yes,  e-Way Bill Applicable from :01

e- Way Bill Threeshold  :50000, Threeshold Limit Includes: Invoice Values

e-Way Bill Applicable for Intra Stat

Remaining All Fields are  set as  “NO”

Step No 3: Stock Group Creation

Gateway of Tally >>>>Inventroy Info >> Stock Group>> Create   then Press Enter

 20.3 Acharya Nagarjuna University

The quantities and amount entered in the allocations screen are consolidated and displayed in the 

voucher. The Opening Balance Quantity or Value specified in the stock item must be completely 

ted among the selected locations. 

: Create a Company with all Details 

Company Name:  Satyam Electronics ,Address: Shop No:1,  SP Road, Bangalore, 

State: Karnataka, Pin Code: 560056, Financial Year From : 01-04-2019 

2019 

: Enable GST  Details 

F3 (Statutory Features) 

Enable Goods & Servies Tax : Yes, Set/Alter GST Details : Yes 

State : Karnataka,     Registration Type: Regular 

Assessee of other Terrirory: NO,  GSTIN :29AAACP7879D1Z0 

2019, Peridicioty of GSTR1: Monthly 

Way Bill Applicable from :01-04-2019 

Way Bill Threeshold  :50000, Threeshold Limit Includes: Invoice Values 

Way Bill Applicable for Intra State :Yes 

Remaining All Fields are  set as  “NO” 

Step No 3: Stock Group Creation 

Gateway of Tally >>>>Inventroy Info >> Stock Group>> Create   then Press Enter

Acharya Nagarjuna University 

 

The quantities and amount entered in the allocations screen are consolidated and displayed in the 

voucher. The Opening Balance Quantity or Value specified in the stock item must be completely 

Company Name:  Satyam Electronics ,Address: Shop No:1,  SP Road, Bangalore,  

Gateway of Tally >>>>Inventroy Info >> Stock Group>> Create   then Press Enter 
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Name Under Should Quantities 

of be added 

Set/Alter Gst 

Details 

 

Hardware Primary Yes Yes Description: 

Hardware 

Hsn Code:8473 

Is Non 

GSTGoods:NO 

Taxability :Taxable 

Tax Rate:18% 

 

CPU Hardware Yes No Not Applicable 

Monitor Hardware Yes No Not Applicable 

Printer Primary Yes No Description: Printer, 

HSN Code: 8473, 

Taxability: Taxable, 

Tax Rate :18% 

Tonner 

&Cartdiges 

Printer Yes No Not Applicable 

 

Step No 4: Units of Measure Creation 

Gateway of Tally>>> Inventory Info >>> Units of Measure >> Create and then Enter 

Type Symbol Formal Name Unit Qty Code Number of 

Decimal Places 

Simple Nos Numbers Nos 0 

 

Step No 5: Stock Category Creation: 

To Enable Stock Category  go to F11 – Inventory Features (F2) and Set to Yes “ Enable 

Stock Categories :Yes 

Gateway of Tally >> Inventory Info >> Stock Category>> Create   Then Enter 

Name Under 

Canon Primary 

HP Primary 

Intel Primary 

 

Step No 6: Stock Item Creation 

1.Name:18”HPT3A, Under: Monitor, Category :HP, Units : Nos , GstApplicable:Yes, Set/ 

Alter Gst Details :No, Type of Supply : Goods, Rate of duty:0 

Opening Qty : 10 Nos   Rate per Unit: 9699 , Value : 96990 
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2.Name: Cannon PG 47, Under: Tonner&Catriges,  Category: Canon, Units: Nos Gst 

Applicable: Applicable, Set/ Alter Gst Details: No, Type of Supply: Goods, Rate of duty :0 

Opening Qty: 10 Nos, Rate Per Unit :1850 , Value :18500 

3.Name : Intel Core 650 Elite, Under: CPU, Category : Intel, Unit:Nos,  Gst details : Applicable, 

Set/Alter GstDetails:No, Type of Supply : Goods, Rate of Duty : 0 

Opening Qty: 10 Nos, Rate Per Unit : 18499, Value: 184990 

Step No:7, Accounting Ledger Creation 

Ledger Name Under Group Inventory Values Gst Details Opening 

Balance 

Capital  Capital No No 30,00,000 

HDFC Bank Bank Accounts No No 29,50,000 

Amar 

Electronics 

Sundry 

Creditors 

No Yes 3,00,480 

Akbar 

Electronics 

Sundry Debtors No Yes Nil 

Cash A/c Cash In Hand NO No 50,000 

Conveyance Indirect 

Expenses 

No No Nil 

CGST Duties & Taxes NO Yes Nil 

SGST Duties & Taxes No Yes Nil 

IGST Duties & Taxes No Yes Nil 

Purchases Purchases a/c Yes Yes –no-Goods Nil 

Sales Sales Yes Yes-NO-Goods Nil 

Vinay 

Electronics 

Sundry Debtor No Yes Nil 

 

Step No 8: Accounting Entries 
1.The following items purchase on Credit from Amar Electronics, vide Bill no:009, from 

Bangalore (within the State)  

Intelcore Elite 650 10 Nos 30000 each 3,00,000 

18”HPT3A 10 Nos 13,500 Each 1,35,000 

Canon PG 47 10 Nos 5,000 Each 50,000 

And GstExtra , CGST and SGST 

2.Credit Sales the following item on Credit to Vinay Electronics , Bangalore 

10Intel Core 

650Elite 

5 Nos 35,000 Each 1,75,000 

18HPT3A 5 Nos 15,500 Each 77,500 

Canon PG 47 5 nos 7,000 Each 35,000 

And GST Extra  that is CGST and SGST 

3. The following  Items Sold On Credit to Akbar Electronics, Hyderabd, Telangana 

Intel Core 650 Elite 2 nos 37,000 each 74,000 

18” HPT3A 2 nos 17,500 Each 35,000 

Canon PG 47 2 nos 8,500 each 17,000 

And GST Extra, That is IGST. 

Problem No: 02 
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M/s.Sandhya  Traders is a Vijayawada based Trading Company  and owned by Mr.Ramlal. The 

firm is Registered office address is D.No:65-5-54,  Canal Road, Near Vinayaka Temple, One 

Town, Vijayawada-520001, Andhra Pradesh, India . Contact Details are 9966223377 and Email 

Id:sandhyatraders@gmail.com 

Nature of Business  

It is a Trading Company and Purchase of Fertilisers and Pesticides  as well as Sale of Fertilisers 

and Pesticides to the Retailers and End Users.  

The Firm Registered as a Regular GST Dealer and Deals with B2B and B2C Transactions 

Note: It is an Existing Business Organisation and they have purchased Tally.ERP9 Software 

As a Tally Professional you can implement the following Business Transactions in Tally 

Software and Trace out the Various Reports. 

Company Creation 

Name M/s.Sandhya Traders 

Address D.NO:65-5-54, Canal Road, Near Vinayaka 

Temple, One Town 

City Vijayawada 

Pin Code 520 001  finanaicail 1-4-2019 

State  Andhra Pradesh 

Country India 

Email ID Sandhyatraders@gmail.com 

Web Site www.sandhyatraders.com 

 

GST Registration Details 

State Andhra Pradesh 

GSTIN/UIN 37AACCI9455L1ZZ 

Registration Type Regular 

Peridiocity of GSTR1 Monthly 

E-Way Bill Applicable Yes 

 

Stock Item Creation Detials 

Item Name Stock Group Units of 

Measure 

GST 

Rate(%) 

HSN 

Code 

Opening Qty Rate Per 

Unit 

Spic Urea Fertilisers Kgs 12% 4545 1000Kgs 12/- 

Nagarjuna Urea Fertilisers Kgs 12% 4545 5000 Kgs 10/- 

Neem Powder Fertilisers Bgs 0% 3434 500 Bags 500/- 

DAP Fertilisers Bgs 12% 4545 100 Bgs 400/- 

17-17-17  Fertilisers Bgs 12% 4545 Nil 0 

Metacid-1ltr Pesticides Tns 5% 2211 100 Tins 600/- 

Metacid- 1/2ltr Pesticides Tns 5% 2211 250 Tins 300/- 
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Satrajith-1000ml Pesticides Tns 5% 2211 110 Tins 760/- 

Satrajith-250ml Pesticides Tns 5% 2211 Nil 0 

Baviston- 5kg Pesticides Pkt 5% 2211 120 Pkts 230/- 

 

Accounting Masters Creation 

Name of the Ledger A/c Under Group -Opening Balance as on 01-

04-2019 

Capital A/c Capital 20,44,989-00 

 

Dena Bank a/c Bank Accounts 3,45,000 

Office Furniture  Fixed Assets 5,00,000 

Motor Vehicle & Cars Fixed Assets 4,50,000 

Pre Paid Insurance Current Assets 5,000 

Cash Cash-In-Hand 4,56,789 

State Bank of India FDs Deposit (Assets)t 5,00,000 

Employee Advances Loans & Advances 1,20,000 

Konark Fertilisers Sundry Debtors 

Maintain Balances Bill by 

Bill= Yes, State : Telangana, 

Hyderabad 

Regular Dealer, 

GSTIN:36AKIPD0765H1ZS 

Rs.4,50,000 

1.Bill No:234, Rs.2,50,000, 

Credit Period:15 Days,Bill 

Date:12-03-2019 

2. Bill No:290, Rs.2,00,000, 

Credit Period: 20 Days, Bill 

Date:23-03-2019 

Jaya Pradha Chemicals Sundry Debtors, Maintain 

Balances Bill By Bill- Yes, 

State: Andhra Pradesh, 

Vijayawada. Regular Dealer, 

GSTIN:37AKIDP07651ZZ 

 

 

Rs.2,00,000/- 

1.Bill No:JP/020, Rs.85,000, 

Credit Period: 45 Days, Bill 

Date:25-03-2019 

2.Bill No:JP/045, 

Rs.1,15,000, Credit 

Period:30 Days, Bill 

Date:27-03-2019 

M/s.CoramandalFertilisers Sundry Creditors, Maintain 

Balance Bill By Bill= Yes, 

State: Tamilnadu, Regular 

Dealer, 

GSTIN:23AKIDIP0675U1ZY 

Rs.2,30,000 

1.Bill No:CFL/0029/19-20, 

Credit Period:30 Days, Bill 

Date:10-02-2019 

M/s. NFCL Ltd Sundry Creditors, Maintain 

Balances Bill By Bill = Yes, 

State: Andhra Pradesh, 

Kakinada,Regular Dealer, 

Rs:6,60,000, 1. Bill No:403, 

Credit Period :45 Days, Bill 

Date:13-03-2019 
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GSTIN:37APKID0675T1ZR 

   

Salary Payables Provisions 4,90,000-00 

Mr.Ajay Loan Un Secured Loans 2,00,000 

Purchases Purchases Accounts Inv: Yes, GST 

Appilcable=Yes 

Sales Sales Accounts Inv:Yes, GST Appilcable 

=Yes 

CGST Duties & Taxes GST Tax Type: Central 

SGST Duties & Taxes GST Tax Type: State 

IGST Duties & Taxes GST Tax Type :Intigrated 

Salaries Indirect Expenses GST = Not Appilcable 

 

Business Transactions 

On 1
st
 April, 2019: The following goods Purchased from M/s. CoramandalFertilisers, Chennai 

Tamilnadu, via Invoice No:495 (Purchases) 

Item Name Qty Rate Per Unit 

Spic Urea 1000 Kgs 12.00 

Nagarjuna Urea 2500 Kgs 16.50 

DAP 1000 Bgs 340.00 

And Plus GST Taxes Extra 

On 2
nd

 April, 2019:  The Following  Goods Purchased on Credit from M/s.NFCL Ltd, 

Kakinada, Via Invoice No:302.(INTRA state) 

Item Name Qty Rate Per Unit 

Metacid -1ltr 200 Tins 650.00 

Metacide-1/2ltr 250 Tins 280.00 

Satrajit-1000ml 300 Tins 860.00 

Plus GST Taxes  

On 4
th

 April, 2019: The Following Material sold for Cash  

(B2C Transactions) to the Consumer, Vijayawada 

Item Name Qty Rate Per Unit 

Bavistin – 5kg 50 pKT 400.00 

17-17-17 10 Bags 370.00 

  Plus GST Taxes 

On 5
th

 April, 2019: The following Material sold on Credit to Jayapradha 

Fertilisers,Vijayawada(b2b) 

Item Name Qty Rate Per Unit 

DAP 100 Bags 280.00 

Spic Urea  120 Kgs 20.00 

Metacid-1ltr7 20 Tins 750.00 

Satrajith-1ltr 20 Tins 500.00 

 

Bavistin-5kg 45 Pkts 400.00 

 

Plus GST Taxes Extra 
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On 10
th

 April,2019: The Following Materials Sold on Credit to Konark Enterprises, 

Hyderabad,(b2B) 

Item Name Qty Rate Per Unit 

Nagarjuna Urea 500 Kgs 10.00 

Spic Urea 400 Kgs 13.00 

DAP 40 Bags 400.00 

Satrajith-250ML 20 Tins 345.00 

GST Taxes Extra 

On 15
th

 April, 2019: The following goods sold for cash to the Ramesh Agencies, he is an Un 

Registred Dealer, Vijayawada( b2 C) 

Item Name Qty Rate Per Unit 

Metacid-1/2 Ltr 30 Tins 300.00 

Baviston-5kg 5 Pkts 450.00 

DAP 10 Bags 500.00 

Plus GST Taxes Extra 

 

Problem No: 03 

Company Details  

Company Name Mitra Auto Traders 

Address Door No:292-2-2 

Governerpet 

Vijayawada 

State Andhra Prdesh 

Pin Code 520002 

Financial Year from 01-04-2018 

Books Beginning from 01-01-2019 

 

GST Details of the Company 

State Andhra Pradesh 

GSTIN 37AACCI9455L1ZZ 

Registration Type Regular 

Applicability 01-01-2019 

Peridocity of GSTR1 Monthly 

e-Way Bill Appilcable Yes 

 

GST Rates are applicable for the inventory detiails is given below 

Descritption HSN Code GST Tax Rate 

Parts & Accessories of Motor 

Vehicles and Cars 

8708 28% 

 

Accounting Masters Details given below 

Accounting Ledger Accounting Group Oepening Balance Details 

Capital A/c Capital 20,00,000 Cr 

HDFC Bank a/cBA Bank Accounts 19,50,000 Dr 
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Cash Cash-In-Hand 50,000 Dr 

Bhasin Distrubutors 

37AKIPD0765H1ZZ 

Sundry Creditors 2,17,000 Cr (Bill Refence; 

3283, 31-12-2018 Credit 

days 30 

Inventory Masters given as below 

Stock Item Stock Main Group/Stock 

Sub Group 

Stock 

Category 

UOM Qty Rate Value 

Pulsor Clutch 

Plate 

Stock Main Group :Auto 

Parts 

Stock Sub Group: Clutch 

Plates 

Bajaj Nos 300 350 1,05,000 

Seeck Brake 

Shoe 

Stock Main Group:Auto 

Parts, Stock Sub Group:  

Break Shoe 

Seeko Nos 200 160 32,000 

Lumax Head 

Lamps 

Stock Main Group: Auto 

Parts 

Stock Sub Group: Head 

Lamps 

Lumax Nos 200 400 80,000 

Accounting Ledger Creations  

Name of the Ledger Under Account Group 

Purchases A/c Purchases 

Input CGST Current Assets 

Input SGST Current Assets 

Input IGST Current Assets 

Sales  Sales 

Purchases Purcahses 

Output CGST Duties & Taxes 

Output SGST Duties & Taxes 

Output IGST Duties & Taxes 

Note: To Enable GST Tax Detials for the Group of Current Assests , Goto F12( Configuration) 

While in the ledger Creation Screen and Enble the Option “ Set ledger to behave as duties & 

Taxes ” Yes 

Record the Following Transactions in Mitra Auto Traders 

On1st January, 2019: Mitra Traders  Purchase the following item from Bashin Traders 

Vijayawada vide invoice Number: 188, GST is Charges 28% (CGST 14% and SGST 14%) 

Sr.No Item Name Quantity Rate Amount 

1 Pulsor Clutch Plate 100 350 35,000 

2 SeekoBreak Shoe 100 160 16,000 

3 Lumax Head Lamps 100 400 40,000 

GST Tax Extra  

On 5
th

 January,2019, Mitra Traders Sold the given items to Bhatia Auto Traders, Vijayawada, 

Bill NO:001 and GST Tax 28% Charged on the Prices Extra (CGST 14% and SGST 14%) 

GSTIN : 37AKIPD0765H1ZS 

Sr.No Item Name Quantity Rate Amount 

1 Plusor Clutch Plates 150 450 67,500 
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2 SeekoBreak Shoe 100 220 22,000 

3 Lumax Head Lamps 50 480 24,000 

E-Way Bill Details:  

e-Way Bill NO:801002725391 

Distance in Kms :10Kms , Number:AP16BY4552,  Vehicle Type: Regular,    Date:05-01-2019 

On 10
th

January  2019: Mitra Auto Traders sold the items to Singh Traders Hyderabad –

Telangana State the following, ( Calculate Tax IGST for the below Transaction) 

Sr No Item Name Quantity Rate Amount 

1 Plusor Clutch Plates 100 450 45,000 

2 SeekoBreak Shoe 150 220 33,000 

3 Lumax Head Lamps 150 480 72,000 

E-Way Bill Details: e-Way Bill No:180292918212, Distance :280Kms Date: 10-01-2019, 

Vehicle Type: Regular, Vehicle No: AP16 45 3938 

 

20.3 Keywords: 

1. Storage Facility Design: Efficient layout, accessibility, and safety. 

2. Inventory Management: Optimal organization, tracking, and retrieval systems. 

3. Construction Materials: Durability, cost-effectiveness, and compliance with standards. 

4.Security Measures: Surveillance, restricted access, and fire protection systems. 

 

20.4 Reference: 

1. "Tally Prime: A Complete Guide" by Dr. R. P. Rustagi and Ashok K. Nadhani 

2. "Tally Prime with GST: Hands-on Practice" by Asok K. Nadhani 

             

         B. Rama Rao 
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